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Chapter 1: Introduction to
Dragon 11

Dragon version 11 contains new features and improvements that enhance your ability to talk to, control,
and interact with your computer. This section contains general information on Dragon and information
on the exciting new features of Dragon 11.

Getting started with Dragon 11.0 2

Dragon version 11 - What's New for administrator 3

Creating Windows shortcuts to User Profiles and Vocabularies 11

Using multiple acoustic models with a User Profile 13

Using Australian, Indian, and Southeast Asian vocabularies in Dragon 11 15
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Getting started with Dragon 11.0
Dragon version 11.0 - What's New for administrators

This section describes the new administrator features of Dragon Version 11.0.

For more information about Dragon Medical, see
http://www.nuance.co.uk/healthcare/dragonmedical/

For more information about Dragon NaturallySpeaking, see
http://www.nuance.com/naturallyspeaking/

Dragon on the Web

The Nuance Web site (www.nuance.com) gives you access to many resources, including

Frequently Asked Questions, usage tips, customer stories, Customer Service information, Tech-

nical Support content, and a detailed comparison between Dragon editions.

Installing, modifying and upgrading Dragon and Installation checklists

View information on the different ways to install, modify, and upgrade Dragon.

Setting up the Roaming feature

The Roaming feature lets users dictate with Dragon from different network locations and dif-

ferent computers without having to create and train individual User Profiles at each location

Adding words,commands, or vocabularies to User Profiles

You use the nsadmin command line utility and the Dragon Data Distribution Tool when you

want to make new words, customized vocabularies or new commands available to all User Pro-

files on a particular Dragon installation.

Customizing Vocabularies with the Dragon Vocabulary Tool

You use the Dragon Voctool to customize a vocabulary by adding new words and by optimizing

the language model.

Using the Convert XML to DAT tool and the MyCommands Protection Utility

n Use the Convert XML to DAT tool to convert any XML files of commands to DAT format.

n With theMyCommands Protection Utility, you can prevent unauthorized Dragon users

from editing the commands by locking access to the file.

Using Structured Commands

Dragon Professional, Medical, and Legal editions - include an extension to Text-and-Graphics com-

mands that let you to set the values of variables in text blocks based on voice input.

Dragon system requirements

Dragon 11 is compatible with Windows 7, Windows Vista, Windows XP SP3, Windows Server

2008
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Dragon version 11 - What's New for
administrator

The following table lists details about the new features and changes in Dragon 11 in the following

categories:

n Accuracy and speed improvements

n New User Interface

n Productivity enhancements

n Other improved features and changes

Accuracy and speed improvements

Reduced training time for recorder-based User Profiles

With improvements to recognition accuracy in version 11, the minimum reading time required to

train Dragon with portable digital recorders is reduced from 15 to 4 minutes. These improve-

ments save time when creating a new User Profile or adding a device to an existing profile.

See "About using a portable recorder" in the Dragon Help for details.

Open User Profiles dialog box optimized for Roaming

Dragon 11 provides a new default method for displaying Roaming User Profiles in the Open

User Profiles dialog box, which enables faster display of User Profiles and grouping them into

folder structures. This setting saves time when using the Roaming feature, and allows for easier

navigation and organization at sites with a large number of Roaming User Profiles and network

paths.

Administrators can still configure Dragon to display the classic Open User Profiles dialog box.

The new setting shows all directories listed in the Location of User Profile, as shown in this

example:
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Easier access to recent profiles, shortcuts

n The Open Recent User Profile menu is improved to show up to 10 recent User Profiles and to

give faster access for large networked Dragon installations. The menu now also includes

options to select an alternate Vocabulary or Dictation Source if they are defined for the User

Profile.

n In addition, now administrators and users can create Windows Shortcuts to Roaming User

Profiles.

Adding directories of Roaming User Profiles to the Acoustic and Language Model Optimizer Scheduler:

Now administrators can schedule Acoustic and Language Model optimization for User Profiles

based on logical directory groupings, such as department or site. Group scheduling was not pos-

sible in prior versions of Dragon because the scheduler only accepted a top-level directory for

processing User Profiles. Now administrators can create subdirectories of User Profiles and

schedule Acoustic and Language Model optimization for all profiles in the subdirectory. See

"Schedule Accuracy Tuning - Select Frequency" in the Dragon Help version 11 for details.

See the Dragon Help version 11 for more information on new ways of displaying Roaming User

Profiles and grouping profiles into folder structures.

New user interface

Redesigned DragonBar and menus

The DragonBar and its menus are redesigned in this release for greater ease of use and to show

the status of Text Control, Recognition Modes, better status messaging, and more. The Drag-

onBar also features a single visual area for all items that change status as a user dictates.

Text Control Indicator
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The Text Control Indicator shows the current level of dictation, selection, and formatting sup-

port. When a user dictates, they either have Full Text Control (a green checkmark ) or Basic

Text Control (a gray checkmark ). Previoius versions of Dragon indicated the current dic-

tation support level with the Select-and-Say indicator (a green ball ).

Recognition Modes

Recognition Mode indicators display next to the Text Control Indicator to identify Dragon's rec-

ognition modes - Normal, Dictation, Commands, Numbers, and Spell Mode.

Here are some other key changes.

Restructured menus

The menus are restructured to be more intuitive and provide easier access to the features a user

needs most. For example, the former NaturallySpeaking menu that contained mostly commands

for User Profiles (formerly called user files), is now called the Profile menu and focuses more spe-

cifically on commands a user can use with their User Profile. The Words menu is renamed the

Vocabulary menu and has all Vocabulary-related commands organized there. The Accuracy

Center is moved from the Tools menu to the Help menu. The following table provides a sum-

mary of the new and old menu names in Dragon 11 :

Dragon 11 menu name Dragon 10 menu name

Profile NaturallySpeaking

Tools Tools

Vocabulary Words

Modes Words

Audio Sound

Help Help

Redesigned Control menu

Dragon's Control menu is clearer about how a user can display Dragon, such as Docked to Top

or Bottom, or Floating, and provides direct access to Dragon Options. Also, the former Close

command is now clearly labeled "Exit Dragon".

See the Dragon Help for more information on the DragonBar, the Text Control indicator, Full

Text Control, Basic Text Control, Recognition modes, Restructured menus, and other changes.

Productivity enhancements

Playback options added to the Text-to-Speech Options

The Text-to-Speech tab of the Options dialog box is renamed Playback/Text-to-Speech and the

following Playback options are added:
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n options to control playback/rewind/fast forward speed (in %)

n options to control playback/rewind/fast forward volume (in %)

See "The Options dialog box Text-to-speech tab" in the Dragon Help for details.

Other improved features and changes

Selecting a language when installing Dragon 11

When installing Dragon 11 , Dragon uses the primary language for the product. An administrator

cannot install Dragon using a language that is different than the primary language. For example,

when installing Dragon 11 , Professional English version, Dragon installs using English as

the language of the user interface.

If an administrator attempts to use the /l option with setup.exe to install Dragon 11 using a
non-primary language, the installation process ignores the /l option.

6



Chapter 1: Introduction to Dragon 11

Upgrading User Profiles to Dragon 11

Dragon 11 supports upgrading User Profiles from versions 9, 9.1, 9.5, 9.6, 10.0, and 10.1. An

administrator cannot upgrade User Profiles from earlier versions to Dragon 11 .

An administrator updates User Profiles after Dragon 11 is installed on a computer. Dragon User

Profiles can no longer be upgraded during installation, as was possible in previous versions of

Dragon NaturallySpeaking.

After installing Dragon 11 , in the Open User profile dialog box, if an administrator selects a User

Profile that needs to be updated, Dragon displays a dialog that gives the administrator the option

of upgrading the User Profile now (by pressing OK) or upgrading the User Profile later (by press-

ing Cancel).

If the administrator selects OK, Dragon displays the User Profile Upgrade Wizard which lets the

administrator select a destination for the upgraded profiles and start the upgrade process.

When an administrator upgrades a User Profile, if DRA data is available for the User Profile, the

data is processed during the upgrade. The total amount of data that is processed is equivalent to

30 minutes of data or less, depending on how much data is available. The upgrade process will

try to use the latest 30 minutes of data.

The User Profile Upgrade Wizard provides the administrator with the opportunity to schedule

acoustic optimization. This allows additional DRA data beyond the initial 30 minutes, to be proc-

essed. The User Profile Upgrade Wizard updates one User Profile at a time.

If the administrator upgrades User Profiles from Dragon version 10, and the profiles contain Aus-

tralian, Indian, or Southeast Asian acoustic models, the upgrade process maps the vocabularies

from UK English to the appropriate dialect-specific vocabulary.

Note: If a user is using Dragon version 8.x or earlier, they can re-use custom words and com-

mands in Dragon 11 . However, vocabularies from version 8.x cannot be upgraded.

1. In Dragon 8.x or earlier, export the custom words and commands

2. In Dragon 11 , create a new User Profile

3. In Dragon 11 , import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and commands.

Controlling updates to the acoustic model of a User Profile

Dragon 11 includes the Save acoustic information option in the Roaming tab of the Admin-

istrative Setting dialog. The Save acoustic information option is only available when the

Roaming feature is enabled.

An administrator selects the Save acoustic information option to make sure that acoustic infor-

mation is saved along with a local User Profile. The option is enabled by default. By saving the

acoustic information, any corrections a user makes will be immediately available after they close

and re-open the User Profile. Setting this option also ensures that the corrections will be syn-

chronized between the Local and Master Roaming User Profile if an administrator enables the

Always copy acoustic information to network option.

This option is turned on by default
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If an administrator disables the Save acoustic information option, the .usr and .sig files created

during dictation sessions, are not saved. When an administrator runs the ACO on the master User

Profile, the User Profile is not updated with the acoustic data from the dictation sessions.

If the Save acoustic information option is always enabled, different .usr and .sig files will exist

on each computer that a user dictates on. Dragon will behave differently on each of the com-

puters. This will be the case until the administrator runs ACO on the master User Profile.

The Save acoustic information option applies to Roaming User Profiles that the user opens

directly from the local cache (for example, in disconnected mode when the master User Profile is

not available).

The Save acoustic information option does not apply to non-Roaming User Profiles that the

user opens when the Roaming feature is enabled.

A user can open non-Roaming User Profiles when the Roaming feature is enabled if the admin-

istrator has enabled opening of local profiles.

The Save acoustic information option does not affect the saving of vocabularies. The user can

perform vocabulary optimization operations, such as adding and deleting words, changing word

properties, etc. Dragon saves these changes to the local cache and then up loads the changes to

the master User Profile.

See How Dragon Synchronizes Master and Local Roaming User Profiles for more information on

what happens during synchronization between Master and Local Roaming User Profiles.

See Setting and selecting Roaming User Profile options for more information about options an

administrator can set to copy acoustic data to the network.

Enabling the QuickStart feature

Administrators can no longer enable the QuickStart feature when they install Dragon 11 . The

installation wizard no longer includes an option for enabling this feature. Users set the Quick-

Start feature of Dragon after an administrator installs Dragon on a computer.

See Installing Dragon on a single computer for more information on installing Dragon.

Using two acoustic models with a User Profile

If the computer that a user dictates on meets certain system requirements, Dragon 11 , will use

two acoustic models (instead of one) with a User Profile. Using two acoustic models instead of

one increases recognition and dictation accuracy. Acoustic models that can be added in pairs to a

User Profile are called BestMatch IV models.

See Using multiple acoustic models with a User Profile for more information.

New Options setting, Require "Click" to select hyperlinks

By default, in Dragon 11 , a user must say "Click" and the name of a hyperlink to open it. For

example, on a Web page with a link for "Directions", a user says "click directions". This change

prevents inadvertent selection of hyperlinks by voice. The "Require Click" option is on by

default for hyperlinks in Dragon 11.

See "Require "Click" to select hyperlinks" in the Dragon Help for details.

Administrative Settings always enabled
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Dragon now keeps the Administrative Settings menu item available even when a User Profile is

open. In Dragon 11, when a user chooses Tools > Administrative Settings, if a User Profile is

open Dragon offers to close it so that the user can continue to the Administrative Settings dialog

box. In Dragon 10, the Administrative Settings command was greyed out and unavailable when a

User Profile was open.

Using the Commands Only and the Empty Dictation Vocabularies in
Dragon 11

Dragon 11 does not include the Commands Only Vocabulary.

An administrator cannot upgrade User Profiles from Dragon versions 9 or 10 that use the Com-

mands Only Vocabulary to Dragon 11 unless a Commands Only vocabulary has already been

installed using the Vocabulary installer.

An administrator cannot upgrade User Profiles from editions earlier than Dragon Professional,

Legal, and Medical versions 9 or 10 that use the Empty Dictation Vocabulary to Dragon 11 .

No Username and password required for Accuracy Tuning and Data
Collection

In Dragon 11 the Accuracy Tuning and Data Collection tasks no longer require a Windows user-

name and password to work. Scheduling Accuracy Tuning will help Dragon learn from a user's

dictation and make recognition more accurate. If a user chooses to participate in the Data Col-

lection program, the user’s dictation data is sent to Nuance for research purposes, to help make

future versions of Dragon more accurate. Remember to schedule these tasks for a time when the

computer will be turned on, all User Profiles are closed, and Dragon is not on. Make sure any

Roaming User Profile data is saved to the master Roaming User Profile before the ACO runs.

See "Accuracy Tuning and Data Collection" in the Dragon Help for details.

Scheduling Accuracy optimization, Tuning, or data collection

Default schedules for Accuracy, Tuning, and Data Collection tasks are now set during the

Dragon 11 installation process. This means that these tasks are always scheduled.

The ability to schedule these tasks during the User Profile creation process depends on how the

Let the user choose when to run Accuracy Tuning and Data Collection option is set for a

custom Dragon installation.

If the Let the user choose when to run Accuracy Tuning and Data Collection option

remains checked (the default), after Dragon installs, task schedules can be set during the User

Profile creation process. If the option is unchecked, task schedules cannot be set during the User

Profile creation process; in this case, the settings selected by the administrator will always be in

effect.

See the Dragon Help for more information.
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Australian, Indian, and Southeast Asian vocabularies

In Dragon 11 , Australian (AUS), Indian (IND), and Southeast Asian (SEA) vocabularies are sep-

arate languages with dialect-specific acoustic models and dialect-specific vocabularies.

See Using Australian, Indian and Southeast Asian for more information on updating 9.x and 10.x

User Profiles that contain Australian, Indian and Southeast Asian acoustic models to Dragon 11 .

Teens Vocabulary is no longer available in version 11

Dragon 10 contained a vocabulary called the Teens vocabulary. In Dragon 11 , the Teens vocab-

ulary is no longer available. In version 11, you create User Profiles for Teens by selecting.the '13

or under' age group and the US English vocabulary in the Profile Creation wizard. User profiles

created in version 10 for Teens will be upgraded to the US English vocabulary.
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Creating Windows shortcuts to User
Profiles and Vocabularies

If Dragon is shared Dragon with other people, or if a person has more than one User Profile, you

can create Windows Shortcuts on the Desktop to start Dragon and open particular User Profiles.

If User Profiles have multiple Vocabularies, you can also specify the Vocabulary to open.

To create a shortcut to a User Profile and
Vocabulary
1. Right-click the Dragon shortcut icon on the Windows Desktop and then click Properties to

open the icon's Properties dialog box.

2. Click the Shortcut tab of the Properties dialog box.

In the Start In box, at the end of the path type "natspeak.exe /user <User Profile name>".

The text in the target box should look similar to the following line:

"C:\Program Files\Nuance\NaturallySpeaking11\Program\Natspeak.exe"

/user "David"
where David is the name of the User Profile.

For Roaming User Profiles:

Or, if Roaming User is enabled, type the path to the Master Roaming User Profile loca-

tion, then /user, then the sub-folder if applicable, and then the User Profile name on

the network. The text in the target box should look similar to the following:

"C:\Program Files\Nuance\NaturallySpeaking11\Program\NatSpeak.exe"

/user "\\<server_name>\<subfolder_path>\<user_profile_name>"

For Vocabularies

To specify a Vocabulary, follow the User Profile name with "/Vocabulary" and the

name of the Vocabulary. The text in the target box should look similar to the fol-

lowing:

"C:\Program Files\Nuance\NaturallySpeaking11\Program\NatSpeak.exe"
/user "David /Vocabulary Politics"

If the User Profile or Vocabulary name contains a space, enclose the name in quotation

marks. For example, enter: /user "Mike Workman" /Vocabulary "American History"

If the User Profile name contains a space, enclose the name in quotation marks. For

example, type: /user "Mike Workman

3. Click OK.

When finished, double-click the shortcut icon to start Dragon. The User Profile opens along with

the Vocabulary specified.

11



Dragon Administrator Guide version 11

Types of Paths
The path can be a UNC, HTTP, or HTTPs path:

UNC

"C:\Program Files\Nuance\NaturallySpeaking11\Program\Natspeak.exe" /user
"\\<directory>\<directory>\<username>"

For example:

"C:\Program Files\Nuance\NaturallySpeaking11\Program\Natspeak.exe" /user
"\\Roaming\Profiles\Roaming1"

HTTP or HTTPS

"C:\Program Files\Nuance\NaturallySpeaking11\Program\Natspeak.exe" /user
"http://<url_of_server>\<user_name>"

For example:

"C:\Program Files\Nuance\NaturallySpeaking11\Program\Natspeak.exe" /user
"http://test01.roam.test\Roaming1"

The path to an HTTP or HTTPS location must only contain forward slashes - the same as the Network

Location dialog.

Precede the username with a backslash.

TIP

It is possible to add a shortcut to the top of the Start menu by dragging the shortcut icon onto the

Start button.
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Using multiple acoustic models with a
User Profile

If the computer that a user dictates on meets certain system requirements, Dragon 11 uses two

acoustic models with a User Profile. Using two acoustic models instead of one improves rec-

ognition and dictation accuracy. Acoustic models that can be added in pairs to a User Profile are

called BestMatch IV models.

Any time you add a new dictation source to a User Profile that uses two BestMatch IV models,

the dictation source will also be associated with the two models.

A User Profile with two BestMatch IV models uses more computer resources, including RAM

memory, than a User Profile with one acoustic model. Dragon 11 uses two BestMatch IV models

on a multi-core computer with at least 2 GB RAM. Dragon 11 recognizes when it is installed on a

computer that meets these system requirements and selects the BestMatch IV acoustic model as

the default.

Dragon 11 does not provide BestMatch IV acoustic models for the following models/regions:

n Teens (11k and Bluetooth)

n United Kingdom, Australia (Bluetooth)

n Indian Subcontinent, Southeast Asia (11k and Bluetooth)

Acoustic Optimization for User Profiles with
BestMatch IV acoustic models
If a User Profile includes BestMatch IV models, you must run the Acoustic and Language Model

Optimizer (ACO) on a computer with multi-core processors. Dragon 11 uses two BestMatch IV

models only on a multi-core computer with at least 2 GB of RAM.

If the ACO processes a User Profile that was created on a computer with multi-core processors,

the optimizer always selects the BestMatch IV models to optimize.

If a User Profile is associated with BestMatch III models without accents, and you run the opti-

mizer on a computer that supports BestMatch IV models, if automatic acoustic model selection is

enabled, the optimizer will automatically choose a BestMatch IV model to optimize.

Multiple acoustic models and User Profiles on single
and multi-core computers
If a user creates a User Profile on a multi-core computer, when the user opens the User Profile on

a single-core computer, Dragon uses the first acoustic model for recognition. Dragon does not

load the second acoustic model.
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If a user creates a User Profile on a single-core computer, when the user opens the User Profile on

a multi-core computer, Dragon uses the single acoustic model for recognition.

If a user selects BestMatch IV models for a User Profile and trains the profile on a multi-core com-

puter, when the user opens the User Profile on a single-core computer, Dragon displays the fol-

lowing warning message:

"Your computer has a single core processor. You have opened a User Profile created on a com-

puter with a multi-core processor.

NaturallySpeaking will work normally on this computer but you may see some change in per-

formance and accuracy".
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Using Australian, Indian, and
Southeast Asian vocabularies in
Dragon 11

In Dragon 10, Service Pack 1, Australian, Indian and Southeast Asian were implemented as dia-

lects, or “Accents”. In Dragon 11 , Australian, Indian, and Southeast Asian vocabularies are sep-

arate “languages” with dialect-specific acoustic models and dialect-specific vocabularies.

In Dragon 11 , a user selects one of the following languages in the Region section of the Profile

Creation wizard.

n Australia

n Indian Subcontinent

n Southeast Asia

Language Region Accent

English United States n Standard
n Australian accented English
n British accented English
n Indian accented English
n Inland Northern US (Great Lakes area)
n Southeast Asian accented English
n Southern US
n Spanish accented English

English Canada n Standard
n Australian accented English
n British accented English
n Indian accented English
n Inland Northern US (Great Lakes area)
n Southeast Asian accented English
n Southern US
n Spanish accented English

English United Kingdom n Standard
n Australian accented English
n Indian accented English
n Southeast Asian accented English

Upgrading User Profiles older than Version 10.0
Service Pack 1 to Dragon 11
When you upgrade Dragon 9.x User Profiles and Dragon 10.0 profiles (prior to Service Pack 1)

that contain Australian, Indian, and Southeast Asian acoustic models, Dragon 11 upgrades them

directly to the same models and vocabularies in Dragon 11.

The following table shows the acoustic model and vocabulary mappings for these languages:
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Dragon 9.x Acoustic
Model Dragon 11 Acoustic Model Dragon 11 Vocabulary

Australian English |
Bluetooth 8 kHz

Australian English | Bluetooth
8 kHz

Australian English | Large | General

Australian English |
BestMatch

Australian English | Best-
Match III/IV

Australian English | Large | General

Indian English | Blue-
tooth 8 kHz

Indian English | Bluetooth 8
kHz

Indian English | Large | General

Indian English | Best-
Match

Indian English | BestMatch
III/IV

Indian English | Large | General

SE Asian English | Blue-
tooth 8 kHz

Southeast Asian English |
Bluetooth 8 kHz

Southeast Asian English | Large | General

SE Asian English | Best-
Match

Southeast Asian English |
BestMatch III/IV

Southeast Asian English | Large | General

UK English | BestMatch UK English | BestMatch III/IV UK English | Large | General

UK English | BestMatch
III

UK English | BestMatch III/IV UK English | Large | General

UK English | Bluetooth
8 kHz

UK English | Bluetooth 8 kHz UK English | Large | General

Upgrading User Profiles newer than Version 10.0
Service Pack 1 to Dragon 11
When you upgrade Dragon 10.0 SP1 or later User Profiles that contain Australian, Indian, and

Southeast Asian acoustic models as “accent models”, Dragon 11 upgrades them to the cor-

responding dialect-specific vocabularies in Dragon 11.

The following table shows the vocabulary mappings for these languages:

Dragon 10 Acoustic
Model Dragon 11 Acoustic Model Dragon 11 Vocabulary

UK English | Bluetooth
8 kHz | Australian
accented English

Australian English | Bluetooth
8 kHz

Australian English | Large | General

UK English | BestMatch
| Australian accented
English

Australian English | Best-
Match III/IV

Australian English | Large | General

UK English | Bluetooth
8 kHz | Indian
accented English

Indian English | Bluetooth 8
kHz

Indian English | Large | General

UK English | Best-
match | Indian
accented English

Indian English | Best-
matchIII/IV

Indian English | Large | General

UK English | Bluetooth
8 kHz | SE Asian

Southeast Asian English |
Bluetooth 8 kHz

Southeast Asian English | Large | General
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Dragon 10 Acoustic
Model Dragon 11 Acoustic Model Dragon 11 Vocabulary

accented English

UK English | BestMatch
| SE Asian accented
English

Southeast Asian English |
BestMatch III/IV

Southeast Asian English | Large | General

UK English | BestMatch UK English | BestMatch III/IV UK English | Large | General

UK English | BestMatch
III

UK English | BestMatch III/IV UK English | Large | General

UK English | Bluetooth
8 kHz

UK English | Bluetooth 8 kHz UK English | Large | General

Note:BestMatch IV models are not provided for the following:

n US English Teens (11 kHz and Bluetooth)

n UK and AUS (Bluetooth)

n IND and SEA (11 kHz and Bluetooth)

See Dragon version 11 - What's New for administrators for more information on Two-pass mod-

els.
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Installing, modifying and upgrading
Dragon

To install Dragon NaturallySpeaking or Dragon Medical:

1. Be sure your systems meet the system requirements.

2. Prepare for the installation or upgrade by backing up User Profiles before upgrading.

3. Install or upgrade the software by choosing the type of installation. See the table below for

installation options.

4. Become familiar with the Dragon file structure and carry out other post installation tasks.

Note: When an administrator installs Dragon 11 , installation instructions appear in the primary

language for the product. An administrator cannot install Dragon using a language that is different

than the primary language. For example, when an administrator installs Dragon 11 , Professional

English, installation instructions appear in English.

Installation topic Topic link

Installation checklists Installation checklists

System requirements System requirements

Preparing for an installation or upgrade Preparing for an installation or

upgrade

Installing Dragon on a single computer
This topic describes the basics steps for installingDragon on a single
computer. It covers both a Typical/Complete installation and a Cus-
tom installation, sometimes linking you to further detail in another
topic.

Installing on a single com-

puter

Installing using the Windows Installer (MSI)
Dragon includes a native Windows Installer (MSI) that lets an admin-
istrator customize installations as well as install across a network to
multiple client computers. In addition, an administrator can use this
service to upgrade, modify, repair, or remove an existingDragon
installations.

Using the Windows Installer

(MSI) to install Dragon

Upgrading from a previous version
An administrator can upgrade installations to Dragon 11 from Dragon
NaturallySpeaking Versions 9.x and 10.x.

Upgrading from a previous

version

View the Dragon file structure and carry out post
installation tasks

Post Installation Tasks
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This section contains information on the prerequisites for installing Dragon, Dragon system require-
ments, and information on which Dragon products you can install on the same computer.

Preparing for an installation or upgrade 22

Installation checklist 23

Dragon system requirements 25

Storage space required for User Profiles 28

Installing on or Upgrading to Windows Vista and Windows 7 30

Coexistence with other Dragon products 31
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Preparing for an installation or
upgrade

Before installing, modifying, or upgrading Dragon NaturallySpeaking or Dragon Medical:

n Close all open applications.

n Turn off or disable any antivirus software; installation can sometimes trigger a false virus report.

n Look at the supplied Installation Checklist.

Installation restrictions
n Be sure your system meets the hardware requirements before attempting to install Dragon. See

Dragon system requirements

n Administrator rights are not required to create a User Profile or use the software after

installation.

n These restrictions also apply to an upgrade installation: On Windows XP Professional, Vista,

and Windows 7, if as administrator you want to create a Dragon User Profile for a Windows

limited user (with restricted privileges), you must log on to Windows using that limited user

account, then create the Dragon User Profile. If you create a Dragon user account for a Windows

limited user while logged in as a Windows administrator, the limited user will not be able to

access that user account.

n Dragon is licensed on a “per individual” basis. You are permitted to install the software on more

than one computer (for example, on a desktop and a laptop computer, or on a work and a home

computer), but you cannot use the software concurrently on more than one computer.

You are permitted to create multiple User Profiles, so long as each User Profile is for a single

individual. If someone else wants to create or use another User Profile, that person must

purchase a separate license for Dragon.

Volume license agreements are available.

File Structure
Upgrading from Dragon NaturallySpeaking 9.x or 10.x automatically relocates some NaturallySpeaking

directories and files.

For information, see Dragon File Structure.
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Installation checklist

Installation checklist
Do all of your workstations meet the recommended system requirements for Dragon?

Will you install the Dragon software manually at each computer or will installation be unat-

tended? (If the latter, read Installing, modifying, and upgrading Dragon for information on setup

or MSI command-line parameters.)

Which features will you install on each computer?

Which vocabularies do you need to install on each computer?

Note: Installing only selected vocabularies helps conserve disk space consumption

and shortens setup time. A full installation with all vocabularies uses about 2500 MB

and takes about 20 minutes, while an installation with only one vocabulary uses less

than 500 MB and takes about 5-10 minutes. See Dragon system requirements for

more information on disk size requirements.

Will you install the tutorial (recommended)?

Will you install the text-to-speech component?

Will you set up roaming User Profiles? (Read Setting up the Roaming feature)

If so, where will you place the User Profiles?

In a shared network directory?

In multiple shared network directories? (for example, one per

department or clinic)

In each user’s Windows home directory?

Note: Placing each user’s profile in his or her Windows home directory

is not recommended, because this makes it more difficult for the admin-

istrator to perform operations on multiple User Profiles, such as running

the Acoustic and Language Model Optimizer or upgrading User Profiles

to a new version.

On an Internet server running WebDAV (HTTP roaming)?

If not, what location will you designate as the backup directory for each User

Profile?
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Where will you place the data distribution directory for distributing word lists

and command sets?

Will you be collecting data for the acoustic optimizer?

Will you restrict users from modifying commands and vocabularies?

Which default user-specific options will you set at installation time? (See the

Dragon Help on the Options dialog.) Which Administrative options will you set?.

Note:Where you store User Profiles will also depend on other factors. Each User

Profile requires at least 25-30 MB hard disk space. With default settings, acoustic

optimizer data can take up to an additional 100 MB per workstation, to a total of 500

MB in the master Roaming User Profile (more precisely, 100 MB per dictation source

per workstation, 500 MB per dictation source per master Roaming User Profile).

Acoustic optimizer data contains text and audio data that can be read or heard by

anyone with access to the User Profiles.

Upgrade checklist

Are there User Profiles that need to be upgraded from a previous version?

If so, will an administrator upgrade them or will each end user upgrade his/her

own?

Support Checklist

Who will be responsible for running the Acoustic and Language Model Optimizer?

Who is responsible for collecting word lists and commands?

Who is responsible for distributing word lists and commands?

Will words and commands be distributed through the data distribution directory or by some

other means, such as email?

Who will Dragon users contact if they need help?
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Dragon system requirements
During the installation process, the software checks that your system meets the following require-

ments. If they are not met, Dragon will not be installed. Note that at least 2 GB of RAM is

required for installation in Windows 7 and Windows Server 2008. See Operating systems and

RAM, below.

NOTE

The Professional and Legal editions of Dragon do not support dictation directly into Electronic

Medical Record (EMR) Systems. For EMR support, please use Dragon Medical Edition.

Processor
Minimum

Intel® Pentium® 1 GHz or equivalent AMD processor or 1.66 GHz Atom® processor (SSE2

instruction set required).

Recommended

Intel Pentium 2.4 GHz (dual 1.8 GHz core processor) or equivalent AMD processor.

Faster processors produce faster performance.

NOTE

Streaming SIMD Extensions (SSE) are not supported.

Processor cache
Minimum: 512 KB

Recommended: 2 MB

Operating systems and RAM

Operating system 32-bit 64-bit RAM min
RAM

recommended

Windows 7 √ √ 2 GB 4 GB

Windows XP Home

(SP2 or greater)

√ X 1 GB 2 GB

Windows XP Pro-

fessional (SP2 or

greater)

√ X 1 GB 2 GB

Windows Vista,

including SP1 and

SP2

√ √ 1 GB 2 GB
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Operating system 32-bit 64-bit RAM min
RAM

recommended

Windows Server 2003

(SP2 or greater, R2)

√ √ 2 GB 4 GB

Windows Server

2008, including SP1

and SP2

√ √ 2 GB 4 GB

Note: Windows 2000, Windows 2000 Server, and Windows XP 64-bit are not supported and

installation is blocked on those systems.

NOTE

* If your computer has less than the recommended amount of RAM, Dragon will install but dis-

plays a message recommending that you install additional RAM for optimum performance.

Free hard disk space
n 2.5 GB minimum for a custom installation where you install only the program files and one User

Profile. Installations can range from 800 MB (US English Home Edition) to 2.5 GB (US

English Medical Edition).

n 2.8 GB minimum for non-English versions.

Microphone
n Nuance-approved noise-canceling microphone. For a complete listing of Dragon-compatible

audio input devices, visit http://support.nuance.com/compatibility on the Dragon
Support Web pages.

Note: Dragon Medical Edition has built-in support for the Dictaphone PowerMics. For more

information, see the following topics in the Dragon Help:

l Using the Dictaphone PowerMic (the beige PowerMic)

Only newer beige PowerMics work with Dragon Medical on Windows Vista.

l Using the Dictaphone PowerMic II (the black PowerMic)

PowerMic II packaging should display Vista compliance labeling. If you are

unsure about the compatibility, confirm that the firmware version is v. 2.02 or

greater. Refer to http://support.nuance.com/compatibility

n For Bluetooth microphones, Tablet PCs, and other hardware, visit

http://support.nuance.com/compatibility.

Sound card
Sound card capable of supporting 22 kHz 16-bit audio recording.

Other requirements
n Microsoft® Internet Explorer 6 or greater (free download available at www.microsoft.com).

n DVD-ROM drive required for installation.

n Speakers (optional for playback of recorded speech and Text-To-Speech features).
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n An Internet connection for product activation. Note that product activation is not required for

Enterprise editions.
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Storage space required for User
Profiles

Adequate storage space must be available for Dragon User Profiles (that store information about

each particular person's voice, vocabulary, custom commands (if applicable), and option settings).

The space needs to exist on:

n Stand-alone installations where end-users work on dedicated computers.

AND

n Only for Enterprise Profile Management Central computers (sometimes servers) where Master

Roaming User Profiles are stored.

Having Roaming User Profiles lets end-users run Dragon on more than one computer or device by

accessing centrally stored provider-specific voice and speech information, rather than requiring

that the profile be on each computer.

Roaming User Profiles also let end-users with one computer use Dragon from different locations

that have a connection to the network, for example, the office, at home, or different locations

with the office or home.

The following information should be treated as guidelines for allocating disk space on your sys-
tem. The actual amount of disk space will vary from site to site.

For each Master Roaming User Profile (User Profiles stored on the central computer), you should

plan to have this much space:

n 25 MB for each Roaming User Profile

n 8 MB for each additional vocabulary you add for this User Profile

n 18 MB for each additional dictation source you add for this User Profile

n 1000 MB for Acoustic Optimizer data associated with each dictation source of each User

Profile

To set how much data you have elected to store:

1. On the DragonBar, select Tools > Administrative Settings.

2. When the Administrative Settings dialog box opens, check the Disk space reserved for net-

work archive option.

In addition, for the Local Roaming User Profile, you should plan to have the following space on

each PC where the end-user dictates:

n 25 MB for each Roaming User Profile

n 8 MB for each additional vocabulary added for this user profile

n 18 MB for each additional dictation source added for this user profile

n 240 MB for acoustic optimizer data associated with each dictation source of each User Profile

The settings in the Data tab of the Options dialog box control how much acoustic optimizer data

Dragon retains locally:
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1. To set the number of minutes of audio to retain locally, click the Archive size... button and

position the slider.

2. To turn off retaining this data locally, check the Conserve disk space required by User pro-

file (for portability) option.

A non-Roaming User Profile requires approximately twice as much disk space as a local Roaming

User Profile. Dragon periodically creates a backup copy of a non-Roaming User Profile and stores

the copy on the local computer. On the other hand, a Roaming User Profile is stored in a network

storage location and Dragon does not create a backup copy of a Roaming User Profile.

An administrator should create backup copies of all Roaming User Profiles on a regular basis.
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Installing on or Upgrading to
Windows Vista and Windows 7

Dragon NaturallySpeaking and Dragon Medical Versions 9.5 and higher are compatible with all edi-

tions of Windows Vista and Windows 7. Dragon runs on 32-bit and 64-bit computers for these

operating systems.

Earlier versions of Dragon (version 8.x, 9.0, 9.1) will not install or run on Windows Vista or Win-

dows 7.

Upgrade considerations
If you upgrade a computer from a previous version of Windows to Windows Vista or Windows 7,

and that computer has Version 8.x, 9.0, or 9.1 of Dragon installed, that version of Dragon will not

work after upgrading to Windows Vista or Windows 7.

All your User Profiles from these previous versions remain intact and can be upgraded when you

install Dragon version 10 or 11 .

See "Upgrading User Profiles to Dragon 11 " in Dragon version 11 - What's New for admin-

istrators for more information.

Roaming User Profiles in an MSI Installation on
Vista or Windows 7
For more on carrying out an MSI installation on Windows Vista or Windows 7, see Modifying

Roaming User Profile, Miscellaneous, Schedule Settings in the INI File.
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Coexistence with other Dragon
products

Coexistence with previous versions of Dragon
You can have only one version of Dragon installed on your system.

Note: Running Dragon 9.x or 10.x concurrently with Dragon 11 is not supported.

Coexistence with Dragon SDK Client Edition
You can install Dragon SDK Client Edition 10 on the same computer where Dragon 11 is installed.

In addition, Dragon and Dragon SDK Client Edition can share vocabularies and User Profiles.

You can run only one product at the same time. For example, if you are running Dragon, you can-

not run any of the Dragon SDK Client tools or samples.

Note: Dragon 11 can coexist with Dragon SDK Client Edition 9.x.

Run Dragon SDK Client Edition 9.x on a computer
with Dragon 11
You must have administrator privileges to perform the following step. In Windows Vista, make

sure to elevate the command prompt.

At a command prompt, type the following command:

C:\Program Files\Nuance\Dragon SDK Client Edition9.x\Program\natspeak.exe
/fixguids

Run Dragon 11 on a computer with Dragon SDK
Client Edition Dragon 9.x
You must have administrator privileges to perform the following step. In Windows Vista, make

sure to elevate the command prompt.

At a command prompt, type the following command:

C:\Program Files\Nuance\NaturallySpeaking11\Program\natspeak.exe /fixguids
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This section provides information on how to install Dragon, post-installation tasks, the Dragon file struc-
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Installing Dragon on a single
computer

This topic presents the basic steps for installing Dragon NaturallySpeaking or Dragon Medical on a sin-

gle computer.

For a complete step-by-step procedure of installing Dragon on a single computer, please see the

Dragon Getting Started Guide, available in printed form, or the Dragon User Guide for version 11 , avail-

able on the DVD in \documentation\enx\UG11.pdf.

Notes:
n In Dragon 11 , the installation process does not present the QuickStart option. If you wish to

enable this option, you can do so after Dragon is installed.

n You must have Windows Administrator rights to install or uninstall Dragon or Dragon Medical on

Windows XP, Windows Vista, or Windows 7. For more information about how Administrator

rights impact the creation of Dragon User Profiles, refer to Preparing for an installation or

upgrade.

n When you install Dragon 11 , Dragon installs using the primary language for the product. You

cannot install Dragon using a language that is different than the primary language. For example,

when you install Dragon 11 Professional, English version, Dragon installs using the English

language.

If you attempt to use the setup.exe with the /l option on the command line to install 5 using a
non-primary language, the installation process uses the primary language for that edition of

Dragon and ignores the /l option.

Installing on Windows Vista and Windows 7

For information about installing the product on Windows Vista and Windows 7, refer to Installing

or Upgrading to Windows Vista and Windows 7.

Installing Dragon on a single computer

To install Dragon NaturallySpeaking or Dragon Medical:

1. Insert the first Dragon DVD into your DVD drive.

If the installation does not start automatically, use the Windows Explorer to find and double-

click setup.exe on the DVD.

When you start the installation, you might see a message from your Operating System saying A

program needs your permission to continue. Click Continue to start the installation.

2. After the Windows Installer begins, it installs software packages (if they are not already

installed):

Visual C++ 9.0 Runtime for Dragon

3. After the installation Wizard begins, click Next to proceed to the License Agreement. Read the

text of the agreement and select I accept..., then click Next again.
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4. Enter your customer information—User Name and Organization—then the Serial Number

supplied to your Dragon installation.

5. Choose your installation directory. If there are no previous versions of Dragon on your system,

the default directory in Windows XP is:

C:\Program Files\Nuance\NaturallySpeaking11

See Dragon file structure on page 54

6. Choose your Setup Type:

If you decide not to install some Dragon components by selecting Custom installation, you can

install them later by running the Setup program again and choosingModify.

l Typical/Complete: Installs all options and User Profiles and requires the most disk space.

l Custom: Lets you select options and User Profiles to install. Customizing your installation

options can greatly reduce the disk space required. 

In the Professional and Medical editions, you can modify the following settings during a cus-

tom installation. These settings are applied to all User Profiles created with this installation

of Dragon, including User Profiles created from Windows XP, Windows Vista, and Win-

dows 7 limited accounts:
l Modify the application's settings for all users displays the Options

dialog box at the end of the installation. The Options dialog box lets you

change the product's standard behavior:
l Change hot key settings

l Customize how text is formatted

l Choose initial microphone settings

l Set how often your User Profiles are backed up

l Set where you can dictate commands, such as in web pages

or other windows

l Modify the administrative settings displays the Administrative settings

dialog box at the end of the installation. The Administrative settings dialog

box lets you:
l Set up the Roaming feature

l Set the backup location of your User Profiles

l Restrict users from modifying commands and vocabularies

l Schedule the Acoustic Optimizer and Data Collection tasks

l Modify the Auto-Formatting options for all users displays the Auto-For-

matting dialog box at the end of the installation. In this dialog box, you can

choose ways that text should be automatically formatted (such as postal

codes in US or UK format) and the number of spaces after a period.

7. Continue following the on-screen instructions. The setup program will install the files for

Dragon on your computer.

8. If you did a Custom installation one or more of the following windows opens immediately:

l If you checkedModify the application's settings for all users, the Options dialog box

opens. For more information on the Options dialog box, see the main Dragon Help file.
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l If you checkedModify the administrative settings, the Administrative Settings dialog

box opens. For more information on setting administrative settings under the Roaming,

Miscellaneous, and Scheduled Tasks tabs:
l See Administrative Settings: Roaming tab

l See Administrative Settings: Miscellaneous

l See Administrative Settings: Scheduled Tasks

l If you checkedModify the Auto-formatting options for all users on the Custom Setup

page, the Auto-Formatting dialog box opens. For more information on the Auto-For-

matting dialog box, see the main Dragon Help file.

9. After you select OK, if you are prompted to restart your computer, restart it now. Otherwise,

skip to the next step.

10. Start the product by selecting Start > All Programs > Dragon NaturallySpeaking 11.0 . The

DragonBar appears on your desktop.

Activating Dragon

The first time you start Dragon, you will be prompted to activate your copy of Dragon. If you do

not activate the software, Dragon will stop working after you start the product fives times.

For more information on activation, please see the Dragon User Guide.
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Sample custom installation of Dragon
Medical

This topic shows an example of a typical custom installation of Dragon Medical for the Roaming

environment.

Note: This is an example only and is provided to give administrators an overview of a typical

installation and the kind of decisions you have to make. Though the example provides rec-

ommendations it is not meant as a substitute for your own planning.

For more information, see:

n Installation checklists

n Installing Dragon on a single computer

n Step-by-Step Command Line Installation

n Overview of Pushing Client Installation from Server

Preparing for the Roaming feature
1. Create network storage location for Master Roaming User Profiles. For example, you can create

a shared drive that all Dragon users will have read/write access to. In this example, we'll name

this shared folderDragon.

2. In the shared Dragon folder, you can create 2 sub-folders; Dragon Profiles and Data Direc-

tory.

l Dragon Profiles is the location for the master copies of the User Profiles. (For

planning purposes allow for 500 MB per User Profile.)

l Data Directory is the location for custom commands and word lists that auto-

matically update the User Profiles by use of the Data Directory Tool.

For more information, see Setting up the Roaming feature.

Install Dragon
 To install Dragon:

1. Insert the first Dragon DVD into your DVD drive or if installing from network drive, click on

setup.exe.

2. When you have the option, choose Custom installation. For example:

Custom lets you select options and User Profiles to install. Customizing your installation

options can greatly reduce the disk space required.
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Click Next to continue.

3. On the Additional options screen, select all three options. For example:

Click Next to continue.

Setting the Dragon Options
When the installation is complete, the three customization dialog boxes will open. The first to

open is the Options dialog box.

Corrections tab:

You use this tab to control how the correction feature and spelling features work.

In this example:

n Check Enable double-click to correct. Selecting this checkbox gives the user a way to correct

with the mouse.

n Maximize the number of choices that can appear in the Correction menu by setting it to 9.
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The Commands tab:

You use this tab to set options that control how Dragon interprets commands. Unless otherwise

indicated, changing these options only affects the current user; any other users keep their existing

settings.

The following example shows the default settings:
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The View tab:

You use the View tab to control the behavior and appearance of the DragonBar and the Results

Box.

In this example, change Auto-hide delay fromNever Hide to 5 seconds.
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The Hot Keys tab:

You use the Hot keys tab to specify hot key assignments.

If your users will be using Dragon on a Notebook, then click Microphone on/off and hit the

F10 key to change the hotkey.
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The PowerMic I and II tabs:

If you are using Dragon and you are using a Dictaphone PowerMic for dictation, the Options

dialog box displays the PowerMic I and II tabs. Dragon has built-in support for PowerMic or Pow-

erMic II microphones. You can use the PowerMic II microphone buttons to perform predefined

actions (described in the table below) or program the buttons to take custom actions.

The following example shows the default settings for the PowerMic II:
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The Playback/Text-to-Speech tab:

You use the Playback/Text-to-speech tab to adjust the attributes of text-to-speech and playback.

In this example, increase the Speed slider slightly. The default value is a little too slow. For exam-

ple:
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The Miscellaneous tab:

You use this tab to set miscellaneous options.

In this example

n Leave the Have the microphone on but asleep option unchecked unless the user cannot or

does not want to use their hands to turn the microphone on and off.

n Check Automatically save the profile changes to automatically save the user's profiles when

Dragon is closed.

For example:
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The Dictation Box tab:

On the Dictation tab, you can define how the Dictation Box operates.

You access the Dictation tab by selecting Tools > Dictation Box from the Dragon menu.

For more information on the Dictation Box, see the Using the Dictation Box topic in Dragon

help file.

The following example shows the default settings for the Dictation Box:
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The Data tab:

You use the Data tab to instruct Dragon to store corrections in an archive, conserve disk space for

better portability of User Profiles, and control how Dragon adapts training, saves recorded dic-

tation, and backs up User Profiles.

In this example:

n Set the Save recorded dictation with document option toNever. You may want to set this

option in most cases when using Dragon Medical and definitely when working in AP or

EMR applications that only use a text editor to populate a database.

n Set the Automatically back up user profile every "n" saves to nothing if your users are

using the Roaming feature. When you have a Roaming User Profile, the Master Roaming User

Profile most likely resides on a server that should be backed up every night.

For example:
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Setting the Administrative Options: Roaming User
Profiles
The second dialog to open at the end of the installation is the Administrative Settings dialog box.

This section describes the Roaming tab of the Administrative options dialog box

You use the Roaming tab of the Administrative Settings dialog box to set up the Roaming fea-

ture. You must set up the Roaming feature on each computer where you want users to dictate

with a Roaming User Profile. For more information, see Administrative Settings: Roaming tab.

In this example:

1. Select Enable to activate the Roaming feature and the Roaming User Profile options.

2. Click the Add button. You use the Roaming User Network Location dialog box to define

the network location of the master Roaming User Profiles. The location you pick must be acces-

sible to all computers on the network that you want available for dictation with Dragon. In this

example, we'll use the network storage location we initially created.
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3. The Administrative Settings dialog box also contains several options that you can choose from

to indicate how you want a Roaming User Profile to function at each Roaming User Profile loca-

tion.

In addition to the default settings, also enable the Access network at user profile

open/close only and Always copy acoustic information to network options. For example:

4. You will be prompted to create the default directory if it does not already exist, when you see

the following message, always click Yes:

Setting the Administrative Options: Miscellaneous
options
When the installation is complete, the three customization dialog boxes will open. The second to

open is the Administrative Settings dialog box. This section describes theMiscellaneous tab of

the Administrative options dialog box

In this example, click Change... to set the location of the Data Distribution Location to the net-

work directory that you created at the beginning.
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Also make sure to deselect the Check for product updates at startup option to disable Dragon

from automatically checking the Nuance web site for product updates if you want to control

which updates your users can get.

Setting the Administrative Options: Scheduled
Tasks 
When the installation is complete, the three customization dialog boxes will open. The second to

open is the Administrative Settings dialog box. This section describes the Scheduled Tasks tab

of the Administrative options dialog box

The following example shows the default settings for the Scheduled Tasks tab:

For more information, see the Dragon Help file.

Setting Auto-Formatting Options
The third dialog to open at the end of the installation is the Auto-Formatting dialog box. For

example, this version of the Auto-Formatting dialog box displays when you are using a non-med-

ical Vocabulary:
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In Dragon Medical, when you are using a medical Vocabulary, the Auto-Formatting dialog box dis-

plays multiple tabs (General, Capitalization, Numbers, Units, and Dates, Abbreviations, and Mis-

cellaneous):

n General Tab—Controls general settings like how number, dates and times, and common

number related abbreviations are formatted. Also on this tab is the option to spell out (expand)

English contractions.

n Capitalization Tab—Controls how Dragon capitalizes dictated words, including medical

terms.

n Numbers, Units, and Dates Tab—Contains rules for formatting numbers and units of

measure, including rules specific to medical topics.

n Abbreviations Tab—Controls how medical-specific abbreviations are formatted.

n Miscellaneous Tab—Contains miscellaneous formatting rules.

To set Auto-Formatting Options
1. Set the Auto-Formatting options.

2. Click Apply to save your changes and leave the Auto-Formatting dialog box open.
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3. Click OK to save your changes in the current tab, close the Auto-Formatting dialog box, and

have the changes take effect. Your changes do not take effect until after you close the dialog

box.

Nuance recommends that you review these tabs to make appropriate choices for your site.
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Post Installation Tasks
Once you have installed or upgraded Dragon, you might want to carry out some of these tasks

before you proceed:

n Cleaning up after uninstalling Dragon

n Dragon File Structure

n Turning off Dragon's use of Microsoft Active Accessibility Service

n Choosing Medical Vocabulary to Support Your Specialty (Dragon Medical only)

Cleaning up after uninstalling
Dragon

The following files will remain on your computer after you uninstall Dragon NaturallySpeaking or

Dragon Medical:

C:\Windows\Speech

n VText.dll

n Vdict.dll

n WrapSAPI.dll

n XTel.dll

n Xcommand.dll

n Xlisten.dll

n Xvoice.dll

n spchtel.dll

n speech.cnt

n speech.dll

n speech.hlp

n vcauto.tlb

n vcmd.exe

n vcmshl.dll

n vtxtauto.tlb

Dragon installed these files for Microsoft SAPI4 support. If you do not have other speech appli-

cations that require SAPI4, you can safely remove these files manually. If have installed other

speech applications that require SAPI4 support, you may need to re-install those applications if

you remove the files.
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Dragon file structure
Upgrading from Dragon NaturallySpeaking 9.x or 10.x to Dragon 11 will automatically relocate some

Dragon NaturallySpeaking directories and files.

You can only upgrade from Dragon 9.x or greater to Dragon 11 .

The following directory structures and file locations assume an installation to a default location.

V9.0/V9.1 Windows 2000/XP Pro/XP Home/Windows
Server 2003 directory structure

The V9.0/V9.1 directory structure before upgrading to Dragon 11 :

C:\Program Files\Nuance\NaturallySpeaking9

\Help

\Program

\Tutorial (optional)

C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking9\

\Custom

\Data

\Data\Training

\Users

C:\Documents and Settings\<username>\Application Data\N-

uance\NaturallySpeaking9\

\Results

V9.5 Windows 2000/XP Pro/XP Home/Windows Server
2003 directory structure

The V9.5 directory structure on Windows 2000/XP Pro/XP Home/Windows 2000 Advanced

Server/Windows Server 2003 before upgrading to Dragon 11 :

C:\Program Files\Nuance\NaturallySpeaking9

\Ereg

\Help

\Program

\Tutorial (optional)

C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking9\

\Custom

\Data

\Data\Training

\Users

C:\Documents and Settings\<username>\Application
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Data\Nuance\NaturallySpeaking9\

\Results

V9.5 Windows Vista directory structure

The V9.5 directory structure on Windows Vista before upgrading to Dragon 11 :

C:\Program Files\Nuance\NaturallySpeaking9

\Ereg

\Help

\Program

\Tutorial (optional)

C:\ProgramData\Nuance\NaturallySpeaking9\

\Custom

\Data

\Data\Training

\Users

C:\Users\<username>\AppData\Roaming\Nuance\NaturallySpeaking9\

\Results

V10 Windows 2000/XP Pro/XP Home/Windows Server
2003 directory structure

The V10 directory structure on Windows 2000/XP Pro/XP Home/Windows 2000 Advanced

Server/Windows Server 2003 before upgrading to Dragon 11 :

C:\Program Files\Nuance\NaturallySpeaking10

\Ereg

\Help

\Program

\Tutorial (optional)

C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking10\

\Custom

\Data

\Data\Training

\Users

C:\Documents and Settings\<username>\Application Data\N-

uance\NaturallySpeaking10\

\Results

V10 Windows Vista directory structure

The V10 directory structure on Windows Vista before upgrading to Dragon 11 :
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C:\Program Files\Nuance\NaturallySpeaking10

\Ereg

\Help

\Program

\Tutorial (optional)

C:\ProgramData\Nuance\NaturallySpeaking10\

\Custom

\Data

\Data\Training

\Users

C:\Users\<-

username>\AppData\Roaming\Nuance\NaturallySpeaking10\

\Results

Dragon 11 Windows XP Pro/XP Home/Windows Server
2003 directory structure

The Dragon 11 directory structure on Windows XP Pro/XP Home/Windows Server 2003:

C:\Program Files\Nuance\NaturallySpeaking11

\Ereg

\Help

\Program

\Tutorial (optional)

C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking11\

\Custom

\Data

\Data\Training

\Users

\RoamingUsers

C:\Documents and Settings\<username>\Application Data\N-

uance\NaturallySpeaking11\

\results

Dragon 11 Windows Vista and Windows 7 directory
structure

The Dragon 11 directory structure on Windows Vista and Windows 7:

C:\Program Files\Nuance\NaturallySpeaking11

\Ereg

\Help

\Program
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\Tutorial (optional)

C:\ProgramData\Nuance\NaturallySpeaking11\

\Custom

\Data

\Data\Training

\Users

C:\Users\<-

username>\AppData\Roaming\Nuance\NaturallySpeaking11\

\results
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Turning off Dragon's use of Microsoft Active
Accessibility Service

Dragon NaturallySpeaking and Dragon Medical use Microsoft Active Accessibility Service to let you

control certain menus and dialog boxes by voice. Without Microsoft Active Accessibility Service,

you would be unable to use Dragon to select menu commands and dialog box controls with your

voice.

If you don't need to control the menus and dialog boxes by voice, you can speed up Dragon per-

formance by turning off Microsoft Active Accessibility Services.

To turn off Active Accessibility Services in Dragon for
all applications

1. Open the Options dialog box by selecting Tools > Options on the DragonBar.

2. Click theMiscellaneous tab.

3. Clear the Voice enable menus and dialog controls box if it is selected.

4. Click OK. You will need to exit and re-start Dragon for this change to take effect.

To turn off Active Accessibility in Dragon for specific
applications

1. Exit Dragon.

2. Open nssystem.ini in a text editor. In Windows XP, by default, nssystem.ini is located in:

C:\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11

See Dragon file structure for information on Dragon paths in other Windows operating

systems.

3. Under [MSAAModules Disabled], add a line similar to the following for each application

where you want to disable the use of Active Accessibility Services:

<executable_name>=1

4. Save and close nssystem.ini.

5. Re-start Dragon.

For example, to disable Dragon use of Active Accessibility Services in Microsoft Word and Micro-

soft Excel, you would add the following lines to nssystem.ini:
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[MSAA Modules Disabled]

winword.exe=1

excel.exe=1

Note: If you do not know the name of an application's executable file, you can start the appli-

cation from the Windows Start menu and then use the Windows Task Manager to view the list of

current Windows applications. The executable names are listed under Image Name on the Proc-

esses tab. You can also right-click the application's icon and select the shortcut tab—the Target

field will provide the name of the executable.
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Choosing a Medical Vocabulary
to Support Your Specialty

If you are using Dragon Medical, you should know which medical vocabulary supports your spe-

cialty, so that you can readily select the correct vocabulary from the list provided.

See Using Australian, Indian and Southeast Asian vocabularies in Dragon for information on

upgrading User Profiles that contain Australian, Indian, or Southeast Asian acoustic models to

Dragon 11 .

The following table correlates Medical specialties with US English and UK English Dragon Med-

ical vocabularies.

US and UK English Dragon Medical
Specialties and the Vocabularies That Support Them

Notes:

n Specialties and Medical Vocabularies marked with a (1) are not available in the Dragon Medical

Small Practice Edition.

n The Physical Medicine and Rehabilitation and the Speech and Language Pathology vocabularies

not available in UK English are marked with a (2).

Specialty Medical Vocabulary to Choose

Addiction Psychiatry Addiction Psychiatry

Adolescent Medicine Family Medicine, Internal Medicine, or Pediatrics

Allergy and Immu-

nology

Allergy and Immunology

Anesthesiology Anesthesiology

Bariatric Surgery Surgery

Behavioral Health Psychiatry

Blood Bank-

ing/Transfusion Med-

icine

Pathology 1

Breast Surgery Surgery

Cardiac Surgery Cardiac Surgery

Cardiology Cardiology

Cardiothoracic Sur-

gery

Surgery
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Specialty Medical Vocabulary to Choose

Cardiovascular Dis-

ease

Internal Medicine

Chemical Pathology Pathology 1

Child and Adoles-

cent Psychiatry

Psychiatry

Child Abuse Pedi-

atrics

Pediatrics

Clinical Cardiac Elec-

trophysiology

Cardiology

Critical Care Med-

icine

Anesthesiology or Internal Medicine

Dentistry Dentistry

Dermatology Dermatology

Dermatopathology Pathology 1

Developmental-

Behavioral Pediatrics

Pediatrics

Diagnostic Radiology Radiology 1

ENT ENT

Ear, Nose, and

Throat

ENT

EEG Psychiatry

Emergency Medicine Emergency Medicine

EMG Examinations Neurology

Endocrinology Endocrinology Diabetes and Metabolism

Epidemiology Epidemiology

Family Medicine Family Medicine

Fetal Medicine Fetal Medicine

Forensic Pathology Pathology 1

Forensic Psychiatry Psychiatry

Gastroenterology Gastroenterology

General Medicine General Medicine

Geriatric Medicine Geriatric Medicine or Family Medicine
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Specialty Medical Vocabulary to Choose

Geriatric Psychiatry Psychiatry

Hand Surgery Hand Surgery or Plastic Surgery

Hematology Hematology

Hospice and Pal-

liative Medicine

Pain Medicine, Emergency Medicine, Family Medicine,

Internal Medicine, Pediatrics, or Physical Medicine and

Rehabilitation 2

Infectious Disease Infectious Disease

Internal Medicine Internal Medicine

Interventional Car-

diology

Internal Medicine

Medical Education

and Writing

Medical Education and Writing

Medical Micro-

biology

Pathology 1

Medical Oncology Internal Medicine

Medical Toxicology Emergency Medicine, Pediatrics

Mental Health Addiction Psychiatry, Endocrinology Diabetes and

Metabolism, Psychiatry, or Psychology

Midwifery Midwifery

Neonatal and Peri-

natal Medicine

Neonatal and Perinatal Medicine

Nephrology Nephrology

Neurodevelopmental

Disabilities

Pediatrics

Neurology Neurology

Neuromuscular Med-

icine

Physical Medicine and Rehabilitation 2

Neuropathology Pathology 1

Neuropsychology Psychiatry, Neurology

Neurosurgery Neurosurgery

Neurotology ENT

Nuclear Medicine Nuclear Medicine
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Specialty Medical Vocabulary to Choose

Nuclear Radiology Radiology 1

Nursing Nursing

Obstetrics and Gyne-

cology

Obstetrics and Gynecology

Oncology Oncology

Ophthalmology Ophthalmology

Oral and Facial Sur-

gery

Oral and Facial Surgery

Orthopaedic Surgery Orthopaedic Surgery

Osteopathy Osteopathy

Otolaryngology ENT

Pain Medicine Pain Medicine

Pathology Pathology 1

Pediatric Cardiology Pediatric Cardiology

Pediatric Critical

Care Medicine

Pediatrics

Pediatric Dentistry Pediatric Dentistry

Pediatric Der-

matology

Dermatology

Pediatric

Emergency Medicine

Emergency Medicine or Pediatrics

Pediatric Endo-

crinology

Pediatrics

Pediatric ENT Pediatrics

Pediatric Gas-

troenterology

Pediatric Gastroenterology

Pediatric Hema-

tology-Oncology

Pediatrics

Pediatric Infectious

Diseases

Pediatrics

Pediatric Nephrology Pediatrics

Pediatric Oto-

laryngology

ENT
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Specialty Medical Vocabulary to Choose

Pediatric Pathology Pathology 1

Pediatric Pul-

monology

Pediatrics

Pediatric Rehabil-

itation Medicine

Physical Medicine and Rehabilitation 2

Pediatric Rheu-

matology

Pediatrics

Pediatric Surgery Surgery

Pediatric Transplant

Hepatology

Pediatrics

Pediatric Urology Urology

Pediatrics Pediatrics

Physical Medicine

and Rehabilitation

Physical Medicine and Rehabilitation 2

Plastic Surgery Plastic Surgery

Plastic Surgery

within Head and

Neck

ENT

Podiatry Podiatry

Proctology Colon and Rectal Surgery

Psychiatry Psychiatry or Addiction Psychiatry

Psychology Psychology

Pulmonary Disease Pulmonary Disease

Radiation Oncology Radiology 1

Radiation Therapy Radiation Therapy

Radiologic Physics Radiology 1

Radiology Radiology 1 or Nuclear Medicine

Rheumatology Rheumatology

Sleep Lab Sleep Lab

Sleep Medicine Family Medicine or ENT

Speech and Language

Pathology

Speech and Language Pathology 1, 2
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Specialty Medical Vocabulary to Choose

Spinal Cord Injury

Medicine

Physical Medicine and Rehabilitation 2

Sports Medicine Emergency Medicine, Family Medicine, or Physical Med-

icine and Rehabilitation

Surgery Surgery

Thoracic Surgery Thoracic Surgery

Transplant Hep-

atology

Internal Medicine

Trauma Surgery Surgery

Undersea and Hyper-

baric Medicine

Emergency Medicine

Urology Urology

Vascular Surgery Vascular Surgery

Vascular and Inter-

ventional Radiology

Vascular and Interventional Radiology 1
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Enhancing the privacy of patient data

When a user dictates using Dragon Medical, Dragon automatically saves all audio and transcribed

text in Dragon Recorded Audio (.DRA) files. If the user corrects any of the dictated text, Dragon

automatically stores these corrections in .enwv files. Both these files are saved in the background.

These automatically created .DRA and .enwv files are used by Dragon to optimize the User Pro-

file. For example, Dragon uses these files when a user runs the Acoustic and Language Model

Optimizer.

Dragon encrypts these automatically created .DRA and .enwv files before storing them in the

local or Roaming User Profile directories to ensure they do not become a back door into patient

data and violate the patient's privacy. These files are also encrypted when a user dictates into a sup-

ported application like Microsoft Word or an Electronic Medical Record (EMR) application.

Due to the restrictions mandated by the HIPAA regulations, these encrypted .DRA and .enwv

files can only be opened by Dragon Medical for its internal use. For example, they cannot be

accessed by the non-Medical versions of Dragon, the Dragon NaturallySpeaking SDK Client Edi-

tion (DSC), or the Dragon NaturallySpeaking SDK Server Edition (DSS). In addition, any

encrypted .DRA and .enwv files automatically created by Dragon, cannot be opened in Drag-

onPad.

Notes:

n Dragon Medical does not encrypt .DRA files explicitly saved by a user. For example, if a user

saves recorded dictation when saving a document (for example, in Word, WordPerfect, or

DragonPad), these saved .DRA files are unencrypted. The user who created these files has the

responsibility of saving these files in a secure location.

n Nuance does not guarantee that the file encryption provided in Dragon will ensure total HIPAA

compliance. Other security measures are required for full compliance.

Security Considerations
As long as other adequate security protections are in place to protect patient data, you can avoid

saving excess patient data by choosing to:

1. Turn off encryption of patient data (not recommended)

2. Turn off creation of .DRA files and set options to conserve disk space, resulting in fewer saved

files

3. Turn off creation of unencrypted .nwv files

Turning on/off encryption of patient data

It is possible to turn off the encryption of these background speech recognition files by un-check-

ing the Encrypt Patient Health Information check box in the Miscellaneous tab of the Administrative

Settings Dialogue.

Nuance can not guarantee HIPAA compliance when this feature is turned off.
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For more information, see the Miscellaneous tab of the Administrative Settings dialog box.

Turning on/off creation of .dra patient data files

You can choose to turn off creation of the .DRA files containing patient data to further protect

the patient's privacy when other security measure are in place, by:

n Turning off data collection, which sends data to Nuance for future product improvements. The

check box to enable/disable data collection is on the Scheduled Tasks tab of the

Administrative Settings dialog box. For more information, see:

l About Data Collection and Other Scheduled Tasks

__and

n Checking settings to conserve disk space, which automatically stops creating files that require

large amounts of storage space:

i. On the DragonBar, select Tools > Options and click the Data tab.

ii. Check the Conserve disk space required by user profiles (for portability) option. For more infor-

mation on the Data tab of the Options dialog box, refer to the main Dragon Help file's

topic on the Data tab in the Options dialog box.

Turning on/off creation of unencrypted text correction .nwv archive
files

To further ensure privacy, any user can turn of creation of archive files that might contain patient

data:

1. On the DragonBar, select Tools > Options and click the Data tab.

2. Uncheck the Store correction in archive option. For more information on the Data tab of the

Options dialog box, refer to the main Dragon Help file's topic on the Data tab in the Options

dialog box.
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This section contains information on how to upgrade Dragon and Roaming User Profiles, as well as how
to upgrade third-party Vocabularies. You can update Dragon 9.x and 10.x User Profiles to Dragon 11 or
greater.

Upgrading Dragon NaturallySpeaking or Dragon Medical 70
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Upgrading master Roaming User Profiles 79
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Upgrading Dragon NaturallySpeaking
or Dragon Medical

An administrator performs the following steps to upgrade a User Profile from Dragon 9.x or 10.x

to Dragon 11 :

n Prepare to upgrade:
n Based on the version of Dragon being upgraded from, determine how to proceed

(see What you should know before upgrading from a previous version)

n If upgrading to Windows Vista, see Installing on or Upgrading to Windows Vista

n Carry out one of these procedures:
n Upgrade multiple User Profiles (see Upgrading multiple User Profiles)

n Upgrade Roaming User Profiles (see Upgrading Roaming User Profiles )

n Upgrade User Profiles with custom or customized vocabularies (see Upgrading User

profiles with Custom and Customized Vocabularies )

Administrators can work with the User Profile Upgrade Wizard (see Upgrading multiple User

Profiles)

See "Upgrading User Profiles to Dragon version 11 " in Dragon version 11 - What's New for

administrators for more information.

Note: If upgrading from Dragon version 8.x or earlier to Dragon 11, version 8.x or earlier custom

words and commands can be re-used in Dragon 11 :

1. In Dragon 8.x or earlier, export the custom words and commands

2. In Dragon 11 , create a new User Profile

3. In Dragon 11 , import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and commands.

What you should know before upgrading from a previous version

An administrator can upgrade to Dragon 11 from Dragon NaturallySpeaking or Dragon Medical Ver-

sions 9.x or 10.x. An administrator upgrades to Dragon 11 by following the installation instruc-

tions for Dragon 11, but should first be sure to:

n Uninstall the previous version, when it is required for the version the administrator is upgrading

from.

n Retain existing User Profiles, to be updated after the installation completes.

n Check that it is possible to upgrade from the existing edition to the edition the administrator is

installing.

See "Upgrading User Profiles to Dragon 11" in Dragon version 11 - What's New for administrators

for more information.
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Upgrading from Dragon 9.x

The Dragon 11 installation installs in the Dragon 9.x directories and overwrites the files in those

directories.

Upgrading from Version 10.x

Uninstall Dragon version 10.x before installing Dragon 11 .

Edition considerations

An administrator must upgrade to the same edition or greater and to the same language.

For example, if upgrading from Version 9.1 German/English to Dragon 11 English only, the

Dragon 9.1 German User Profiles are not upgraded. Upgrading to Dragon 11 German/English

upgrades both German and English User Profiles. After upgrading, an administrator can install

other Dragon 11 languages.

Notes:

n If a user is using Dragon version 8.x or earlier, they can re-use custom words and commands in

Dragon 11 :

1. In Dragon 8.x or earlier, export the custom words and commands

2. In Dragon 11 , create a new User Profile

3. In Dragon 11 , import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and

commands.

n When an administrator installs Dragon 11 , Dragon installs using the primary language for the

product. An administrator cannot install Dragon using a language that is different than the

primary language. For example, if an administrator installs Dragon 11 Professional - English

version, Dragon installs using the English language. If the administrator attempts to use the /l
option with setup.exe to install Dragon 11 using a non-primary language, the installation process

uses the primary language for that edition of Dragon and ignores the /l option.
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Installing on or Upgrading to
Windows Vista and Windows 7

Dragon NaturallySpeaking and Dragon Medical Versions 9.5 and higher are compatible with all edi-

tions of Windows Vista and Windows 7. Dragon runs on 32-bit and 64-bit computers for these

operating systems.

Earlier versions of Dragon (version 8.x, 9.0, 9.1) will not install or run on Windows Vista or Win-

dows 7.

Upgrade considerations
If you upgrade a computer from a previous version of Windows to Windows Vista or Windows 7,

and that computer has Version 8.x, 9.0, or 9.1 of Dragon installed, that version of Dragon will not

work after upgrading to Windows Vista or Windows 7.

All your User Profiles from these previous versions remain intact and can be upgraded when you

install Dragon version 10 or 11 .

See "Upgrading User Profiles to Dragon 11 " in Dragon version 11 - What's New for admin-

istrators for more information.

Roaming User Profiles in an MSI Installation on
Vista or Windows 7
For more on carrying out an MSI installation on Windows Vista or Windows 7, see Modifying

Roaming User Profile, Miscellaneous, Schedule Settings in the INI File.
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Upgrading multiple User Profiles
You use the User Profile Upgrade Wizard to upgrade a Dragon 9.x or 10.x User Profile to Dragon

11 . There are two ways you can start the User Profile Upgrade Wizard:

n In the Open User profile dialog box, select a User Profile to upgrade. Dragon displays a dialog

that gives you the option of upgrading the User Profile now (by pressing OK) or upgrading the

User Profile later (by pressing Cancel). If the user selects OK. Dragon displays the User

Profile Upgrade Wizard.

n In the Start menu, select Programs >  Dragon NaturallySpeaking 11.0 > Dragon

NaturallySpeaking Tools > Upgrade User Profiles. Dragon displays the User Profile

Upgrade Wizard.

Using the User Profile Upgrade Wizard
The User Profile Upgrade Wizard guides you through the process of upgrading User Profiles from

Dragon 9.x and 10.x.

The wizard cannot upgrade User Profiles created by versions of Dragon prior to Dragon 9.

User Profile Upgrade Wizard: Select the profile(s)
to upgrade
On the Select the profile(s) to upgrade page, you see these elements:

User profiles to upgrade

This screen displays the location and name of all the User Profiles that the wizard will upgrade.

Modify the list of User Profiles to include all User Profiles that you want to upgrade. The wizard

starts by including all the User Profiles in the current folder as candidates to upgrade. You add

User Profiles to the list by clicking the Browse to add a profile button and browsing for addi-

tional User Profiles in other locations. You remove User Profiles from the list by selecting them

and clicking the Remove from list button. Once the list of User Profiles contains the profiles

you want to upgrade, click Next.

Note: If you have roaming users in your network, see Upgrading Roaming User

Profiles: Overview

Current Location

The location of the User Profiles to upgrade.

User Profile

Displays the names of all the User Profiles to upgrade.

Total profiles to be upgraded

Displays the total number of User Profiles to upgrade.
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Browse to add a profile

Opens a Browse for Folder window that you use to locate additional User Profiles for the wizard

to upgrade.

Remove from list

Deletes the User Profile you select from the User Profile Upgrade Wizard.

Once you have made a selection, click Next.

If you choose to upgrade only one User Profile, the wizard displays the number of minutes the

upgrade requires to complete.

If you upgrade a UK User Profile, the wizard displays a page that lets you select a region for the

profile.

User Profile Upgrade Wizard: Choose where to store
the upgraded profile(s)

As the User Profile Upgrade Wizard updates a User Profile to Dragon 11, the wizard can move a

copy of the upgraded User Profile to another location without modifying the old profile. This

allows you to use the original profile if you need to and makes the profile compatible with oper-

ating systems like Windows XP that store all user data in the Documents and Settings folder.
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Location for upgraded profile(s)

Click the Browse button or select a new destination from the list if you want to choose a des-

tination other than the suggested destination.

Advanced

Click the Advanced button to open the Advanced Options dialog box where you can change

how the wizard upgrades the User Profile.

User Profile Upgrade Wizard: Advanced Options

The Advanced Options dialog box lets you make finer adjustments to how the wizard upgrades

User Profiles.

User profiles to

The User profiles to list box provides information about the location, vocabulary, and the acous-

tic model for each profile you plan to update.

Attribute Name Old Value New Value

Location The name of the User
Profile.

The current location of the
User Profile.

The location where Dragon
will place the updated User
Profile.

Vocabulary The name of the current
vocabulary for the User
Profile.

The name of the base vocab-
ulary for the current vocab-
ulary.

The name of the new base
vocabulary for the current
vocabulary.

Acoustic
model

The name of the audio
input device for the User
Profile.

The name of the current lan-
guage/voice model for the
User Profile.

The name of the new lan-
guage/voice model for the
User Profile.

Setting a location for an upgraded User Profile

When you click on the Location line in the User profiles to list box, Dragon enables the New

Location text box. The text box displays the location that the wizard recommends or that you

chose on the Choose where to store the upgraded profile(s) page. You can click Browse and

choose a new location.

Setting a new base vocabulary for a User Profile

When you click on the Vocabulary line in the User profiles to list box, Dragon enables the

New Base Vocabulary text box. The text box displays the current vocabulary of the User Profile

or the one that the User Profile Upgrade Wizard assigns to the upgraded User Profile if Dragon

does not support the old vocabulary. If Dragon supports the current vocabulary, the message

<Unable to upgrade> appears.

You can select a new base vocabulary from the drop-down list.
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Setting a new acoustic model for a User Profile

When you click on an Acoustic model line in the User profiles to list box, Dragon displays the

New Acoustic Model text box. The text box displays the current language (such as US English),

language model, and accent of the User Profile. You can choose a new acoustic model from the

drop-down list.

After you modify the information for each User Profile in the list box, click OK to return to the

wizard, and click Next to proceed.

User Profile Upgrade Wizard: Begin profile
upgrading
On the Begin profile upgrading page, click Begin upgrading to start the upgrade process. The

wizard requires approximately 5 to 20 minutes to upgrade each User Profile.When the process is

complete, click Finish.

If the User Profile Upgrade wizard starts automatically after you upgrade and start Dragon, the

Open User Profile window opens and displays a list of the User Profiles you can choose from to

begin dictation.
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Preparing to upgrade Roaming User
Profiles

Step 1: Install Dragon 11 on the computer where
you upgrade the Dragon 9.x or 10.x Master
Roaming User Profiles
Nuance recommends that administrators install Dragon 11 on the computer where the Dragon 9.x

or 10.x Master Roaming User Profiles are located. If that is not possible, Nuance recommends that

administrators install Dragon 11 on a separate computer where they will perform the upgrades.

For more information on installing, see Installing Dragon on a single computer.

Notes:

n If you are unable to install Dragon where the Dragon 9.x or 10.x Master Roaming User Profiles

are located, Nuance recommends that you install Dragon 11 on a separate computer where you

perform the upgrades. For more information, see Upgrading Roaming User Profiles: Overview.

n If upgrading from Dragon 8.x or earlier to Dragon 11 , version 8.x or earlier custom words and

commands can be re-used in Dragon 11 . See the Dragon Help for information on exporting and

importing custom words and commands:

i. In Dragon 8.x or earlier, export the custom words and commands

ii. In Dragon 11 , create a new User Profile.

iii. In Dragon 11 , import the custom words and commands

Step 2: On the Dragon 9.x or 10.x end-user systems
that use the Roaming feature
On the end-user systems where the users dictate using the Dragon 9.x or 10.x Roaming feature,

save and close any open User Profiles on each Dragon 9.x or 10.x system that uses the Roaming fea-

ture.

Note: If there is no time when all the Roaming User Profiles are not in use (for example, in a hos-

pital where some physicians use Dragon during a night shift), administrators can upgrade different

groups of Roaming User Profiles at different times.

Step 3: On the central network storage location for
the Dragon 9.x or 10.x Master Roaming User
Profiles
1. (Optional) Back up the master Roaming User Profiles to a separate location, either by using any

system backup utility that is implemented at your facility or by using the Dragon TheManage
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User Profiles dialog.

Note: You do not need to back up the Roaming User Profiles because the upgrade retains the

Dragon 9.x or 10.x User Profiles in a directory that is separate from the Dragon 11 User Profiles.

2. Create a new directory on the shared network drive to store the upgraded Dragon 11 Master

Roaming User Profiles. Although you can store the upgraded User Profiles in the same location

as the current User Profiles — this would make two versions of each User Profile visible to the

end user and lead to confusion — Nuance recommend creating a location that is different from

the location that stores the current (Dragon 9.x or 10.x) User Profiles.

Step 4: Copy the Dragon 9.x or 10.x Master
Roaming User Profiles to the Dragon 11 client
computer
If you install Dragon 11 on the computer where the Dragon 9.x or 10.x Master Roaming User

Profiles are located, then proceed to Step 5 below.

If Dragon 11 is not installed on the computer where the Dragon 9.x or 10.x Master Roaming User

Profiles are located, perform the following steps on the Dragon 11 client computer:

1. Create a directory to store all the Master Roaming User Profiles you plan to upgrade.

2. Copy the Dragon 9.x or 10.x Master Roaming User Profiles from the network location to the

directory.

Step 5: On the administrator system where you
plan to upgrade the Dragon 9.x or 10.x Master
Roaming User Profiles
1. Start Dragon Version 11 and make sure the Roaming feature is off.

To turn off the Roaming feature:

i. Close any open User Profiles.

ii. Click Administrative Settings on the DragonBar Tools menu. This action dis-

plays the Administrative Settings dialog box.

iii. On the Roaming tab, make sure Enable is not selected.

2. Close Dragon.

3. Follow the instructions in the next section, Upgrading master Roaming User Profiles.

See "Upgrading User Profiles to Dragon version 11 " in Dragon version 11 - What's New for

administrators for more information.
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Upgrading master Roaming User
Profiles

You must use the User Profile Upgrade Wizard to upgrade Dragon 9.x or 10.x master Roaming

User Profiles to Dragon 11 .

Before you proceed with the tasks in this topic, complete the procedure in Preparing to upgrade

Roaming User Profiles.

After you upgrade the Dragon 9.x or 10.x Master Roaming User Profiles and optionally copy them

back to their network location, you can proceed to upgrade your end-user systems that use the

Roaming feature. For more information, see Upgrading end-user systems.

Step 1: Upgrade the Dragon 9.x or 10.x Master
Roaming User Profiles
On the computer with the Dragon 9.x or 10.x Master Roaming files and where Dragon 11 is

installed:

1. Select Start > Programs > Dragon NaturallySpeaking 11.0 > Dragon NaturallySpeaking

Tools > Upgrade User Profiles.

Note: If you did not turn off the Roaming feature in the Administrative Settings dialog box

before attempting to start the User Profile Upgrade Wizard, you receive an error message stat-

ing that you cannot upgrade a Roaming User Profile. If you receive the message, go back to the

Administrative Settings dialog and be sure the Enabled check box is not checked.

2. On the Select the profile(s) to upgrade page, click Browse to add a profile... to select the

location of the Dragon 9.x or 10.x Master Roaming User Profiles. The Select the profile(s) to

upgrade page now displays a list of User Profiles in the selected directory:

79



Dragon Administrator Guide version 11

Continue to add User Profiles from other local locations or use the Remove from list button to

remove specific User Profiles. Click Next to continue.
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3. If you choose to upgrade only one User Profile, the wizard displays the number of minutes the

upgrade requires to complete the upgrade.

4. If you upgrade a UK User Profile, the wizard displays a page that lets you select a region for the

profile.

5. On the Choose where to store the upgraded profile(s) page, in the Location for upgraded

profile(s) text box, choose the local location you previously created to contain the upgrade

Dragon 11 master Roaming User Profiles. If a location is not visible, click Browse, find the cor-
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rect location, and click Next.

6. The Begin profile upgrading page displays the number of User Profiles that the wizard is pre-

pared to upgrade.

Click Begin upgrading to start the upgrade process. The upgrade process can take 2-3 min-

utes or more per User Profile, depending on the speed of the computer system and the speed of

the network. Click Stop at any time to interrupt this process. The upgrade process creates new

master Roaming User Profiles in the destination you selected.

7. Click Finish to complete the upgrading process and exit the User Profile Upgrade Wizard.

The User Profile Upgrade Wizard names each Dragon 11 master Roaming User Profile as fol-

lows: <name> (v11). For example, Dragon copies and upgrades a Dragon 10.x Master Roam-
ing User Profile with a filename of roaminguser1to roaminguser1 (v11). Dragon does not change the

name of the Dragon 10.x Master Roaming User Profile.

Do no store the Dragon 9.x or 10.x Roaming User Profiles in the same directory as the upgraded

Dragon 11 Roaming User Profiles. The Open User Profile dialog box displays all the Dragon 9.x

, 10.x, and 11.x profiles. A Dragon user may not be sure of the profile they should select for dic-

tation.

Step 2: Clean up the Dragon 9.x or 10.x locations
for master Roaming User Profiles (optional) 
When the User Profile Upgrade Wizard modifies the Dragon 9.x or 10.x master Roaming User

Profiles, it create a copy of the upgraded User Profile and does not change the original profiles.

This ensures the original profiles are available in case someone requires them.
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An administrator can optionally rename or remove the Dragon 9.x or 10.x master Roaming User

Profiles through theManage User Profiles dialog box.

Step 3: Copy the Dragon 11 Master Roaming User
Profiles to their network location (Optional)
If you were unable to install Dragon 11 where you store the Dragon 9.x or 10.x Master Roaming

User Profiles, and you instead copy them to a different computer with Dragon 11 installed, you

must now copy the Dragon 11 Master Roaming User Profiles back to the new network directory.

This is the directory you created on their original network location.

You can skip this step if you installed Dragon 11 on the computer where the Dragon 9.x or 10.x

Master Roaming User Profiles are located and you upgraded those Master Roaming User Profiles

directly to Dragon 11 .

Step 4: Upgrade end-user systems to Dragon 11
After you upgrad the master Roaming User Profiles, you can upgrade the end-user systems that

use the Roaming feature.

For more information, see Upgrading end-user systems.
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Upgrading multiple User Profiles
You use the User Profile Upgrade Wizard to upgrade a Dragon 9.x or 10.x User Profile to Dragon

11 . There are two ways you can start the User Profile Upgrade Wizard:

n In the Open User profile dialog box, select a User Profile to upgrade. Dragon displays a dialog

that gives you the option of upgrading the User Profile now (by pressing OK) or upgrading the

User Profile later (by pressing Cancel). If the user selects OK. Dragon displays the User

Profile Upgrade Wizard.

n In the Start menu, select Programs >  Dragon NaturallySpeaking 11.0 > Dragon

NaturallySpeaking Tools > Upgrade User Profiles. Dragon displays the User Profile

Upgrade Wizard.

Using the User Profile Upgrade Wizard
The User Profile Upgrade Wizard guides you through the process of upgrading User Profiles from

Dragon 9.x and 10.x.

The wizard cannot upgrade User Profiles created by versions of Dragon prior to Dragon 9.

User Profile Upgrade Wizard: Select the profile(s)
to upgrade
On the Select the profile(s) to upgrade page, you see these elements:

User profiles to upgrade

This screen displays the location and name of all the User Profiles that the wizard will upgrade.

Modify the list of User Profiles to include all User Profiles that you want to upgrade. The wizard

starts by including all the User Profiles in the current folder as candidates to upgrade. You add

User Profiles to the list by clicking the Browse to add a profile button and browsing for addi-

tional User Profiles in other locations. You remove User Profiles from the list by selecting them

and clicking the Remove from list button. Once the list of User Profiles contains the profiles

you want to upgrade, click Next.

Note: If you have roaming users in your network, see Upgrading Roaming User

Profiles: Overview

Current Location

The location of the User Profiles to upgrade.

User Profile

Displays the names of all the User Profiles to upgrade.

Total profiles to be upgraded

Displays the total number of User Profiles to upgrade.
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Browse to add a profile

Opens a Browse for Folder window that you use to locate additional User Profiles for the wizard

to upgrade.

Remove from list

Deletes the User Profile you select from the User Profile Upgrade Wizard.

Once you have made a selection, click Next.

If you choose to upgrade only one User Profile, the wizard displays the number of minutes the

upgrade requires to complete.

If you upgrade a UK User Profile, the wizard displays a page that lets you select a region for the

profile.

User Profile Upgrade Wizard: Choose where to store
the upgraded profile(s)

As the User Profile Upgrade Wizard updates a User Profile to Dragon 11, the wizard can move a

copy of the upgraded User Profile to another location without modifying the old profile. This

allows you to use the original profile if you need to and makes the profile compatible with oper-

ating systems like Windows XP that store all user data in the Documents and Settings folder.
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Location for upgraded profile(s)

Click the Browse button or select a new destination from the list if you want to choose a des-

tination other than the suggested destination.

Advanced

Click the Advanced button to open the Advanced Options dialog box where you can change

how the wizard upgrades the User Profile.

User Profile Upgrade Wizard: Advanced Options

The Advanced Options dialog box lets you make finer adjustments to how the wizard upgrades

User Profiles.

User profiles to

The User profiles to list box provides information about the location, vocabulary, and the acous-

tic model for each profile you plan to update.

Attribute Name Old Value New Value

Location The name of the User
Profile.

The current location of the
User Profile.

The location where Dragon
will place the updated User
Profile.

Vocabulary The name of the current
vocabulary for the User
Profile.

The name of the base vocab-
ulary for the current vocab-
ulary.

The name of the new base
vocabulary for the current
vocabulary.

Acoustic
model

The name of the audio
input device for the User
Profile.

The name of the current lan-
guage/voice model for the
User Profile.

The name of the new lan-
guage/voice model for the
User Profile.

Setting a location for an upgraded User Profile

When you click on the Location line in the User profiles to list box, Dragon enables the New

Location text box. The text box displays the location that the wizard recommends or that you

chose on the Choose where to store the upgraded profile(s) page. You can click Browse and

choose a new location.

Setting a new base vocabulary for a User Profile

When you click on the Vocabulary line in the User profiles to list box, Dragon enables the

New Base Vocabulary text box. The text box displays the current vocabulary of the User Profile

or the one that the User Profile Upgrade Wizard assigns to the upgraded User Profile if Dragon

does not support the old vocabulary. If Dragon supports the current vocabulary, the message

<Unable to upgrade> appears.

You can select a new base vocabulary from the drop-down list.
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Setting a new acoustic model for a User Profile

When you click on an Acoustic model line in the User profiles to list box, Dragon displays the

New Acoustic Model text box. The text box displays the current language (such as US English),

language model, and accent of the User Profile. You can choose a new acoustic model from the

drop-down list.

After you modify the information for each User Profile in the list box, click OK to return to the

wizard, and click Next to proceed.

User Profile Upgrade Wizard: Begin profile
upgrading
On the Begin profile upgrading page, click Begin upgrading to start the upgrade process. The

wizard requires approximately 5 to 20 minutes to upgrade each User Profile.When the process is

complete, click Finish.

If the User Profile Upgrade wizard starts automatically after you upgrade and start Dragon, the

Open User Profile window opens and displays a list of the User Profiles you can choose from to

begin dictation.

Upgrading User Profiles with Vocabularies Created by Third Parties

Vocabularies Created by a Third Party (other than by
Nuance)

Note: Any installation can use vocabularies that are not provided by Nuance, but

created by a third party specifically for a particular installation.

Upgrading User profiles with third party
vocabularies
When you upgrade a User Profile whose base vocabulary was created by a third party, all custom

words and other changes to that vocabulary will be maintained but the vocabulary's base type will

be changed. For example, Dragon 9.x or 10.x User Profiles that use the US English | Large |

Nuance vocabulary with a topic ID of 9005 are upgraded to use the General—Large vocab-

ulary; that upgraded user profile's vocabulary also contains all customizations in the Dragon 9.x or

10.x vocabulary.

See "Upgrading User Profiles to Dragon version 11 " in Dragon version 11 - What's New for

administrators for more information.

Once the User Profile is upgraded, you can continue to modify the vocabulary using the Voctool.

To further modify and re-distribute customizations to vocabularies created by third parties, you

can follow the steps outlined below on your Dragon 11 User Profiles.
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Step 1: Export custom words added to the custom
vocabulary

If you added any additional custom words to the vocabulary created by a third party, you must

first export those words. To export custom words:
n On the DragonBar menu, select Vocabulary > Export custom word and phrase

list This action displays the Export Custom Words dialog box.

n Enter the path and name of the file containing the custom words to add to the

vocabulary that you want to create, or use Save in list to find a location for the file you

want to create.

Step 2: Upgrade a User Profile that uses a custom
vocabulary
To upgrade Dragon 9.x or 10.x User Profiles with a third party vocabulary,

1. Run the User Profile Upgrade Wizard. To run the wizard, select Dragon Nat-

urallySpeaking 11.0> Dragon NaturallySpeaking Tools > Upgrade User Profiles.

2. In the User Profile Upgrade Wizard, select a Dragon 9.x or 10.x User Profile that uses a

vocabulary from a third party.

3. Click Next and follow the on-screen prompts.

The User Profile Upgrade Wizard displays the original vocabulary deployed to create the User

Profile and lets you choose a Dragon 11 base vocabulary that the User Profile Upgrade Wizard

should assign to the upgraded User Profile.

Step 3: Import custom words to the upgraded User
Profile
If you exported words in Step 1, you now must import those words. To import a word list:

1. On the DragonBar, click Vocabulary > Import list of words or phrases This displays the

Add Words fromWord Lists wizard.

2. Click Next to add the file you created in Step 1.

Step 4: Export the customized vocabulary
You can share vocabularies among different User Profiles by first exporting a vocabulary from one

User Profile and then importing it to a new User Profile. Use the following procedure to export a

vocabulary. To export a vocabulary:

1. Create a folder in which to save the exported vocabulary files.

2. Open the upgraded Dragon 9.x or 10.x User Profile that uses the custom vocabulary.

3. On the DragonBar, select Vocabulary >Manage Vocabularies or say "Manage Vocab-

ularies."
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4. In theManage Vocabularies dialog box, select the vocabulary you want to export and then

export it.

5. Locate and open the target folder, enter a name for the exported vocabulary in the File Name

box, and then save it.

6. In theManage Vocabularies dialog box, click or say "Close" to save and close it.

Note: Exporting a vocabulary creates a copy of the four files that make up the vocabulary in the

new location. You can access these files via the Data Distribution Tool or the nsadmin tool to

create new custom base vocabularies.

Step 5: Use nsadmin or the Data Distribution tool to
copy the vocabulary you export
Using the nsadmin command line or the Data Distribution Tool, you can import the vocabulary

your created in Step 2 as a base vocabulary on any Dragon installation.

Once you add a base vocabulary to a Dragon installation, you can then use the new vocabulary to

create new User Profiles or add a new vocabulary to the an existing User Profile.

When you run nsadmin or the Data Distribution Tool to import the exported vocabulary to

your Dragon installation, be sure to give the new vocabulary the same name and topic ID that the

Dragon 9.x or 10.x customized vocabulary had.

For example, if your Dragon 9.x or 10.x custom vocabulary was named US English | Large |

Nuance topic ID 9005, you would use nsadmin or the Data Distribution Tool to create a new

base vocabulary with that same name and topic ID number.

89





Chapter 5: Installing Dragon
using the Windows installer

(MSI)

This section provides information on using MSI files to install Dragon over a network, modifying Roam-
ing User and other options, using .ini file to install Dragon with a specific configuration, creating and
using MST files to install Dragon, installing Dragon from a command-line using natspeak.exe or msiex-
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Overview of Installing Dragon using
the Windows Installer (MSI)

Dragon NaturallySpeaking and Dragon Medical include a native Windows Installer (MSI) that lets you

customize your installations as well as install across a network to multiple client computers. In

addition, you use this service to modify, repair, or remove any existing installations.

Although you have several choices when deciding how you want to install Dragon Nat-

urallySpeaking or Dragon Medical on the command line, Nuance recommends that you follow the

approach presented initially in this document.

Note: Administrative installations are not supported for Dragon Medical Small Practice Edition.

You can use this procedure to install the software on one computer at a time or combine it with

Systems Management Server (SMS) or Windows Active Directory Service to install the software

across a network to multiple client computers. Also, if you have already installed the product, you

use this process to upgrade, modify, repair, or remove any existing installations.

Before You Begin
To ensure a smooth installation, before you proceed, you should gather the following information

regarding your network and Dragon settings.

n Preferred settings for Dragon options, including any PowerMic or PowerMic II button actions

to be programmed. You set these settings in the Options dialog box of Dragon.

n Preferred settings for Dragon Auto-Formatting options to be applied to the recognized text.

You set these settings in the Auto-Formatting dialog box of Dragon.

n Path to and/or mapped drive of the location where Roaming User Profiles are stored or are

going to be stored, are normally set in the Network Settings sub-dialog of the Roaming tab in

the Administrative Settings dialog box.

n Information about your http or https connection to the Roaming User Profiles storage location,

if applicable, are normally set in the Http Settings orHttps Settings sub-dialog of the

Administrative Settings dialog box.

n Preferred settings for collecting dictation data to be sent back to Nuance Communications for

improving the future accuracy of Dragon, are normally set under the Scheduled Tasks tab of

the Administrative Settings dialog.

n Install a third-party indexing/search software before you install Dragon; if no third-party

indexing/search is installed, when you try to set Dragon options, the Enable Desktop Search

commands check box will not be available for selection. Dragon supports Google Desktop

and Microsoft Vista Search.

Finding the MSI Installer on the DVD
The compiledMSI file is located on your installation DVD. The files for each edition are named:

n Dragon NaturallySpeaking (all editions) or Dragon Medical: Dragon NaturallySpeaking 11.msi

n SDK Client Edition (DSC): Dragon SDK Client Edition 10.msi
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n SDK Server Edition (DSS): Dragon SDK Server Edition 10.msi

You can double click on one of these .msi files to start the InstallShield Wizard; however, to

instead take advantage of available command line options, you can pass the file name as the appli-

cation to install to the msiexec.exe command using the /i option:

msiexec.exe /i "Dragon NaturallySpeaking11.msi"

Entering Command Lines

Unless otherwise noted:

n All command line options are case-insensitive (unless otherwise noted) and can be combined.

n No options require special values based on the values of other options.

n In the examples, user-supplied information is displayed between angle brackets. Do not use

angle brackets (<,>) as part of the command line.

n Do not use quotation marks in command line instructions.

n If a path name contain spaces, place a backslash followed by a quotation mark ( \"), before each

space in the path.

n Whenever you set an option to an .ini file, you must give the full path to that .ini file.

n All msiexec.exe command-line options you pass with /v must be prefaced with a forward slash

(/) only.

Windows Vista Notes
Dragon setup is designed so that msiexec.exe can be run from an elevated command prompt in

Windows Vista.

To launch an elevated command prompt in Windows Vista:

1. Click the Windows Start key

2. Type cmd in the search field

3. Press Ctrl+Shift+Enter. This action displays a User Account Control dialog box stating that

Windows needs your permission to continue.

4. Click Continue or hit Alt+C to confirm the elevation prompt. This displays an elevated com-

mand prompt.

Alternatively, to run the command window as an administrator, you can select Start > All Pro-

grams > Accessories > Command Prompt (without releasing the mouse), then right click

Command Prompt and select Run As. Choose an Administrator user and enter the authen-

tication information requested.
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Overview of the Network Installation
of Dragon from a Server

Overview of Pushing Client Installation from a
Server
You can push a Dragon installation to client computers on a network and avoid having to install

Dragon separately on each computer.

Dragon includes a native Windows Installer (MSI) that lets you both install across a network to

multiple client computers and customize your installations. Several servers support this type of

network installation:

n Windows Server 2003

n Windows Server 2008

n System Management Server (SMS)

n Active Directory Services

The administrator carrying out the installation creates an image of the installation program on the

server and then configures the server to automatically push the application onto the client sys-

tems. You can also configure network installations to modify, repair, or remove an existing instal-

lation.

Support for SMS and Windows 2003 Server with
Active Directory
Systems Management Server (SMS) provides a mechanism for pushing application installations out

from the server to client systems. SMS supports using the Windows Installer (MSI) to push client

installations on clients using all versions of Windows, from Windows XP to Windows 7. SMS

requires that a client application be installed on all client computers.

For information about Windows Installer technology, see the Microsoft document Scenarios and

Procedures for SMS 2003: Planning and Deployment available at
http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-

8A18-9BC180713F7E&displaylang=en.

Active Directory Services is a feature of Windows Server 2003, and Windows Server 2008. The

Group Policy component of Active Directory Services includes a Software Installation snap-in

that lets an administrator create a network installation. Administrators can use this feature to

install software to Windows XP, Windows Vista, and Windows 7 clients.

Dragon supports the Active Directory Services Assign to Computers installation option. This

option successfully installs the software when the computer is rebooted. You (as administrator)

can delay installation on Windows XP or Vista clients by enabling logon optimization for group

policy; for this type of installation, an entry for the installation can be viewed in the event log after

the first reboot. The installation is then performed on the second reboot. The installation takes

place silently, and the software is installed for all users on the computer.
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Overview of Alternative Ways to Carry Out
Administrative Installation
Dragon NaturallySpeaking and Dragon Medical include a native Windows Installer (MSI) that lets

you install across a network to multiple client computers and customize your installation in the

process. In addition, you can use this service to modify, repair, or remove any existing instal-

lations. You can use any of the following command line approaches to installing Dragon over a net-

work:

Note: MSI installations are not supported for Dragon Medical Small Practice Edition.

n Carrying Out an Administrative Installation with .bat File

n Configuring Installation of Product Updates

n Creating Custom Installation Using Microsoft Custom Install Wizard

Once you have installed the server image, you can configure your installation, then use SMS or a

similar product to install Dragon. If the product you use to push the installation out to a server

requires it, you can install Dragon with msiexec (see Step-by-Step Command Line Installation

with msiexec.exe) instead of setup.exe.
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Modifying Roaming User Profile,
Miscellaneous, Schedule Settings in
the INI File

Suppose you have a large installation that involves several departments. Three departments

require one group of configure settings and two others require modifications. After you complete

the installation on the three departments requiring the same configuration, you might want to edit

your configuration files before using them on the additional two departments.

To edit the settings, you can use the natspeak command again. You can either return to the com-

puter where you carried out the initial installation to use natspeak or install the configuration from

the first three departments on the first computer in the two departments with different settings.

Modify the settings using:

n natspeak /setdefaultoptions

n natspeak /setdefaultformattingoptions

n natspeak /setdefaultadministrativeoptions

Then copy the new nsdefaults.ini file and roamingdef.ini files to a location accessible from all the

client computers to have the alternative configuration. For example, if you want these files to be

accessible to the MSI installer from a mapped network drive. copy the files to that location before

installing to the client PCs.

Or, if the Roaming User Profile network settings are not changing, you can edit any of the other

Roaming User Profile, Miscellaneous, and Scheduled Tasks settings of your configuration by rerun-

ning Dragon with any command listed above. (You cannot make changes to the roamingdef.ini

file, where the network settings reside.) Lists of the options in the nsdefaults.ini and roam-

ingdef.ini files are provided in the tables that follow:

Caution: Be sure to use the full path to the file if you set an option to an .ini file name.

Understanding and applying the
Roaming User Options

You can set Roaming User options during an MSI installation of Dragon. In the command line:

n Set the /SETDEFAULTS option to 1 display the Options dialog box at the end of the

installation. The Options dialog box lets you change Dragon’s standard behavior, including

specifying hot keys, customizing how text is formatted, changing initial microphone settings,

and setting the how often your User Profiles are backed up.

n Set the /SETADMINS option to 1 to display the Administrative settings dialog box at the end

of the installation. The Administrative settings dialog box lets you set up the Roaming feature.
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In the Roaming, Miscellaneous, and Schedule tabs of the Administrative Settings dialog box,

you set default values for the Roaming User options in the table below. The default values are

then written to the nsdefaults.ini file, the roamingdef.ini file, and the roaminguser.ini file.

After the MSI installation is finished, you can use the nsdefaults.ini file, the roamingdef.ini file, and

the roaming.ini file to install Dragon on other computers using the same settings that are in the .ini

files.

See Overview of Installing Dragon using the Windows installer (MSI) and its subtopics for more

information on installing Dragon using an MSI installation.

See MSI Options Specific to Dragon for more information on options that can be set during an

MSI installation of Dragon.

Do not attempt to manually modify the .ini files. Manually modifying the .ini files may

cause unpredictable or undesirable results.

Option Description and UI equivalent

RoamingUserOn=0 (or 1) Turns on the Roaming feature.

Default 0 = Off

Same as the Roaming Tab - Enable option.

Roaming User Local Cache

Directory

="<existing

directory>"

Sets the location of the local copy of the Roaming User Profile. The

default location is:
Documents and Settings\All Users\Application Data\N-
uance\Dragon NaturallySpeaking11\RoamingUsers\

Same as the Roaming Tab - Local directory (for cache) option.

Open User Large Col-

lection

=0 (or 1)

When set to 0, Dragon 11 only displays the classic version of the

Open User Profile dialog box (from Dragon 10.1 and earlier ver-

sions). Dragon 11 does not display the new version of the dialog

that shows a tree-view of groups of User Profiles. When set to 1,

Dragon 11 only displays the new version of the Open User Profile

dialog box.

Same as the Roaming Tab - Display Classic Open User Pro-

files dialog. option.

See Dragon version 11 - What's New for administrators for more

information.

Roaming User Restrict

Local

User Access=1 (or 0)

Permits non-Roaming User Profiles to be opened when the Roam-

ing feature is active. Default of 1 restricts access to Roaming User

Profiles only, preventing non-roaming (local) users from dictating

by accident.

Same as the Roaming Tab - Allow non-roaming user profiles to

be opened option.
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Option Description and UI equivalent

Roaming User Incorporate

Voc Delta=0 (or 1)

When the vocdelta.dat file reaches 90% of its maximum size (1000

KB, or 1 GB), incorporates the contents of the local vocdelta.dat

file into the master Roaming User Profiles (acoustic model for the

User Profile), without running the Acoustic and Language

Model Optimizer. After it incorporates the contents of the file

into the master Roaming User Profile, it clears that data from the

local User Profile, where new data is culled from subsequent dic-

tation. If the data is being incorporated when you open a roaming

User Profile, the process can be time consuming.

Default 0 = Off

Same as the Roaming Tab - Merge contents of vocdelta.dat

into network user profile when file is full option.

Roaming User Limited

Network Traffic=0 (or 1)

Transfers local Roaming User Profile changes to the master Roam-

ing User Profile to synchronize the local and the master Roaming

User Profile only when you open or close the User Profile. This

includes the changes a user makes locally from the Options dialog

box. For more information, see the Dragon Administrator Guide

Help file topic on Synchronizing Master and Local Roaming User

Profiles. Excessive network slowdowns can be alleviated by check-

ing this option because it limits multiple interim synchronization of

local and master Roaming User Profiles.

Default 0 = Off

Same as the Roaming Tab - Access network at user profile

open/close only option.

Roaming User Always

Break

Lock=0 (or 1)

Ask before breaking locks on network user profiles (rec-

ommended). A network lock prevents opening a Roaming User Pro-

file that is already open. Network problems can cause a lock to

become "stuck" and not release even after opening the User Profile

is complete. Default of 0 produces a prompt that states the User

Profile is locked and asks you to override the lock. A setting of 1

does not produce the prompt, but breaks the lock automatically.

Same as the Roaming Tab - Ask before breaking locks on net-

work user profiles (recommended for UNC and mapped

drives)option.

ASW Override=0 (or 1) (ASW is short for Audio Setup Wizard.) Runs a Volume and Qual-

ity Check on the microphone each time you open a Roaming User

Profile. This setting affects all users. Turn this option on if your

users experience reduced accuracy because of differences in the

microphone, sound card, and ambient sound levels at different loca-

tions.
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Option Description and UI equivalent

Default 0 = Off.

Nuance recommends you set this option to 1.

Same as the Roaming Tab - Set audio levels on each machine

option.

Roaming ASW Override

=0 (or 1)

Runs a Volume and Quality Check on the microphone each time

you open a Roaming User Profile. Set to 1 if the Roaming feature is

enabled and ASW Override is 1. ASW Override and Roaming

ASW Override should always have the same setting.

Same as the Roaming Tab - Set audio levels on each machine

option.

Roaming User Save Acous-

tics

=0 (or 1)

When set to 1 (by default), when a user dictates on a computer,

acoustic adaptation that occurred as Dragon 'adapted' to the user's

voice, is saved. Acoustic optimization on the master User Profile

applies the acoustic adaptation data from dictation to the acoustic

model for the profile. When set to 0, the .usr and .sig files created

during dictation are not saved. Acoustic optimization on the master

User Profile does not apply the acoustic adaptation data from dic-

tation to the acoustic model for the profile.

Same as the Roaming Tab - Save acoustic information option.

See Dragon version 11 - What's New for administrators for more

information.

Roaming User Copy

Dragon

Log=0 (or 1)

Copies the dragon.log file from the local Roaming User Profile loca-

tion to the master Roaming User Profile location at the same time

that the program synchronizes the local and the master Roaming

User Profiles.

Default 0 = Off

Same as the Roaming Tab - Copy Dragon log to network

option.

RoamingUserCopyAcoustic

Always=0(or 1)

Copies the User Profile’s acoustic information to the master Roam-

ing User Profile location when you do not want to run the Acous-

tic and Language Model Optimizer on the master Roaming

User Profiles. The local Roaming User Profile acoustic information

is stored in:
Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\RoamingUsers\<display
name>\<username>\current\voice

The <display name> is the name you defined for the master Roam-

ing User Profile location. You can have multiple network storage
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Option Description and UI equivalent

locations. The <username> contains the names of an individual

master Roaming User Profile.

Default 0 = Off.

If you chose not to copy the User Profile’s acoustic information to

the network, corrections you make on one computer are not avail-

able on other computers used by that particular Roaming User Pro-

file until you run the Acoustic and Language Model Optimizer

on the master Roaming User Profile location and the local and

master Roaming User Profile synchronize. When this option is set

to 1 (on), the latest acoustic information is always available and auto-

matically synchronized when the master Roaming User Profile is

opened from another location. The transfer of acoustic information

is not limited by setting the Disk space reserved for network

archive option.

Same as the Roaming Tab - Always copy acoustic information

to network option.

Roaming User Do Not

Copy

Dra Files=0 (or 1)

Prevents making files that contain acoustic data from the latest dic-

tation session available to the Acoustic Optimizer when the pro-

gram synchronizes the local and master Roaming User Profiles. You

use this option to prevent the transfer of acoustic optimization data

to local User Profiles.

Same as the Roaming Tab - Conserve archive size on network

option.

Roaming User Max Con-

tainer Size=500 MB

Controls the maximum size for each container directory in the

master Roaming User profile directory. Defaults to 500 MB, max

of 1000 MB.

Same as the Roaming Tab - Disk space reserved for network

archive option.

Allow Users to Configure

Tasks=0 or 1

An administrators enables this option to allow users to access the

Scheduled Tasks tab in the Administrative Settings dialog box.

Users can use the options in the Scheduled Tasks tab to set sched-

ules for tasks, including the accuracy tuning task and the data col-

lection task. If an administrator does not enable this option, users

cannot access the Scheduled Tasks tab and the tasks will use the

default schedule.

Same as the Scheduled Tasks Tab - Let the user choose when

to run Accuracy Tuning and Data Collection option.

Custom Directory

=<full path>

Sets the location of the Data Distribution directory used by the
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Option Description and UI equivalent

Data Distribution Tool or the nsadmin command. The Data Dis-

tribution directory can be set to any directory that Windows has

read and write access to. This includes portable devices such as Zip

drives and CD/DVD burners. In enterprise installations, the Data

Distribution directory is likely set to mapped network drives and

UNC paths.

Same as theMiscellaneous Tab - Data Distribution location

option.
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Editing Miscellaneous and Scheduled
Task Settings in nsdefaults.ini File

Of the settings in the nsdefaults.ini file retrieved from the Administrative Settings dialog box, sev-

eral settings are from the Miscellaneous and Scheduled Tasks tabs of the dialog box. You can mod-

ify the following settings in the nsdefaults.ini file:

Options Description UI

AO Archive Time

Limit

Maximum audio

archive size in min-

utes. The same

option in the

options.ini file for

a particular user

contains the size of

the current audio

archive for that

user.

Default max is

3600000 minutes.

Archive Size dialog

box, displaying the

range of audio archive

sizes

Disable command

changes for restricted

users=0 (or 1)

Turns on or off the

option that lets

non-administrative

users add or modify

commands.

Do not allow

restricted users to add

or modify commands

Disable vocabulary

changes for restricted

users=0 (or 1)

Turns on or off the

option that lets

non-administrative

users modify vocab-

ularies.

Do not allow

restricted users to

modify vocabularies

Global Enable Pause

Results=0

(or 1)

Turns on or off rec-

ognition when the

speaker pauses.

Record wave data

between utterances

Custom

Directory=<full path>

Sets the location of

the Data Dis-

tribution directory

used by the Data

Distribution Tool

or the nsadmin

command.

Data Distribution loca-

tion
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Options Description UI

Current Status

Ctfmngr=0 (or 1)

Turns on or off

Windows advanced

text services. Turn-

ing off these serv-

ices prevents

conflict between

them and Dragon.

Disable Windows

advanced text services

No Dictation=0 or 1 When No Dic-

tation is on (set to

1) the user cannot

dictate, but can

only correct dic-

tation; used to des-

ignate a user as a

transcriptionist.

Correction Only

Mode

Global MyCommands

MacroRecorder=0 or

1

Allows or does not

allow the user to

modify Macro

Recorder com-

mands. The user

should still be able

to dictate with

those commands,

even when not

allowed to modify

them.

Disable use of Macro

Recorder commands

Global MyCommands 

StepByStep Script-

ing=0 or 1

Allows or does not

allow the user to

modify Step-by-

Step commands.

The user should

still be able to dic-

tate with those

commands, even

when not allowed

to modify them.

Disable use of Step-

by-Step commands

Global MyCommands

VBA Scripting=0 or 1

Allows or does not

allow the user to

modify

Advanced Scripting

commands. The

user should still be

Disable use of

Advanced Scripting

commands
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Options Description UI

able to dictate with

those commands,

even when not

allowed to modify

them.

enx ACO uses Auto

Accent AM selec-

tion=0 or 1.

When set to 1, the

Acoustic Opti-

mizer engine can

automatically select

an acoustic model

that it believes is

more suited to your

speech. To avoid

having this switch

occur, set the

option to 0.

In Dragon 11 , spe-

cial conditions

apply if you run the

Acoustic Opti-

mizer on a User

Profile that has two

acoustic models.

See Using multiple

acoustic models

with a User Profile

for more infor-

mation.

Disable automatic

acoustic model selec-

tion in Acoustic Opti-

mizer

Encrypt Patient

Health Information=0

or 1

When set to 1,

Dragon auto-

matically encrypts

interim files it auto-

matically creates, to

avoid the pos-

sibility of those

files being inad-

vertently accessed

by unauthorized

personnel.

Encrypt patient health

information

Data Collector

Batch Mode=0 or 1

When set to 1,

turns on a process

that automatically

Enable scheduled

Data Collection
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Options Description UI

collects data to

help improve

speech recognition

in the future. The

process sends the

data to Nuance

over the Internet,

but does not send

any personal infor-

mation - it collects

recorded dictation

and the cor-

responding text.

Collecting data for

Nuance is optional.

Allow Users to Opti-

mize=0 or 1

When set to 1,

turns on a process

that automatically

runs an opti-

mization process

on speech rec-

ognition for the cur-

rently open User

Profile.

Enable scheduled

Accuracy Tuning

Allow Users to Con-

figure Tasks=0 or 1

Turning this option

on lets users set

the schedule for

accuracy tuning and

data collection

tasks. Otherwise,

these tasks take

place on a default

schedule.

Let the user choose

when to run Accuracy

Tuning and Data Col-

lection
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Understanding Network and
Connection Settings in roamingdef.ini
File

Although you cannot edit the roamingdef.ini file because it is encrypted, you should know that

the following information is in the file. You can modify these settings through the Administrative

Settings dialog only. For more information on values for each option, refer to the Dragon Admin-

istrator Guide Help file available through the product menu:

Options Description and UI

[<Network Settings>] Display Name assigned to the network directory

where Roaming User Profiles are stored, in the

Network Directories box.

location Address. Path to a network directory, web server,

or secure web server where Roaming User Pro-

files are stored.

HTTP Settings (HTTP)

type Authentication Type.

authscheme=1 Indicates authentication is required.

queryforuserpassword Prompt for user and password check box.

authuser <domain>\<username> required to log in.

authpassword Actual password required to log in.

followredirects Follow Redirects. Never, Always, or Same Scheme

Only.

keepalive Keep Connection Alive check box.

locktimeout Lock under Timeouts. Number of seconds after

timeout expires to lock the connection.

connectiontimeout Connection under Timeouts. Number of seconds

after timeout expires to close the connection.

connectiontimeoutinactivity Type under Timeouts. Set if you selected Inactivity

option.

connectiontimeoutabsolute Type under Timeouts. Set if you selected Absolute

option.

firewall Firewall and Proxy Servers. Set if a firewall is con-

figured.
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Options Description and UI

proxy Use Proxy Server check box. Set if checked.

proxyserver Network Location. URL to the web server.

firewalltype Type. Type of firewall represented by a number.

firewallhost Server. Name of server for the firewall.

firewallport=1080 Port. Port used by the proxy server or firewall.

1080 is the default.

firewalluser Username. Login name of the admin user who can

access the firewall.

firewallpassword Password. Password to log in to the firewall.

firewalldata Firewall Data or Proxy Authorization. Special authen-

tication string for firewall or proxy server, if appli-

cable.

SSL Settings (HTTPS)

sslcertstore Certificate store text box with no label. Name of

the certificate.

sslcertstorepassword Certificate Store Password.

sslcertstoretype Certificate Store Type, indicated by numeric des-

ignation.

useopenssl Using OpenSSL check box.

opensslcipherlist Cipher List.

opensslcafile Certificate Authority File.

opensslcadir CA Directory.

tls1

ssl3

ssl2

pct1

SSL Enabled Protocols
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Carrying Out an Administrative
Installation with .bat File

A straightforward way to install Dragon from the command line to a server is to carry out an admin-

istrative installation using a .bat file.

Caution: Only advanced users should attempt any type of administrative Installation.

Note: A script for carrying out a full administrative installation, including installation of Visual

C++ Runtime for Dragon, is provided in the admininstall.bat file at the top of the directory struc-

ture on the DVD. The script provided includes a bare minimum of the options available, so you

might want to read through the Installation using the Dragon command line to find out about

other options you might use.

Understanding the script in admininstall.bat
Below are some of the lines from the script in the admininstall.bat file, a batch file that un-com-

presses setup files into a network location for installation using SMS or another service. Since any

system to be installed might be a 32-bit system or a 64-bit system, the batch file places a different

vcruntime on the server for each type of system.

To run the batch file, you enter admininstall.bat and follow it with three arguments: the locations

of the vcruntime source file for 32-bit systems, the vcruntime source file for 64-bit systems, and

the Dragon .msi file, in that order. Both 32-bit and 64-bit vcruntime files must be available for the

.bat file to run.

Near the top of the batch file, you see the lines that check the parameters entered and if the param-

eters passed are not acceptable, execute a routine that handles that situation:

:rem //Check and analyze input parameters if .%1.==.. goto bad_args if
.%2.==.. goto bad_args if .%3.==.. goto bad_args

If the arguments you pass when you enter the command are acceptable, the batch file sets the

NETWORK_VCRUNTIME_DIR variable to the first argument, the NETWORK_VCRUN-

TIME_X64_DIR to the second and NETWORK_DNS_DIR to the third:

set NETWORK_VCRUNTIME_DIR=%1% set NETWORK_VCRUNTIME_X64_DIR=%2% set
NETWORK_DNS_DIR=%3%

Notice that there are two VCRUNTIME variables. The first is for a 32-bit system and the second

for a 64-bit system. The script needs both to carry out all the action.

In the next section of the batch file, you see the lines that install Visual C++ Runtime for

Dragon, which must be installed before you can install Dragon. The batch file first installs 32-bit

computer vcruntime and displays messages as it progresses:

echo Installing Visual C++ Runtime for Dragon NaturallySpeaking...
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To install Visual C++ Runtime for Dragon, the script uses the full path to vcruntime.exe and

passes it several options:

n /a to indicate it is an administrative installation (to a server)

n /L option followed by the language ID

n /v option followed by a series of MSI installation options all enclosed in quotation marks,

including:

l TARGETDIR to indicate where to put the image resulting from an admin-

istrative installation

l /qb to display only a basic GUI

l /L to indicate the types of messages to log and the file to log them in

ISSetupPrerequisites\VCRuntime\vcruntime.exe /a /l1033
/v"TARGETDIR=%NETWORK_VCRUNTIME_DIR% /qb /L*v %TEMP%\admininstall.log"

Note: An administrative installation should always use the TARGETDIR option instead of the

INSTALLDIR option.

The batch file then installs 64-bit vcruntime using the full path to vcruntime_x64.exe and passes

it the same options:

echo Installing Visual C++ Runtime for Dragon NaturallySpeaking 64bit
(x64)... ISSetupPrerequisites\VCRuntime\vcruntime_x64.exe /a /l1033
/v"TARGETDIR=%NETWORK_VCRUNTIME_X64_DIR% /qb /L*v %TEMP%-
\admininstall.log"

If you have Version 10, rather than Version 10.x or 11, you have only the 32-bit version and need

to use a different path:

ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-ADE12FB7DEC5}-
\vcruntime.exe /a /l1033 /v"TARGETDIR=%NETWORK_VCRUNTIME_DIR% /qb /L*v
%TEMP%\admininstall.log"

When the installation of Visual C++ Runtime succeeds or fails, the batch file displays the appro-

priate message.

Finally, the log file installs Dragon, using a single line of code that calls the setup.exe command

and passes it:

n /a option — Indicates administrative install

n /s option for a silent no-GUI installation

n /v option to indicate msiexec options follow, enclosed in quotation marks

The msiexec options with /v include /qb for display of a basic GUI during the process, the TAR-

GETDIR setting, and a /L with a series of log file options, including the name and location for

the log file:
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echo Installing Dragon NaturallySpeaking... setup.exe /a /s /v"/qb TAR-
GETDIR=%NETWORK_DNS_DIR% /L*v %TEMP%\admininstall.log"

When the installation of Dragon succeeds or fails, the batch file displays an appropriate message.

The remainder of the file handles errors and cases where bad arguments are passed on the com-

mand line.

Modifying admininstall.bat
You can modify the admininstall.bat file by adding to and changing the options you pass for instal-

lation Visual C++ Runtime, then Dragon. You can add more options and/or modify the options

shown here. For more on installation options, refer to Installation using the Dragon command line

or these summaries:

n MSI Options Specific to Dragon

n MSI Options for Installing Dragon Features/Advanced Options

n Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties

n MSI Options for Roaming User Profile, Tuning, and Data Collection Setup
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Install Dragon on an initial computer
and choose the default settings

Before you proceed, you should be familiar with installing the product on a single computer from

the DVD. For more information, see Installing, modifying and upgrading Dragon.

The initial installation is used to set default values for the Administrative, User and Auto-For-

matting options. These options can then be used to install on other computers using the same

values.

Even if you are installing from a server, you should run through the initial installation below first.

For more information on installing from a server, proceed to Overview of the Network Instal-

lation of Dragon from a Server.

Caution: If you want to set any administrative settings, be sure you have Windows administrator

privileges. Administrator rights are not required to create a User Profile or use the software after

installation.

Before you begin:

n Install any pending Windows updates and reboot the computer when you are finished.

n Close all open applications.

n Turn off or disable antivirus software; the installation process can sometimes trigger a false virus

report.

Note: An alternative to this approach is to use msiexec.exe to install Dragon, covered under Step-

by-Step Command Line Installation with msiexec.exe.
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Extracting MSI/MST Files from the
Dragon setup.exe

Some minor release of Dragon, Service Pack 1 of Dragon 10 for example, do not include a .MSI

file, they are supplied with a setup.exe.

You can carry out an administrative installation using setup.exe, as follows:

n Create a server image of Dragon files for later installing clients. You create the image by

executing setup.exe and passing it the /a option and a Dragon-specific option that extracts MST

and MSI files from the Dragon setup.exe file provided.

n Use the options to extract the MSI/MST Files from the Dragon setup.exe.

Extracting MSI/MST Files from setup.exe
The following setup.exe options are designed to extract .msi/.mst files for Windows Installer-

oriented distributions.

Note: When you install Dragon 11 , Dragon installs using the primary language for the product.

You cannot install Dragon using a language that is different than the primary language. For exam-

ple, when you install Dragon 11 , Professional - English version, Dragon installs using the English

language.

If you attempt to use the /l option with setup.exe to install Dragon 11 using a non-primary lan-
guage, the installation process uses the primary language for that edition of Dragon and ignores the

/l option.

These options do not install any files, but rather extract an installable set of files into the server

directory you specify.

Option Description

/a Administrative installation. Instructs

setup.exe to perform an administrative instal-

lation to a network for use by a workgroup

instead of a normal installation. This option is

required when trying to extract the .msi files.

An administrative installation installs a source

image of the application onto the network. The

image is similar to a source image on a CD or

DVD. Users in the workgroup who have

access can then install the product over the net-

work from this source image.

/a Administrative installation. Instructs

setup.exe to perform an administrative instal-

lation to a network for use by a workgroup
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Option Description

instead of a normal installation. This option is

required when trying to extract the .msi files.

An administrative installation installs a source

image of the application onto the network. The

image is similar to a source image on a CD or

DVD. Users in the workgroup who have

access can then install the product over the net-

work from this source image.

/v"<msiexec options>" Passes msiexec options to Windows Installer.

See table ofmsiexec options for details. This

option is required when trying to extract the

.msi files.

/l<Windows Language Code>  Specifies the language to use for installing

Dragon. For example, to launch the installation

in French, the command line would include

/L1036. The language codes supported for

installing Dragon NaturallySpeaking are:

1031=German

1033=English

1034=Spanish

1036=French

1040=Italian

1043=Dutch

Also creates an MST file for the language you

specify, such as 1036.MST.

EXTRACTFILES="c:\xyz" For installing Version 10 Service Pack 1 only.

Indicates the directory where the extracted

.msi/.mst files are to be written. Long path

names containing spaces need to be in quo-

tation marks escaped by having a backslash pre-

cede each quotation mark (\"). This property is

required to extract the .msi files. If the direc-

tory you specify does not exist, the installer

creates it.

Here is a sample command line to extract msi

files from a single executable:

setup.exe /a /s /v"-
EXTRACTFILES=c:\temp\msifiles"

114



Chapter 5: Installing Dragon using the Windows installer (MSI)

Option Description

TARGETDIR=”C:\xyz” Use with administrative installations only. Indi-

cates the full path to where to install the image

of Dragon.

115



Dragon Administrator Guide version 11

Using .MSI/.MST Files for Custom
Installations Example

Using .MST files you can tailor the MSI installation without changing the setup.exe file that

Nuance provides.

Note: When you install Dragon 11 , Dragon installs using the primary language for the product.

You cannot install Dragon using a language that is different than the primary language. For exam-

ple, when you install Dragon 11 , Professional - English version, Dragon installs using the English

language.

If you attempt to use the /l option with setup.exe to install Dragon 11 , using a non-primary lan-
guage, the installation process uses the primary language for that edition of Dragon and ignores the

/l option.

Step1: Running setup.exe to Extract .MSI and .MST
Files
The following sample command line extracts the Dragon NaturallySpeaking 10.msi and the .MST

file used for installing Dragon :

setup.exe /a /s /v"EXTRACTFILES=c:\temp\MSIfiles /qn"

Caution: The first time you try any command line, you should not run it in Silent mode, because if

you have neglected to provide required information, you then receive a GUI prompt for that infor-

mation.

Next, you specify the extracted .MSI and .MST files in a command line to install Dragon . The

next two examples show how these files are used running first setup.exe, then msiexec.exe.

Step 2: Passing MST File to setup.exe to Install
Dragon
This sample command line launches setup and installs Dragon into the C:\Dragon directory:

setup /a /s /v"INSTALLDIR=\"C:\<full_path>\Dragon\" /qn

Alternative Step2: Passing MST File to msiexec.exe to Dragon

Before actually use the MST file you extracted in the previous step to install Dragon on the com-

mand line with msiexec.exe, you must install Visual C++ Runtime for Dragon, as outlined here.

1. Find the ISSetupPrerequisites/VCRuntime directory on the product DVD and open it. In the

directory you find the vcruntime.exe and vcruntime_x64.exe files. (If you are installing Version

10 rather than Version 10.x or 11, look in the ISSetupPrerequisites\{1FAD9007-0FF1-4B05-

B7CE-ADE12FB7DEC5} directory instead.)

116



Chapter 5: Installing Dragon using the Windows installer (MSI)

2. Copy the vcruntime files to your server or to another accessible location. These .exe files install

Visual C++ Runtime for Dragon. Run vcruntime.exe on each 32-bit computer where you

intend to install Dragon and vcruntime_x64.exe on each 64-bit computer.

Caution: Do not attempt to extract the .msi file from either vcruntime.exe or vcruntime_

x64.exe. Installing the Visual C++ Runtime for Dragon as part of an msiexec.exe command line

installation of Dragon is not recommended and not supported.

3. After you have installed Visual C++ Runtime for Dragon, enter a command line like the fol-

lowing, which demonstrates how to use the .msi file you extracted earlier with setup.exe to do

an administrative installation of the SDK Client Edition:

msiexec /a "D:\Dragon SDK Client Edition 10.msi" /l*v %TEMP%\dgnsetup.log /q

The /q option runs the installation in Quiet mode.

For more on using the Microsoft Windows Installer, refer to

http://msdn2.microsoft.com/en-us/library/Aa372866.
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Installation using the Dragon
installation process

Perform the following steps to use the user interface of the Dragon installation process:

1. Insert the product DVD in the DVD drive. If the installation does not start, run setup.exe from

the DVD.

2. Choose the Custom installation with appropriate languages and vocabularies.

3. Choose the Custom installation with appropriate vocabularies.

4. Choose the following check boxes under Additional options to have additional dialog boxes

pop up at the end of the installation, where you can make changes that affect all users dictating

on this computer.

l Modify the application's settings for all user profiles - Displays the Options dialog box

at the end of the installation.

l Modify the administrative settings - Displays the Administrative Settings dialog box at

the end of the installation, where you set up the Roaming feature, where to backup your

User Profiles, and who can modify commands/vocabularies.

l Auto-Formatting options - Displays the Auto-Formatting dialog box at the end of the

installation, where you apply uniform formatting to all documents dictated at this instal-

lation; for example, formats for dates, times, and phone numbers.

5. When the Options dialog box appears, select the default options that should apply to all client

installations and click OK. This dialog box is where you set up all the options under the various

tabs (Correction, Command, and so on). In Dragon Medical, you can also program custom

actions into the buttons on the PowerMic I and PowerMic II microphones.

Note: Settings under the Playback/Text-to-Speech tab are not saved. To include Text-to-

Speech as a feature of your installation, work with options in Summary: MSI Options for Install-

ing Dragon Features/Advanced Options.

Note: At least one supported third-party indexing/search software should be installed on the

system before you install Dragon, or the Enable Desktop Search commands check box will not

only be unchecked, but will not be available to be checked. Dragon supports Google Desktop

and Microsoft Vista Search.

6. When the Auto-Formatting dialog box appears, select Auto-Formatting options to apply to all

client installations and click OK.

7. When the Administrative Settings dialog box appears, if you want to set up Roaming User Pro-

files, set the options under Roaming User Profile (to set the HTTP or HTTPS settings under

the HTTP Settings or HTTPS Settings button, you must have either http:// or https:// in

front of the network directory path); whether you have Roaming User Profiles or not, set the

options under Miscellaneous and Scheduled Tasks tabs and click Apply for each; then, when

you have set all the settings, click OK.

8. Dragon has saved the configuration you created with running natspeak.exe in the nsdefaults.ini

and roamingdef.ini files (the roamingdef.ini file is created only if you set up Roaming User
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Profiles). You can find these .ini files under
C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking11\.
These .ini files are now considered customized files, because they now they contain the custom

settings that will be applied to each of the DNS client installations you deploy. Retrieve the

nsdefaults.ini and roamingdef.ini files and copy them to a directory where you can access them

from the other client computers. (If you did not run natspeak.exe on the command line, you do

not find a roamingdef.ini file; in that case, you can use a roaming.ini file from an existing instal-

lation whose settings you’d like to replicate. If you did not change the Network Settings, you

do not need a roamingdef.ini or roaming.ini file at all.)

You are now ready to install the same configuration you just established here onto other com-

puters.

Notes:

n If you are installing Dragon on more than one client computer and over a network, you can use

the same .ini files with the MSI Installer (msiexec). You also use SMS Server or another server-

based program that pushes the installation out to several clients at once. Even if you are

installing from a server, you should run through the initial installation before you carry out the

administrative installation. Then, for more information on installing from a server, proceed to

Overview of Pushing Client Installation from Server.

n When you install Dragon 11 , Dragon installs using the primary language for the product. You

cannot install Dragon using a language that is different than the primary language. For example,

when you install Dragon 11 , Professional - English version, Dragon installs using the English

language. If you attempt to use the /l option with setup.exe to install Dragon 11 using a non-
primary language, the installation process uses the primary language for that edition of Dragon

and ignores the /l option.
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Install the Same Configuration on
Additional computers

Note: If you chose Enable Desktop Search Commands on the Commands tab during the initial

installation, you must install Google Desktop or Microsoft Vista Search before you install Dragon;

otherwise, that option does not take effect..

1. Be sure you can access the .ini files you created in the previous procedure from the computer

you will be installing on or copy the files to a local path on the client computer where you are

about to install Dragon.

2. Be sure you have the Dragon serial number (or the group serial number, if you are installing

Dragon to multiple computers on a network).

3. Be sure all mapped drives you plan to use are mapped on individual client computers where you

are distributing the installation.

4. Install any pending Windows updates and reboot the computer.

5. Open a command line window (Start > Run cmd).

6. Insert the product DVD in the DVD drive and search the DVD for the path where the Dragon

setup.exe is located.

7. On the computer where you are installing Dragon, to install the same configuration you created

during the initial installation, enter the following on the command line (using the customized

nsdefaults.ini file) of a single client. You pass the Dragon serial number for the SERI-

ALNUMBER option and the full path to the nsdefaults.ini file using the DEFAULTSINI

option (this line assumes no Roaming User Profiles):

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon11\"
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

/L*v C:\Logs\logfile.log

Note: The full path for the DEFAULTSINI setting uses escaped out quotation marks (pre-

ceded by a backslash) only when there are spaces in the full path.

Caution: The first time you test any installation, you should pass /q rather than /qn so that if

you have neglected to provide information about a setting that does not have a default, you

receive a GUI prompt for that information.

8. If you entered a network address in the Network Directories box and set up HTTP or HTTPS

settings in the Roaming tab of the Administrative Settings dialog during the initial installation,

those settings are transferred to your client computers only if you include the ROAM-

INGUSERINI option, set to roamingdef.ini:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon11\"
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"

/L*v C:\Logs\logfile.log
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You include the bolded portion of the above command lines so that if something goes wrong

during the installation, you receive messages about it. You pass /L and a series of sub-options

followed by a log file name to have the installation log errors and other messages related to the

process. (You can send the log file to technical support should any issues arise.)

Note: You can also use the /qn option to install the product in Quiet mode, where no GUI or

other messages appear. Another option, the /passive mode, runs the entire installation unat-

tended, but displays a progress bar. However, the first time you run any installation command

line, you should not use the /qn option, because turning off the GUI also turns off any mes-

sages that help you determine any problems with that command line. To use the /qn option,

add it to the end of the command line:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon11\" DEFAULTSINI=\"C:\<full_path>\ns-
defaults.ini\"
/L*v C:\Logs\logfile.log /qn

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon11\" DEFAULTSINI=\"C:\<full_path>\ns-
defaults.ini\"

ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\" /L*v C:\Logs\logfile.log
/qn
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Creating Custom Installation Using
Microsoft Custom Install Wizard

If you are installing Dragon on a network, you can create a custom installation program using a set

of tools available from Microsoft.

1. Download and install the tools

2. Run the wizard

You are then ready to use the custom installer to install the product.

Installing the Microsoft Custom Installation Wizard
The Microsoft Custom Installation Wizard is part of the Microsoft Office Resource Kit Tools. To

install the Custom Installation Wizard:

1. Download the Office Resource Kit Tools (OrkTools.exe) from:

http://www.microsoft.com/office/orkarchive/xpddl.htm. The OrkTools.exe self-
extracting executable (EXE) file installs the core Office XP Resource Kit tools on your com-

puter through a single Setup program.

2. After downloading OrkTools.exe, to install the tools, you either double-click the executable or

select Start > Programs >Microsoft Office Tools >Microsoft Office XP Resource Kit

Tools.

After you install the tool, you use its Custom Installation Wizard to create your custom instal-

lation. For details on using the wizard, proceed to Modifying setup Properties for Custom Instal-

lation.

Modifying setup Properties for Custom Installation
The following explains how to modify setup properties for a custom installation of Dragon. This

example shows how to add to the installer configuration one of the many MSI options you can set

for installing Dragon, the SERIALNUMBER property. (You can add any options available to MSI

on the command line.)

1. Start the Microsoft Custom Installation Wizard by choosing Start > Programs >Microsoft

Office Tools >Microsoft Office XP Resource Kit Tools, and then click Custom Instal-

lation Wizard. The Custom Installation Wizard screen displays:
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2. Click Next.

3. On the Open the MSI File page of the wizard, shown below, select the .MSI file you want to

use to create a custom installation. The compiled .MSI file is located on your installation CD.

The files are named:
n Dragon NaturallySpeaking or Dragon Medical: Dragon NaturallySpeaking 11.msi

n Dragon SDK Client Edition (DSC): Dragon SDK Client Edition11.msi

n Dragon SDK Server Edition (DSS): Dragon SDK Server Edition11.msi
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4. The following example uses Dragon NaturallySpeaking 10.msi.

5. Click Next.

6. Click Yes when you see the following message:

7. On the Open the MST File page of the wizard, select Create a new MST file.

8. Click Next to continue.

9. On the Select MST File to Save page of the wizard, select a file name and path for the MST file

you are creating:
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10. Click Next.

11. On the Specify a Default Path and Organization page, select the default path for the installation.

By default, Dragon installs in \Program Files\Nuance\NaturallySpeaking11.
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12. Click Next.

13. On the Remove Previous Versions page, keep the default selections and click Next. This page

applies only to Microsoft Office and does not affect the Dragon installation.

14. Click Next to keep all the defaults when you come to the Set Features Installation States page,

where you select particular components to install. The illustration here shows some of the Med-
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ical vocabularies you might choose:

15. On the next several pages of the wizard, click Next on each, and proceed until you reach the

Modify Setup Properties page. All the pages in between apply only to Microsoft Office or do

not affect the Dragon SDK Client Edition installation.
n Customize Default Application Settings page

n Change Office User Settings page

n Add/Remove Files page

n Add/Remove Registry Entries page

n Add, Modify, or Remove Shortcuts page

n Identify Additional Servers page

n Specify Office Security Settings page

n Add Installations and Run Programs page
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16. Use the Modify Setup Properties page, shown below, to add, modify, and set the MSI options

of your custom installation.

17. Click the Add... button to display the Add/Modify Property Value dialog box, where you mod-

ify the MSI installation options. In this example, we add and set the SERIALNUMBER option.

18. In the following Add/Modify Property Value page, enter the new property name SERI-

ALNUMBER and a valid serial number, then click OK:

19. Note that the Modify Setup Properties page re-displays with the updated information. For exam-

ple:

20. Continue adding or modifying other MSI options that apply for your environment. Once you are

done, click Next.
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21. On the Save Changes page, click Finish.

22. When the Custom Installation Wizard page appears, click Exit. This screen displays the location

of Windows Installer transform (.MST file) that you created.

After you save changes, you can use the resulting .MST file to manage an installation through a

Group Policy in Active Directory Services.

You are now ready to use the custom installer you created to install the product.
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Installation using the Dragon
command line

When you install Dragon 11 , Dragon installs using the primary language for the product. You can-

not install Dragon using a language that is different than the primary language. For example, when

you install Dragon 11 , Professional - English version, Dragon installs using the English language.

If you attempt to use the /l option with setup.exe to install Dragon 11 using a non-primary lan-
guage, the installation process uses the primary language for that edition of Dragon and ignores the

/l option.

Perform the following steps to use the Dragon command line:

1. Open a command line window (Start > Run and enter cmd).

2. Insert the product DVD in the DVD drive, search the DVD for the path where the Dragon

setup.exe is located, and switch directories to the path on the product DVD where the Dragon

setup.exe is located.

3. Enter the following command line to install Dragon on this initial computer (ignore any errors

you receive regarding the serial number, as it is not required for this in initial installation, unless

you plan to dictate later):

setup.exe /s /v"INSTALLDIR=c:\Dragon11 /L*v C:\Logs\logfile.log /qn"

The /s option sets the silent option for the every .exe that setup.exe provides a wrapper for,

including the vcruntime.exe service that setup.exe automatically installs for you, so that no GUI

pops up. By contrast the /qn inside the quotation marks after /v sets the silent option for the

Dragon installation.

The /v option introduces any series of msiexec.exe options you want to pass to the Windows

installer, all enclosed in quotation marks after the /v, with no space allowed between the /v and

the opening quotation mark. Among the options inside the quotation marks are:

n INSTALLDIR — Indicates the full path to where you want Dragon installed

n /L*v — (either upper or lowercase) Indicates the log file where messages about the installation

should be written

n /qn — (Quiet mode—also called Silent mode—no GUI) Turns off the Dragon GUI

Caution: The first time you test any installation, you should not run it in Silent mode, because if

you have neglected to provide information about a setting that does not have a default, you

receive a GUI prompt for that information. You should initially pass the /L*v option because it

runs the entire installation GUI. When the Welcome dialog appears, you can stop and look into

the log file., where you can search for Command line to verify that all command line parameters

are being incorporated. The line you find will have this format:

MSI (c) (##:##)[##:##:##:###] Command Line: <OPTION>=<value>
<OPTION>=<value> ...

The above command line is to install the primary language of the Dragon product.
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Logging errors and other messages

Sub-options for /L indicate the types of messages to send to the log:

Sub-option Message type sent to log file

i Status messages

w Nonfatal warnings

e All error messages

a Start up actions

r Action-specific records

u User requests

c Initial UI parameters

m Out-of-memory or fatal exit information

o Out-of-disk-space messages

p Terminal properties

v Verbose output

x Extra debugging info (Windows Server 2000 only)

+ Append to existing log file

* Wildcard. Log all info except v and x options

*vx Log all info including v and x options

Running natspeak.exe to Set Options
When the installation completes, you then set up the configuration on this initial computer by run-

ning natspeak up to three times, in the steps that follow. All steps are optional; by skipping a step,

you are choosing to accept the default values for the options applicable for associated options.

1. On a workstation PC where Dragon is installed, close Dragon if it is running.

2. From the Windows Start menu, select All Programs > Accessories > Command Prompt to

open the Command Prompt window.

3. Switch to the Program directory. The default is:

C:\Program Files\Nuance\NaturallySpeaking11\Program
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4. Enter the following natspeak command:

natspeak.exe /setdefaultsoptions

5. When the Options dialog box appears, select the default options that should apply to all client

installations and click OK. This dialog box is where you set up all the options under the various

tabs (Correction, Command, and so on). In Dragon Medical, you can also program custom

actions into the buttons on the PowerMic I and PowerMic II microphones.

Note: Settings under the Playback/Text-to-Speech tab are not saved. To include Text-to-

Speech as a feature of your installation, work with options in Summary: MSI Options for Install-

ing Dragon Features/Advanced Options.

Note: At least one supported third-party indexing/search software should be installed on the

system before you install Dragon, or the Enable Desktop Search commands check box will not

only be unchecked, but will not be available to be checked. Dragon supports Google Desktop

and Microsoft Vista Search.

6. Enter another natspeak command:

natspeak.exe /setdefaultformattingoptions

7. When the Auto-Formatting dialog box appears, select Auto-Formatting options to apply to all

client installations and click OK.

For example (Dragon Medical):
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8. Enter a final natspeak command:

natspeak.exe /setdefaultadministrativeoptions

9. When the dialog box appears, if you want to set up Roaming User Profiles, set the options

under Roaming User Profile (to set the HTTP or HTTPS settings under the HTTP Settings or

HTTPS Settings button, you must have either http:// or https:// in front of the network direc-

tory path); whether you have Roaming User Profiles or not, set the options under Miscellaneous

and Scheduled Tasks tabs and click Apply for each; then, when you have set all the settings,

click OK.

10. Dragon has saved the configuration you created with running natspeak.exe in the nsdefaults.ini

and roamingdef.ini files (the roamingdef.ini file is created only if you set up Roaming User Pro-

files). You can find these .ini files under
C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking11\.

Note: If you do not find the nsdefaults.ini file in the sub-folders under All Users, navigate to
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All Users.WINDOWS, or administrator, or any other Documents and Settings sub-folders for

other users on this workstation until you locate the nsdefaults.ini file. It’s possible that the

workstation was configured so that a different “user” folder is the default for application data

for Nuance and other applications.

These .ini files are now considered customized files, because they now they contain the custom

settings that will be applied to each of the DNS client installations you deploy. Retrieve the

nsdefaults.ini and roamingdef.ini files and copy them to a directory where you can access them

from the other client computers. (If you did not run natspeak.exe on the command line, you do

not find a roamingdef.ini file; in that case, you can use a roaming.ini file from an existing instal-

lation whose settings you’d like to replicate. If you did not change the Network Settings, you

do not need a roamingdef.ini or roaming.ini file at all.)

11. When you have located the nsdefaults.ini file, verify that your option settings have been

changed. Double-click the nsdefaults.ini file to open it in a text editor. You should see values

defined for the options you changed.

Example: If the Capitalize ‘allergy’ and ‘allergies’ as ‘ALLERGY’ and ‘ALLERGIES’ option has

been turned on, the nsdefaults.ini file contains this statement:

12. Include the newly created nsdefaults.ini file in your MSI package to distribute the file to all user

workstations where Dragon is installed.

For more on natspeak.exe command line options, refer to natspeak Command Line Switches.

You are now ready to install the same configuration you just established here onto other com-

puters.

Note: If you are installing Dragon on more than one client computer and over a network, you can

use the same .ini files with the MSI Installer (msiexec). You also use SMS Server or another

server-based program that pushes the installation out to several clients at once. Even if you are

installing from a server, you should run through the initial installation before you carry out the

administrative installation. Then, for more information on installing from a server, proceed to

Overview of Pushing Client Installation from Server.
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Natspeak.exe command line reference
You can use command line options to modify the way that Dragon NaturallySpeaking or Dragon

Medical starts up.

These switches are used in the following syntax:

natspeak /switch

where /switch is one or more switches from table below (each switch is a single word without

spaces or hyphens):

Switch Function

/diagnose Runs Dragon in diagnostic mode to output

info to Dragon.log file and exits.

/user <user> Automatically loads the user profile.

/topic <topic> Automatically loads the topic (Pro-

fessional/Medical/Legal editions only).

/quick Runs Dragon in QuickStart mode, a mode

that starts Dragon without loading a user

profile or any speech models on startup of

your computer.

/SetDefaultOptions Options Displays the Options dialog box at

the end of the installation.

/SetDefaultAdministrativeOptions Options Displays the Administrative set-

tings dialog box at the end of the instal-

lation.

/SetDefaultFormattings Options Displays Auto-Formatting dialog

box at the end of the installation.
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Other Actions You Can Take on
Command Line

Here are other (optional) actions you can take on the command line as part of a silent installation:

Note: In Dragon 11 , the installation process does not present the QuickStart option. If you wish

to enable this option, you can do so after Dragon is installed.

Additional Options for Silent Installations

n Modifying the Default Installation Directory

n Configuring Installation of Product Updates

n Suppressing Reboot of the computer After Installation

n Installing Same Roaming User Profile Configuration on Additional computer(s)

Additional Options with Extensive Settings for Silent Installations

n Revising Day/Time of Scheduled Tasks (Optional)

n Configuring Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional)

136



Chapter 5: Installing Dragon using the Windows installer (MSI)

Modifying Default Installation
Directory

If you want to set an installation directory other than the default, pass INSTALLDIR="<full path

to install>" on the command line (note that the quotation marks are required only if you have

spaces in the path):

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon11\" /L*v C:\Logs\logfile.log /qn"

Note: If the installation directory does not have spaces, note how the INSTALLDIR directory is

designated in the command line:

setup.exe /v"INSTALLDIR=C:\Dragon11 ADDLOCAL=ALL"

If the installation directory has space(s), it is surrounded in quotation marks that are escaped out

by having backslashes precede them (shown in bold):

setup.exe /v"INSTALLDIR=\"C:\NaturallySpeaking11\" ADDLOCAL=ALL"

Caution: The first time you try any installation, you should not run it in Silent mode, because if

you have neglected to provide information about a setting that does not have a default, you

receive a GUI prompt for that information.
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Configuring Installation of Product
Updates

If you want the individual client computer to download product updates to Dragon over the web,

you would set the PRODUCTUPDATEFLAG option to 1 (option checks the check box). If you

prefer to install the updates on the servers and later distribute them to client computers, set this

option to 0 (unchecks the check box). If your enterprise does not install service packs provided

by Nuance, Nuance recommends you set this flag to -1:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon11\"
PRODUCTUPDATEFLAG=-1 /L*v C:\Logs\logfile.log /qn"
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Suppressing Reboot of the computer
After Installation

To suppress rebooting of the computer after installation of Dragon completes, you can pass Micro-

soft's REBOOT option set to ReallySuppress. Using this option also suppresses the reboot some-

times required by the installation of Visual C++ Runtime for Dragon, which setup.exe installs in

the background. Using this option is highly recommended if you are executing a silent installation

(But if system updates are pending, rebooting is required for DNS to work normally.

REBOOT=ReallySuppress

The altered command line would look like this:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon11\" /qn
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress
/L*v C:\Logs\logfile.log /qn"
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Installing the same Roaming User
Profile Configuration on Additional
computer(s)

Use the roamingdef.ini file you created during the initial installation as the input for the ROAM-

INGUSERINI option in this format (be sure to use the full path to the file when you pass the

option):

ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"

The default is empty (no .ini file will be used). Include the ROAMINGUSERINI option in the

installation command line:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon11\"
ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"
/L*v C:\Logs\logfile.log /qn"

The example above assumes that the full path has spaces in it, so it has escaped out quotation

marks around the option value. After you have completed the installation, verify that all options

are correctly set on the client computer.
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Revising Day/Time of Scheduled
Tasks (Optional)

This section describes how to modify the schedule for Dragon tasks to later take place on each dic-

tation client computer by passing particular options in a command line installation. This section is

a continuation of Installation using the Dragon command line. When you finish this section, you

might want to proceed to Configuring Local or On-Demand Install of Vocabularies/Text-to-

Speech (Optional).

Note: You take the following actions on the client computer to install Dragon on client PCs, not

on the computer where you installed the initial installation and configured default option settings

for users.

You can include an additional option on the command line to indicate you want on any or all of

the following tasks carried out on a particular schedule:

n Acoustic model optimization (ACO) — This task optimizes the acoustic files used to recognize

words that the user trains and speaks. You can set a particular date and time for this

optimization to occur. When a speaker is new to Dragon, you might want to run the

optimization more often, after the speaker has worked with Dragon for a while.

n Language model optimization (LMO) — This task optimizes the language model (vocabulary

files) used to help recognize words that the user speaks. The model incorporates data from the

user’s speech into the language model he or she is using, ultimately customizing the model for

that user profile.

n Data Collection (DC) — This task automatically collects data that helps improve Dragon’s

ability to recognize speech. You can choose to allow this data to be sent back to Nuance over

the Internet on a particular schedule or choose not to send the data. This process does not

collect your personal information.

You turn on/off the above tasks and set the schedule for those you turn on by passing an option

called PERIODIC_TASK to the MSI installer. You set PERIODIC_TASK to a string containing

short acronyms for the types of tasks, aco | lmo | dc, separated by vertical bars. If you do not

pass the acronym for the feature, that feature is set to its default.

After the acronyms for the tasks to schedule, the string for PERIODIC_TASK should include the

administrator login and password, then the schedules that correspond to the acronyms, in the

order that they occur in the string. The schedules use three-letter weekday abbreviations and 24-

hour time with two digits for the hour and two for the minute, separated by a colon. The two

schedules are separated by vertical bars and presented in the same order as their corresponding

acronyms. While the acronyms for the tasks are separated from each other by vertical bars, sem-

icolons separate the group of tasks from the admin user name, password, and group of schedules.

For instance, to retain the default schedule for data collection and modify schedules for acoustic

model optimization to Mondays at 1 AM and language model optimization to Mondays at 6 AM,

you would set PERIODIC_TASK as follows:

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"

An installation command line including this task setting option might look like the following:
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setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon11\"
ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
/L*v C:\Logs\logfile.log /qn"

For more information on the PERIODIC_TASK option, refer to MSI Options for Roaming User

Profile, Tuning, and Data Collection Setup.
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Configuring Local or On-Demand
Install of Vocabularies/Text-to-
Speech (Optional)

This section describes how to enable Roaming User Profiles in a command line installation and is

a continuation of Installation using the Dragon command line.

Note: You take the following actions on the client computer where you want to install Dragon,

not on the computer where you carry out the initial installation.

Installing only particular vocabularies locally,
others on-demand
When you install Dragon or Dragon Medical on a client computer as outlined in Installation using

the Dragon command line, by default you install all the available vocabularies locally.

If you do not want all of those vocabularies to be installed locally, but to instead have them

installed only if/when a user attempts to deploy a particular vocabulary, you can indicate that fact

on the installation command line by adding the ADDLOCAL option and setting it to the names of

the vocabularies to install locally. For example, say you want to do a partial installation of Dragon

Medical and you only want to install the General Medical vocabulary and the Radiology vocab-

ulary, you set ADDLOCAL to NatSpeak, ENUMedical, ENURadiology, and the command line

would appear as follows (NatSpeak must be in the setting of ADDLOCAL, unless you set ADD-

LOCAL to ALL; otherwise, the installation fails):

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon11\" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress ADDLOCAL=NatSpeak,ENUMedical,ENURadiology
/L*v C:\Logs\logfile.log /qn"

Note: There must not be any spaces between the arguments specified for ADDLOCAL.

If you want other vocabularies to be available, you set ADDLOCAL to ALL and set the ADVER-

TISE property to a list of additional vocabularies. The command line might look like the fol-

lowing:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon11\"
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress ADDLOCAL=ALL
ADVERTISE=ENUCardiology,ENUEmergency,ENUGastroenterology
/L*v C:\Logs\logfile.log /qn"

Separate the features/vocabularies for ADDLOCAL with commas, but do not put spaces in the

list. The names you must use for the vocabularies consist of a prefix for the language, then the
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name of the vocabulary, such as ENU for English and Cardiology to form ENUCardiology. For a

list of the exact names for features/vocabularies you can assign to ADDLOCAL or ADVERTISE

on the command line, refer to MSI Options for Installing Dragon Features/Advanced Options.

Installing Text-to-Speech feature
To install Text-to-Speech locally, you would include the feature in the list of features for ADD-

LOCAL; for instance, you would add TTSENX for Text-to-Speech in English:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon11\"
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress
ADDLOCAL=TTSENX,NatSpeak,ENUMedical
/L*v C:\Logs\logfile.log /qn"

Links to Summaries of MSI Options

For more information, see these summary topics:

n MSI Options Specific to Dragon.

n Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties

n MSI Options for Roaming User Profile, Tuning, and Data Collection Setup
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Upgrading Your Dragon Installation
from the Command Line

There are two command line upgrade scenarios:

n Major Upgrade—Upgrading from Version 9, 9.x, 10, or 10.x to Dragon 11

n Minor Upgrade—Upgrading to a higher point release within the same edition and version of

Dragon. For example, upgrading from Dragon 11.0 to Dragon 11.x.

All of these types of upgrades can either display the GUI or be silent (not display the GUI),

except the minor upgrade, which does not support the silent option. Upgrades to Dragon 11 are

only supported for Dragon 9.x and 10.x.

An administrator cannot upgrade User Profiles with the command line installation. For more infor-

mation on upgrading Roaming User Profiles, see the section below. If User Profiles are not Roam-

ing User Profiles, administrators run the User Profile Upgrade Wizard after installation

completes.

Upgrading Roaming User Profiles
Before upgrade User Profiles, administrators must upgrade Roaming User Profiles in the Roaming

User Profile directory. Afterwards, administrators can upgrade Dragon on the client computers

and the Roaming User Profiles become available as soon as the upgrade is complete.

See "Upgrading User Profiles to Dragon version 11 " in Dragon version 11 - What's New for

administrators for more information.

Background on Roaming User Profiles

Before administrators upgrade Roaming User Profiles from Dragon NaturallySpeaking or Dragon

Medical 9.x or 10.x to Version 11, they need to recall some basics about how the Roaming feature

works: Each Dragon user has a master Roaming User Profile that can be opened from any net-

worked computer where Dragon is installed. The master Roaming User Profiles are stored on a net-

work location. When a master Roaming User Profile is opened from that central network location,

Dragon transfers a copy of that User Profile to the Local Roaming User Profile on the computer

where the user is dictating.

Recommended Approach

Since the Local Roaming User Profile is a copy of the user data taken from the master Roaming

User Profile, it does not make any sense to directly upgrade the Local Roaming User Profile when

upgrading the local Dragon installation.

Instead, administrators should install Dragon 11 directly on the network computer where the

Dragon 9.x or 10.x Master Roaming User Profiles are located and upgrade those Master Roaming

User Profiles directly. After upgrading the master Roaming User Profiles, administrators can then

proceed to upgrade end-user systems that deploy the Roaming feature.

Notes:
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n Even though the Dragon 11 User Profile Upgrade Wizard supports both mapped drives and

UNC paths, Nuance strongly recommends upgrading the Master Roaming User Profiles on a

drive on a computer where Dragon 11 is locally installed. Nuance does not recommend

upgrading the Master Roaming User Profiles across a network to either a mapped drive or UNC

path; upgrading over a network will take a undetermined length of time. In addition, the User

Profile Upgrade Wizard does not support upgrading User Profiles over an HTTP connection.

n Upgrading the master Roaming User Profiles to Dragon 11 leaves the 9.x or 10.x master

Roaming User Profiles unchanged, so that the users in the network can run Dragon 9.x or 10.1

while the administrator plans the upgrade.

n If upgrading from Dragon version 8.x or earlier to Dragon 11 , version 8.x or earlier custom

words and commands can be re-used in Dragon 11 : 

1. In Dragon 8.x or earlier, export the custom words and commands

2. In Dragon 11 , create a new User Profile

3. In Dragon 11 , import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and

commands.
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Step-by-Step Process for Upgrading
Roaming User Profiles

1. Plan to upgrade the master Roaming User Profiles at a time when they are not being opened by

end users, for example during the night or on a weekend. Nuance recommends backing-up User

Profiles before upgrading them.

2. Install Dragon 11 on the computer where the Dragon 9.x or 10.x Master Roaming User Profiles

are located. If that is not possible, Nuance recommends that installing Dragon 11 on a separate

computer where you will perform the upgrades.

OR

If unable to install Dragon where the Dragon 9.x or 10.x Master Roaming User Profiles are

located, Nuance recommends administrators:

n Install Dragon 11 on a separate computer where they will perform the upgrades.

n Copy the Dragon 9.x or 10.x Master Roaming User Profiles from the network

location to the computer where Dragon 11 is installed.

n Upgrade the Dragon 9.x or 10.x Master Roaming User Profiles on the computer

where Dragon 11 is installed.

n Copy the upgraded Dragon 11 Master Roaming User Profiles to a network

accessible directory on the original network location.

In Dragon version 11 or earlier, if the upgrade installation displays an option to

upgrade existing User Profiles to work with this installation, ignore the option, as it

does not affect Roaming User Profiles. Administrators manually run the User Profile

Upgrade Wizard later.

3. On the end-user systems where the users dictate, save and close any open User Profiles on each

Dragon 9.x or 10.x system that uses the Roaming feature.

If there is no time when all of the Roaming User Profiles are not in use (for example, in a hos-

pital where physicians use Dragon during a night shift), administrators can upgrade different

groups of Roaming User Profiles at different times.

4. On the central network location that stores Dragon 9.x or 10.x master Roaming User Profiles,

back up the master Roaming User Profiles to a separate location by using any system backup util-

ity that is implemented at your facility.

5. On the central network location that stores Dragon 9.x or 10.x master Roaming User Profiles,

create a new directory to store the upgraded Dragon 11 Master Roaming User Profiles.

Always be sure the upgraded User Profiles are in a different location from the current User Pro-

files. If end users see two versions of each User Profile, they may become confused when they

try to open a User Profile. Nuance recommends storing User Profiles, from different versions of

Dragon, in different locations.

6. If Dragon 11 is not installed on the computer where the Dragon 9.x or 10.x Master Roaming

User Profiles are located, create a directory on the local computer where Dragon 11 is installed.

The directory stores all the Master Roaming User Profiles you plan to upgrade. Copy the Dragon

9.x or 10.x Master Roaming User Profiles from the network location to this directory.
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7. On the administrator system where you upgrade the Master Roaming profiles to Dragon 11 ,

start Dragon 11 and make sure the Roaming feature is turned off.

To turn off the Roaming feature:
n Close any open User Profiles.

n Click Tools > Administrative Settings on the menu to display the Administrative

Settings dialog box.

n On the Roaming tab, make sure Enable is not selected.

8. Close Dragon.

9. On the computer where both the 9.x or 10.x Master Roaming profiles and Dragon 11 are

installed, select Start > Programs > Dragon NaturallySpeaking 11.0 > Dragon Nat-

urallySpeaking Tools > Upgrade User Profiles. The User Profile Upgrade Wizard opens.

If you do not turn off the Roaming feature in the Administrative Settings dialog box before

attempting to start the User Upgrade Wizard, you see an error message stating that you cannot

upgrade a Roaming User Profile. If you see the message, go back to the Administrative Settings

dialog and make sure the Enabled check box is not checked.

10. On the Select the profile(s) to upgrade page, click Browse to add a profile... to select the

location of the Dragon 9.x or 10.x Master Roaming User Profiles. The Select the profile(s) to

upgrade page now displays a list of User Profiles in the selected directory:

Continue to add User Profiles from other local locations or use the Remove from list button to

remove specific User Profiles. Click Next to continue.
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11. If you choose to upgrade only one User Profile, the wizard displays the number of minutes the

upgrade requires to complete the upgrade.

12. If you upgrade a UK User Profile, the wizard displays a page that lets you select a region for the

profile.

13. On the Choose where to store the upgraded profile(s) page, in the Location for upgraded

profile(s) text box, choose the local location you previously created to contain the upgraded

Dragon 11 master Roaming User Profiles. If a location is not visible, click the Browse button,

149



Dragon Administrator Guide version 11

find the correct location, and click Next.

14. The Begin profile upgrading page displays the number of User Profiles that the wizard is pre-

pared to upgrade.

Click Begin upgrading to start the upgrade process. The upgrade process can take 2-3 min-

utes or more per User Profile, depending on the speed of the computer system and the speed of

the network. Click Stop at any time to interrupt this process. The upgrade process creates new

master Roaming User Profiles in the destination you selected.

15. Click Finish to complete the upgrading process and exit the User Profile Upgrade Wizard.

The User Profile Upgrade Wizard renames Dragon 11 master Roaming User Profile as fol-

lows: <name> (v11). For example, Dragon copies and renames a 10.x Master Roaming User
Profile named roaminguser1to roaminguser1 (v11) when the profile upgrades to version 11. Dragon

does not change the 10.x Master Roaming User Profile named roaminguser1.

16. (Optional) If you cannot install Dragon 11 where the original Master Roaming User Profiles are

located and those User Profiles were copied to another computer where Dragon 11 was

installed, copy the upgraded 11 Master Roaming User Profiles back to the new network-acces-

sible directory that you created to store them.

17. Since the User Profile Upgrade Wizard leaves the Dragon 9.x or 10.x master Roaming User

Profiles unchanged and in their original network location, the Dragon 9.x and 10.x systems can

continue to use the Roaming feature until you upgrade the systems to Dragon 11. Follow the

steps in "Major and Minor Upgrades: Silent Upgrade" and be sure to enable the Roaming feature.

In the Network Directories settings, set the correct path to the upgraded Roaming User Pro-

files.

18. Run Dragon on the end-user system and open a User Profile.
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If upgrading from Dragon version 8.x or earlier to Dragon 11 , Dragon 8.x or earlier custom words

and commands can be re-used in Dragon 11 :

1. In Dragon 8.x or earlier, export the custom words and commands

2. In Dragon 11 , create a new User Profile

3. In Dragon 11 , import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and commands.
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Major and Minor Upgrades: Silent
Upgrade

To upgrade from Dragon Version 10.x to Dragon Version 11 (major upgrade), you can use either

msiexec.exe or setup.exe. You can carry out this installation with a GUI or silently. The procedure

presented here shows how to upgrade silently using msiexec.exe.

Note: A Minor upgrade involves upgrading to a higher point release within the same edition and

version of Dragon. For example, upgrading from Dragon 11.0 to Dragon 11.x.

Overview of Silent Upgrade
If your environment requires that you perform a silent installation and use msiexec.exe, rather

than setup.exe, take these high-level actions in this order:

n Uninstall the older version of Dragon.

n Version 10 only: Uninstall the older version of Visual C++ Runtime for Dragon.

n Install the new version of Visual C++ Runtime for Dragon. Note that there are two versions of

vcruntime.exe, one for 32-bit Windows and another for 64-bit Windows. Use the appropriate

version for your enterprise.

n For major upgrades only: Perform an initial installation of the new version of Dragon on a single

computer and establish the configuration you want to use by calling natspeak.exe on the

command line and passing it these options:
n /setdefaultoptions

n /setdefaultformattingoptions

n /setdefaultadministrativeoptions

When you run the Dragon command line installation silently, the msiexec.exe installer auto-

matically retains User Profiles from the previous version. Later individual users can upgrade their

local (but not Roaming User) profiles when they start Dragon. (For updating Roaming User Pro-

files, see Before You Upgrade.)

GUIDs for uninstalling
The table below lists GUIDs that you pass to the /x option of msiexec for each version of Dragon

and Visual C++ Runtime for Dragon. Make sure to use the /x option with the GUID.

Products and versions GUID

DNS V11 {EFFA53BC-8C04-2E21-3D90-A13B1697B0CA}

DNS V10 and 10.x {E7712E53-7A7F-46EB-AA13-70D5987D30F2}

DNS V9 and 9.x {DDDD90B2-80F2-413A-8A8E-38C5076A7DBA}

VC-Runtime 32-bit {4A5A427F-BA39-4BF0-9A47-9999FBE60C9F}

VC-Runtime 64-bit {4A5A427F-BA39-4BF0-9A47-7777FBE60C9F}
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Step-by-Step Upgrade Process
You must follow these steps to set options for your users:

1. If you are upgrading from a previous version of Dragon, copy the nsdefaults.ini and roam-

ingdef.ini files to a central location so they can accessed later.

2. Open a command line window (Start > Run and enter cmd).

3. Uninstall Dragon Version 10.x with msiexec.exe by passing the installer the /x option followed

by the old version’s GUID and the /qn option to turn off any GUI.

The correct GUID for each Version you can upgrade to Dragon 11 on the command line is

shown in the adjacent table and the example below uses the Dragon 9.x GUID:

msiexec /x {DDDD90B2-80F2-413A-8A8E-38C5076A7DBA}

/L*v "C:\updatelog.log" /qn

msiexec automatically retains User Profiles when you use the silent option.

Caution: The first time you try any upgrade, you should not run it in Silent mode, because if

you have neglected to provide required information, you then receive a GUI prompt for that

information.

4. For upgrading from Dragon 9.x, skip this step. If you are upgrading from Dragon 11 or 11.x

(minor upgrade), uninstall the old version of Visual C++ Runtime for Dragon with msiexec.exe

by passing the installer the /x option followed by the old version’s GUID and the /qn option to

turn off any GUI. The example below shows uninstalling the 32-bit Visual C++ Runtime for

Dragon:

msiexec /x {4A5A427F-BA39-4BF0-9A47-9999FBE60C9F}

/L*v "C:\updatelog.log" /qn

To uninstall the 64-bit version, use the alternative GUID shown in the adjacent table.

5. Be sure you have the Dragon serial number (or the group serial number, if you are upgrading

Dragon on multiple networked computers).

6. Be sure all mapped drives you plan to use are mapped on individual client computers where you

are distributing the upgrade.

7. Install any pending Windows updates on clients and reboot as needed before continuing.

8. Insert the product DVD in the drive and search the DVD for the path where the Dragon

setup.exe is located.

9. Install the new version of Visual C++ Runtime for Dragon by entering the full path to vcrun-

time.exe on a 32-bit system or vcruntime_x64.exe on a 64-bit system:

ISSetupPrerequisites\VCRuntime\vcruntime.exe /S /v"qn /l*v %TEMP%\vc-

runtime.log"

OR

ISSetupPrerequisites\VCRuntime\vcruntime_x64.exe /S /v"qn /l*v
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%TEMP%\vcruntime.log"

If you are installing Version 10 rather than Version 10.x or 11, you have only the 32-bit version

and use a slightly different path:

ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-ADE12FB7DEC5}\vcruntime.exe
/S
/v"qn /l*v %TEMP%\vcruntime.log"

10. If you are performing a minor upgrade, skip this step. If you are performing a major upgrade

from Dragon 9.x, perform an initial installation on a single computer where you configure the

settings of user profile options, Auto-Formatting options, and administrative settings. You can

follow the instructions in Install the Same Configuration on Additional computers under Instal-

lation using the Dragon command line.

11. Be sure you can access the .ini files from the old installation (minor upgrades) or the .ini files

you just created in the initial installation (major upgrades) from all computers you will be upgrad-

ing. (Or copy the files to a local path on the client computer where you are about to upgrade.)

12. For a major upgrade, install the new version of Dragon with msiexec.exe by passing the installer

the /i option followed by the name of the Dragon .msi file and options like those shown in the

sample below:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-## REBOOT=ReallySuppress
INSTALLDIR="C:\<full_path>\Dragon11"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"

REMOVEOLDPROD=1 /L*v "C:\logfile.log" /qn

To ensure that the entire old version of the product is removed, you pass REMOVE-

OLDPROD=1 (major upgrades only, not minor upgrades) so that the process removes the old

version of Dragon before installing the new. In addition, you should be sure to provide the full

path to each .ini file you are using.

13. For a minor upgrade, install the new version of Dragon with msiexec.exe the same way as you

would the major upgrade, only passing both REINSTALL or REINSTALLMODE options, as

shown in the sample below. Here REINSTALL is set to ALL and REINSTALLMODE is set to

vemus, where /v indicates to reinstall from the source (reupdating cache), e indicates to install

the newer file if one is available, mu means to rewrite the registry settings, and s means to rein-

stall all shortcuts and recache all icons. For more information on the REINSTALL and REIN-

STALLMODE settings, refer to MSI Options for Installing Dragon Features/Advanced

Options.

Here is a typical minor upgrade installation line:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
REBOOT=ReallySuppress
INSTALLDIR="C:\<full_path>\Dragon11"

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
REINSTALL=ALL REINSTALLMODE=vamus
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/L*v "C:\logfile.log" /qn

Caution: If you do not pass the REINSTALL and REINSTALLMODE options, the minor

upgrade will fail.
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Using setup.exe for Upgrades
When installing both major and minor upgrades, the setup.exe installer automatically installs Vis-

ual C++ Runtime for Dragon before installing Dragon.

Note: A Minor upgrade involves upgrading to a higher point release within the same edition and

version of Dragon. For example, upgrading from Dragon 11.0 to Dragon 11.x.

Although the upgrade does not migrate forward the configuration and Roaming User Profile set-

tings from the earlier version, you can reuse the nsdefaults.ini and roamingdef.ini files you used to

install Dragon 11 . You can also create new .ini files or update existing ones.

When you run setup.exe with a GUI to install a minor upgrade, setup.exe can detect when a pre-

vious version of Dragon exists on a target computer. Once it detects a previous version, setup.exe

runs the rest of your installation in minor upgrade mode, automatically overwriting older files with

newer files and adding any missing files. .

Using setup.exe for Silent Upgrades
If you are upgrading a previous version of Dragon, you must use the REINSTALL=ALL option

and REINSTALLMODE set to the sub-options that indicate which files to reinstall, usually

REINSTALLMODE=vamus. If you did not originally install in the default location, the

INSTALLDIR option is also required. Here is the command line using setup.exe:

To upgrade silently with setup.exe, you pass the /s option, then pass REINSTALL or REIN-

STALLMODE options:

setup.exe /s /v"/i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
REBOOT=ReallySuppress
INSTALLDIR=\"C:\<full_path>\\Dragon11\"
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"
REINSTALL=ALL REINSTALLMODE=vamus
/L*v C:\logfile.log /qn"
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Step-by-Step Command Line
Installation with msiexec.exe

Another way to install Dragon from the command line on several dictation client computers is to

use the msiexec.exe program from Microsoft. You are required to use msiexec.exe instead of

setup.exe if you are installing Dragon from a server across a network to a single or multiple com-

puters.

In the sections that follow, you carry out these two tasks:

n Install Dragon on Initial computer and Establish Configuration

n Install Same Configuration on Additional computer(s)

Finding the MSI Installer on the Dragon DVD
The compiledMSI file is located on your installation DVD. The files for each edition are named:

n Dragon NaturallySpeaking (all editions) or Dragon Medical: Dragon NaturallySpeaking 11.msi

n SDK Client Edition (DSC): Dragon SDK Client Edition 10.msi

n SDK Server Edition (DSS): Dragon SDK Server Edition 10.msi

You can double click on one of these .msi files to start the InstallShield Wizard; however, to

instead take advantage of available command line options, you can pass the file name as the appli-

cation to install to the msiexec.exe command using the /i option:

msiexec.exe /i "Dragon NaturallySpeaking11.msi"

Install Dragon on Initial computer and Establish
Configuration
Follow the steps outlined under Installation using the Dragon command line.

Then return here and continue with the next section to install the same configuration on individ-

ual client computers using msiexec.exe instead of setup.exe.

Install Same Configuration on Additional
computer(s)
If you chose Enable Desktop Search Commands on the Commands tab during the initial instal-

lation, you must install Google Desktop or Microsoft Vista Search before you install Dragon;

otherwise, that option does not take effect.

1. Be sure you can access the .ini files you created in the previous procedure from the computer

you will be installing on or copy the files to a local path on the client computer where you are

about to install Dragon.

2. Be sure you have the Dragon serial number (or the group serial number, if you are installing

Dragon to multiple computers on a network).
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3. Be sure all mapped drives you plan to use are mapped on individual client computers where you

are distributing the installation.

4. Install any pending Windows updates/reboot the computer.

5. Open a command line window by selecting Start > Run and entering cmd.

6. Insert the product DVD in the DVD drive and search the DVD for the path where the Dragon

setup.exe file is located.

7. In the command window, switch to the ISSetupPrerequisites\VCRuntime\ directory inside the

directory of the executable for Dragon. (If you are installing Version 10, rather than Version

10.x or 11, the path to switch to is ISSetupPrerequisites\{1FAD9007-0FF1-4B05-B7CE-

ADE12FB7DEC5} .)

8. On the command line, run the installation of Visual C++ Runtime (requires 4.08 MB of disk

space to install):

vcruntime.exe

The Choose Setup Language dialog box appears asking you to select a language for the instal-

lation. After you select the language, an initialization GUI briefly displays, then the InstallShield

wizard pops up. To disable the dialog box that requests the language, pass the /S option (see

more options below). To install vcruntime.exe without seeing either the Choose Language

Setup dialog or the InstallShield wizard, you should execute the command line shown here for

32-bit Windows:

vcruntime.exe /S /v"/qn /l*v %TEMP%\vcruntime.log"

Or the command line shown here for 64-bit Windows:

vcruntime_x64.exe /S /v"/qn /l*v %TEMP%\vcruntime.log"

Caution: The first time you try any installation, you should not run it in Silent mode, because if

you have neglected to provide required information, you then receive a GUI prompt for that

information.

9. On your product DVD, locate the compiled .msi file for the edition of Dragon you want to

install and switch to that directory.

10. Retrieve the customized nsdefaults.ini and roamingdef.ini files from the computer where carried

out the initial installation.

11. To install Dragon, enter the following command line, using the /i option also using the /qn

option to install the product in Quiet mode, where no GUI appears. You also pass the Dragon

serial number for the SERIALNUMBER option, the full path to the nsdefaults.ini file for the

DEFAULTSINI option, and the full path to the roamindef.ini file for the ROAMINGUSERINI

option:

msiexec /i "Dragon NaturallySpeaking 11.msi"

SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v "C:\Logs\logfile.log" /qn
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Notes:

n For an administrative installation, you pass the /a option to msiexec rather than the /i option.

You also need to pass the TARGETDIR option instead of the INSTALLDIR option.

n The first time you test this installation, you should pass /q rather than /qn so that if you have

neglected to provide information about a setting that does not have a default, you receive a

prompt asking for that information.

The bolded portion of the preceding command line is included so that if something goes wrong

during the installation, you receive messages about it. You pass /L and a series of sub-options to

have the installation process log errors and other types of messages related to the process. (You

can then send the log file to Nuance Technical Support should any issues arise.)

Here are other optional actions you can take on the command line that link you to further instruc-

tions, below:
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Additional Options for Installations
with msiexec.exe

Note: In Dragon 11 , the installation process does not present the QuickStart option. If you wish

to enable this option, you can do so after Dragon is installed.

Additional Options for Silent Installations

n Modifying the Default Installation Directory

n Configuring Installation of Product Updates

n Suppressing Reboot of computer After Installation

n Installing Same Roaming User Profile Configuration on Additional computer(s)

Additional Options with Extensive Settings for Silent Installations

n Installing Some Vocabularies Locally/Others Only On Demand

n Installing Text-to-Speech Feature

n Reinstalling Dragon with Particular Set of Features

n Setting Day/Time of Scheduled Tasks

Additionally, you can launch the Online Registration Form After Installation
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Additional Options for Silent
Installations

Note: In Dragon 11 , the installation process does not present the QuickStart option. If you wish

to enable this option, you can do so after Dragon is installed.

Additional Options for Silent Installations

n Modifying the Default Installation Directory

n Configuring Installation of Product Updates

n Suppressing Reboot of computer After Installation

n Installing Same Roaming User Profile Configuration on Additional computer(s)

Additional Options with Extensive Settings for Silent Installations

n Installing Some Vocabularies Locally/Others Only On Demand

n Installing Text-to-Speech Feature

n Reinstalling Dragon with Particular Set of Features

n Setting Day/Time of Scheduled Tasks

Additionally, you can launch the Online Registration Form After Installation

Modifying Default Installation Directory
If you want to set an installation directory other than the default, pass INSTALLDIR="<path to

install>" to msiexec on the command line:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon11"
/L*v "C:\Logs\logfile.log" /qn

Note: For an administrative installation, you should pass the TARGETDIR option instead of the

INSTALLDIR option.

Configuring Installation of Product Updates
If you want the individual client computer to download product updates to Dragon over the web,

you would set the PRODUCTUPDATEFLAG option to 1 (option checks the check box). If you

prefer to let the server download the updates and later distribute them to client computer, set this

option to 0 (unchecks the check box). To not even display the check box, set the option to -1.

For enterprise sites, choose -1 to prevent product updates from being downloaded.

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
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INSTALLDIR="C:\<full_path>\Dragon11"
PRODUCTUPDATEFLAG=-1 /L*v "C:\Logs\logfile.log" /qn

Suppressing Reboot of computer After Installation
To suppress rebooting of the computer after installation of Dragon completes, you can pass Micro-

soft's REBOOT option set to ReallySuppress. Using this option also suppresses the reboot some-

times required by the installation of Visual C++ Runtime for Dragon, which setup.exe installs in

the background. Using this option is highly recommended if you are executing a silent installation

(But if system updates are pending, rebooting is required for DNS to work normally.

REBOOT=ReallySuppress

The altered command line would look like this:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon11\" /qn
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress

/L*v C:\Logs\logfile.log /qn"

Suppressing Reboot of computer After Installation
To prevent the computer where you are installing Dragon from rebooting automatically after the

installation ends, you can pass Microsoft’s REBOOT option set to ReallySuppress:

REBOOT=ReallySuppress

The altered command line would look like this:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon11"
PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
/L*v "C:\Logs\logfile.log" /qn

Installing the Same Roaming User Profile
Configuration on Additional computer(s)
Use the roamingdef.ini file you created during the initial installation as the input for the ROAM-

INGUSERINI option in this format (be sure to use the full path to the file when you pass the

option):

ROAMINGUSERINI="Y:\<full_path>\roamingdef.ini"

In the above example, Y: is mapped network drive, accessible from client computers.
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Optionally include the ROAMINGUSERINI option in the installation command line. If you do

not use this property, default settings are assumed.

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon11"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v "C:\nuanceLogs\logfile.log" /qn

After you have completed the installation, verify that all options are correctly set on the client

computer.

Launching Online Registration Form After
Installation
To have the online registration form for Dragon pop up on the workstation in its browser imme-

diately after the installation completes, you can pass a option to the WEBREGISTRATION

option and set it to 1 (applies only if you do not use the /qn option). The default is 0 which

means registration will not be launched.

WEBREGISTRATION=1

The revised command line would look like this:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon11" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
WEBREGISTRATION=1 /L*v "C:\Logs\logfile.log"

Installing Some Vocabularies Locally and Others On
Demand
When you install Dragon or Dragon Medical on a client computer, by default you install all the

available vocabularies locally.

If you do not want all of those vocabularies to be installed locally, but to instead have them

installed only if/when a user attempts to create a particular vocabulary, you can indicate that fact

on the installation command line by adding the ADDLOCAL option and setting it to the names of

the vocabularies to install locally. For instance, to install only an English Legal vocabulary, you

would set ADDLOCAL to NatSpeak,ENUMedical and the command line would appear as follows

(NatSpeak must be in the setting of ADDLOCAL, unless you set ADDLOCAL to ALL, or the

installation will fail):

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
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DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon11" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress ADDLOCAL=NatSpeak,ENUMedical
/L*v "C:\Logs\logfile.log" /qn

Separate the features/vocabularies for ADDLOCAL with commas, but do not put spaces in the

list. The names you must use for the vocabularies consist of a prefix for the language, then the

name of the vocabulary, such as ENU for English and Cardiology to form ENUCardiology. For a

list of the exact names for features/vocabularies you can assign to ADDLOCAL or ADVERTISE

on the command line, refer to Summary: MSI Options for Installing Dragon Features/Advanced

Options.

Particularly in a Dragon Medical installation, you might find it useful to have most vocabularies

available but not locally installed. You can take that action by setting ADDLOCAL to ALL and

then setting the ADVERTISE property to a list of vocabularies to not be installed locally, so that

you end up with a subset of the medical vocabularies locally installed and all others available only

on demand. The command line might look like the following:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon11" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress ADDLOCAL=ALL
ADVERTISE=ENUCardiology,ENUEmergency,ENUGastroenterology
/L*v "C:\Logs\logfile.log" /qn

Installing Text-to-Speech Feature
To install Text-to-Speech locally, you would include the feature in the list of features for ADD-

LOCAL; for instance, you would add TTSENX for Text-to-Speech in English:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon11" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
ADDLOCAL=TTSENX,NatSpeak,ENUMedical
/L*v "C:\Logs\logfile.log" /qn

Reinstalling Dragon with Particular Set of Features
Sometimes you want to reinstall Dragon and add or remove particular features of the product. You

can also take this action on the command line using the REINSTALL and REINSTALLMODE

options of the MSI installer. You set REINSTALL to those features you want to install or to

ALL.

For example, to install a minor upgrade to Dragon, you might use this command line:
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msiexec /i "Dragon NaturallySpeaking11.msi" REINSTALL=ALL REIN-
STALLMODE=vamus /qn

The vemus options: v indicates to reinstall from the source (reupdating cache), e indicates to

install the newer file if one is available, mu means to rewrite the registry settings, and s means to

reinstall all shortcuts and re-cache all icons. For more information on the REINSTALL and REIN-

STALLMODE settings, refer to Summary: MSI Options for Installing Dragon Fea-

tures/Advanced Options.

Note: A Minor upgrade involves upgrading to a higher point release within the same edition and

version of Dragon. For example, upgrading from Dragon 11.0 to Dragon 11.x.

Setting Day/Time for Scheduled Tasks
To retain the default schedule for data collection and modify schedules for acoustic model opti-

mization to Mondays at 1 AM and language model optimization to Mondays at 6 AM, you would

set the PERIODIC_TASK string as follows:

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"

An MSI installation command line including the option setting this schedule would look like this:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
INSTALLDIR="C:\<full_path>\Dragon11"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:<full_path>\roamingdef.ini"
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
/L*v "C:\Logs\logfile.log" /qn

For more information on the PERIODIC_TASK option, refer to MSI Options for Roaming User

Profile, Tuning, and Data Collection Setup.

Launching Online Registration Form After
Installation
To have the online registration form for Dragon pop up on the workstation in its browser imme-

diately after the installation completes, you can pass a option to the WEBREGISTRATION

option and set it to 1 (applies only if you do not use the /qn option). The default is 0 which

means registration will not be launched.

WEBREGISTRATION=1

The revised command line would look like this:

msiexec /i "Dragon NaturallySpeaking 11.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon11" PRODUCTUPDATEFLAG=-1
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REBOOT=ReallySuppress
WEBREGISTRATION=1 /L*v "C:\Logs\logfile.log"
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MSI Options Specific to Dragon
This section describes the fundamental msiexec.exe options that apply to Dragon Nat-

urallySpeaking and Dragon Medical. Additional options that apply only to a Dragon installation are

listed in:

n MSI Windows Installer Options

n MSI Options for Installing Dragon Features/Advanced Options

n MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

Caution: Before you install Dragon using an MSI installation, you must install Visual C++ Run-

time for Dragon on each dictation computer using the vcruntime.exe available on the product

DVD. You cannot install Visual C++ Runtime as part of a typical msiexec.exe installation. For

details, refer to Installing Visual C++ Runtime for Dragon.

If you install Dragon using its setup.exe file, InstallShield installs vcruntime.exe for you.

Dragon command line options do not need to be prefaced by hyphens or slashes.

Notes:

n In Dragon 11 , the installation process does not present the QuickStart option. If you wish to

enable this option, you can do so after Dragon is installed.

n Launching msiexec.exe /i "Dragon NaturallySpeaking 11.msi" XYZ=ABC automatically sets the

property named XYZ to the value of ABC internally and continues the installation. However, if

you use setup.exe to install, you must put all msiexec.exe options you pass it in quotation marks

after the /v option.

Unless noted otherwise, all property values are in UPPERCASE.

Options Description

DEFAULTSINI="c:<path>\

nsdefaults.ini"

Indicates a default settings (nsdefaults.ini ) file

that the installer uses to change the default

behavior of the product for all users at instal-

lation time. This file must be in an .ini file

format; any settings you want to take effect

on clients must have a section name encased

in square brackets as well as the value and

data. If only values and data are set in this file

without the section name encased in brack-

ets, the settings are not propagated on client

computers. Usually, you do not edit the

nsdefaults.ini file directly; instead you set

defaults in Dragon’s Options and Admin-

istrative Settings dialog boxes.

Follow these steps to create a nsdefaults.ini

file for an MSI installation:
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Options Description

Install Dragon on a computer with Windows

administrator privileges.

Set options in the Options and Admin-

istrative Settings dialog boxes as required in

your environment and save them by closing

Dragon.

Copy the nsdefaults.ini file created by this

installation of Dragon to a separate location.

By default, the nsdefaults.ini is located in:
C:\Documents and Settings\All
Users\Application Data\N-
uance\NaturallySpeaking11\

Use the copied nsdefaults.ini as the input

for the DEFAULTSINI option.

SERIALNUMBER=abcde-fgh-

ijkl-mnop-qr

A serial (license) number is required for all

installations. You must specify a valid serial

number on the command line.

Note: Specifying a serial number on the com-

mand line does not bypass the serial number

checking within setup.

PRODUCTUPDATEFLAG=0

(or 1 or –1)

Sets the default state of the product update

check box at the end of installation, to indi-

cate whether the installation should auto-

matically check the web for product updates.

Automatic product updates are not sup-

ported for enterprise installations.

A value of 0 (zero) turns the check box off

by default, 1 (one) turns it on by default.

To disable the option entirely (turn the

option off and suppress the display of the

check box altogether), set the value to –1.

The default setting is 1 (enables the check

box and checks for product updates by

default).
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Options Description

QUICKSTART=0 (or
1)

Set the default state of Enable QuickStart

Mode check box to enable QuickStart and

to create shortcut for Dragon in the Windows

Startup folder.

A value of 0/1 will turn check box off/on,

respectively.

SETDEFAULTS=0 (or 1) If set to 1, sets the default state ofModify

the application’s settings for all users

check box to display the Options dialog box

at the end of the installation. The Options

dialog box lets you change Dragon’s standard

behavior, including specifying hot keys, cus-

tomizing how text is formatted, changing ini-

tial microphone settings, and setting the how

often your User Profiles are backed up.

Applies only if your installation displays the

Installation Wizard.

A value of 0/1 will turn check box off/on

accordingly.

With SETDEFAULTS=1, no dialogs display

during installation if /qn is used for Quiet

mode installation.

SETADMINS=0 (or 1) If set to 1, sets the default state ofModify

the administrative settings check box to

display the Administrative settings dialog

box at the end of the installation. The

Administrative settings dialog box lets you

set up the Roaming feature, set the backup

location of your User Profiles, and restrict

users from modifying commands and vocab-

ularies. Applies only if your installation dis-

plays the Installation Wizard.

A value of 0/1 will turn checkbooks off/on

accordingly.

With SETADMINS=1, no dialogs display

during installation if /qn is used for Quiet

mode installation.

SETFORMATTINGS=0 (or

1)

If set to 1, sets the default state ofModify

the administrative settings check box to

display the Auto-Formatting dialog box at
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Options Description

the end of the installation. The Auto-For-

matting dialog box lets you set up visual for-

mats for the output of the recognized text,

including standard abbreviations and other

preferences. Applies only if your installation

displays the Installation Wizard.

A value of 0/1 will turn check box off/on

accordingly.

With SETFORMATTINGS=1, no dialogs

display during installation if /qn is used for

Quiet mode installation.

WEBREGISTRATION=1 (or

0)

Determines whether or not to launch the on-

line product registration form after the instal-

lation completes. 0 disables the product reg-

istration. The default of 1 enables display of

the form.
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MSI Options for Installing Dragon
Features/Advanced Options

This section describes additional msiexec.exe options that apply to Dragon NaturallySpeaking and

Dragon Medical. Although these options are for msiexec.exe, they are also available for setup.exe

if you use them with the /v“ option.

Other options are listed under:

n Summary: MSI Windows Installer Options

n Summary: MSI Options Specific to Dragon.

n Summary: MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

Note: A Minor upgrade involves upgrading to a higher point release within the same edition and

version of Dragon. For example, upgrading from Dragon 11.0 to Dragon 11.x.

The following table presents options that apply to a Dragon installation where you select particular

features to install. Unless noted otherwise, all property values are in UPPERCASE.

Options Description

ADDLOCAL=Feature1,Feature2,... or ADD-

LOCAL=ALL

Set the ADDLOCAL property to a list of

features to be installed locally, delimited by

commas. To install all features locally

(including User Profiles), use ADD-

LOCAL=ALL on the command line.

ADVERTISE=Feature1,Feature2,FEATURE3,... Set the ADVERTISE property to a list of

features to be available but not locally

installed, delimited by commas. To install

all features as advertised, use ADVER-

TISE=ALL on the command line. The

ADVERTISE option overrides the ADD-

LOCAL option. The best method for

installing a particular set of features is to

set the ADDLOCAL property to ALL and

then set the ADVERTISE property to

those features you do not want installed

locally. A list of the features that you can

set for installation is listed in the section

after this table.

REINSTALL=Feature1,Feature2,... (or ALL) List of features that are to be reinstalled,

delimited by commas. To reinstall all fea-

tures use REINSTALL=ALL on the com-

mand line.

171



Dragon Administrator Guide version 11

Options Description

If you set the REINSTALL property, you

should also set the REINSTALLMODE

property, to indicate the type of reinstall to

be performed. If the REINSTALLMODE

property is not set, then by default all files

that are currently installed are reinstalled

only if the currently installed file is an ear-

lier version (or is not present). By default,

no registry entries are rewritten.

Note that even if REINSTALL is set to

ALL, only those features that were already

installed previously are reinstalled. Thus, if

REINSTALL is set for a product that is yet

to be installed, no installation action takes

place at all.

For more information, see:
http://msdn.microsoft.com/library/
default.asp?url=/library/en-
us/msi/setup/reinstall.asp

REINSTALLMODE={type of rein-
stallation to perform}

String that contains letters indicating the

type of reinstall to perform. Options are

case-insensitive and order-independent.

This property should normally always be

used in conjunction with the REINSTALL

property. However, this property can also

be used during installation, not just during

a reinstall.

See REINSTALLMODE for more details.

REMOVEOLDPROD=1 Removes the old version of the product

before installing the new version. Should

be used in major upgrades only.

/x<Product.msi|ProductCode> Un-installs the currently installed version

of Dragon. You are required to take this

action during upgrading; however, you

should be familiar with the entire upgrade

procedure before proceeding with this

option.

REINSTALLMODE

By default the REINSTALLMODE=omus to reinstall all files whose checksums are missing or

corrupt, rewrite all registry names, reinstall all shortcuts and re-cache icons. Below is a list of the

options with abbreviated definitions:

p — Reinstall only if the file is missing.
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o — Reinstall if the file is missing or is an older version.

e — Reinstall if the file is missing or is an equal or older version.

d — Reinstall if the file is missing or a different version is present.

c — Reinstall only files whose checksums are missing or corrupt.

a — Force all files to be reinstalled, regardless of checksum or version.

u — Rewrite all required registry entries from the Registry Table that go under HKEY_CUR-

RENT_USER or HKEY_USERS .

m— Rewrite all required registry entries from the Registry Table that go under HKEY_LOCAL_

MACHINE or HKEY_CLASSES_ROOT. Regardless of computer or user assignment, rewrite all

info from these tables: Class, Verb, PublishComponent, ProgID, MIME, Icon, Extension, and

AppID . Reinstall all qualified components. When reinstalling an application, run the Reg-

isterTypeLibraries and InstallODBC actions.

s — Reinstall all shortcuts and re-cache all icons, overwriting existing shortcuts and icons.

v — Run from the source package, re-cache the local package. Does not apply to new installation

of a product or feature.

If you set REINSTALLMODE without also setting REINSTALL, then the detection modes

you specify still apply and the overwrite mode is used. The REINSTALLMODE property

affects only those features selected for installation using REINSTALL.

For example, to launch a minor upgrade without using setup.exe, you must set the following

properties on the command line:

REINSTALL=ALL REINSTALLMODE=vamus

To install a minor upgrade using an .msi file, use this command line:

msiexec /i "Dragon NaturallySpeaking11.msi" REINSTALL=ALL REINSTALLMODE=vamus

For more information on REINSTALLMODE and the reinstall option codes, see:
http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/msi/setup/reinstallmode.asp
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MSI Options for Roaming User Profile,
Tuning, and Data Collection Setup

This section summarizes the Roaming User Profile, acoustic/language model tuning, and data col-

lection options for command line installations of Dragon NaturallySpeaking and Dragon Medical.

Other options are listed under:

n Summary: MSI Windows Installer Options

n Summary: MSI Options Specific to Dragon

n Summary: MSI Options for Installing Dragon Features/Advanced Options

Options Description

PERIODIC_TASK=<string> Sets schedule for either one, two, or three tasks— an acoustic
model optimization (ACO) task, language model optimization (LMO)
task, and/or data collection (DC) task. You can schedule each task
to run daily or weekly, but need to set the schedule for each task
only once.

See PERIODIC_TASK for more details.

ROAMINGUSERINI="c:\xyz.ini" Specifies a roaming user .ini file (roamingdef.ini) that contains the
Master Roaming User Profile location and any associated HTTP or
HTTPS settings for a Roaming User Profile. These are the same options
set in theNetwork Directories field of the Roaming tab of the
Administrative settings dialog box and theHTTP and HTTPS Set-
tings dialog boxes.

See ROAMINGUSERINI for more details.

PERIODIC_TASK

The <string> of PERIODIC_TASK contains these arguments, separated by semicolons:

aco | lmo | dc—One, two, or all three of them with a vertical bar separating each. If
you do not pass the acronym for the feature, that feature is set to its default.

Administrator login name. Be sure you use the fully qualified <domain name>\<account
name> in a case where the user is a local administrator but the computer is on a domain.

Administrator password.

When to run the task(s), with times for each of multiple tasks separated by a vertical bar
(|). Each scheduled time should be in the format DayOfWeek, hh:mm, where the day of the
week is the three letter abbreviation (no period), the time is the 24-hour time, and the
comma between them is required.

The task runs once a week on the day/at the time you indicate. If you omit the DayOfWeek,
the task runs every day at the time given.

The first of multiple times becomes the schedule for the first task named in the first param-
eter, the second time the schedule for the second task, the third the schedule for the third
task. If you omit a time by having two vertical bars with no time between them or by leav-
ing out the first or last time, the corresponding task is scheduled for a default time.
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Default Schedules

Acoustic model optimization (ACO) — Mon, 02:00

Language model optimization (LMO) — Every day, 03:00

Data collection (DC) — Fri, 01:00

Examples of PERIODIC_TASK Settings

A string setting this option to perform an acoustic model optimization every Monday at 1
AM and a language model optimization the same day at 4 AM is (notice the comma
between the day of the week and the time):

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 04:00"

To schedule only data collection and language model optimization tasks and have them occur

every day at 4 PM and 11 PM, respectively, you would enter only the time for each task, without

indicating a particular day:

PERIODIC_TASK="dc|lmo;myadmin;mypswd;04:00|23:00"

A string setting this option to perform an acoustic model optimization every Tuesday at midnight,

data collection every Wednesday at 3 AM, and a language model optimization every Friday night at

10 PM is:

PERIODIC_TASK="aco|dc|lmo;myadmin;mypswd;Tue, 00:|Wed, 03:00|Fri,
22:00"

To have the data collection and language model optimization tasks occur at default times, you

modify the previous string by removing the times for those tasks, but leaving space between the

vertical bars and after the last vertical bar:

PERIODIC_TASK="aco|dc|lmo;myadmin;mypswd;Tue, 00:| | "

ROAMINGUSERINI

When you enable the Roaming feature, Dragon creates an encrypted roamingdef.ini file.

Use the following steps to create a roamingdef.ini file to be used for an MSI installation where

the Roaming feature is enabled:

Install Dragon on a computer with Windows administrator privileges.

Enable the Roaming feature options required in your environment. These must include the Master

Roaming User Profile location set in the Network Directories field in the Roaming tab of the

Administrative Settings dialog box and any HTTP or HTTPS settings.

Test these settings to make sure the Roaming User Profile connection works.

Save your settings by closing Dragon.

Copy the encrypted roamingdef.ini or roaming.ini file (use the one that is newer) created by this

installation of Dragon to a separate location. By default, the .ini is located in:
C:\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\

175



Dragon Administrator Guide version 11

Set the ROAMINGUSERINI option to the name of the roamingdef.ini file. The default is empty

(no .ini file will be used).

To set these options using ROAMINGUSERINI, the Roaming feature must be enabled in the

nsdefaults.ini file.
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Feature Variables to Set Through the
ADDLOCAL or ADVERTISE Properties

When specifying features on the command line:

n If a feature does not exist in a particular edition or language, overriding its default property has

no effect.

n Some features (such as Text-to-Speech) have sub-features. Setting these features on the

command line automatically turns on the properties of all sub-features, unless you specify an

additional override for those sub-features.

n Any information in parentheses after the sub-feature is not included in the feature name.

You can specify any of the following features using ADDLOCAL and ADVERTISE properties on

the command line:

Feature Sub-feature

NatSpeak None Dragon NaturallySpeaking

and Medical: Sub-features for

ENU (US English):

Samples

(Sample Commands
file)

None

TTS (Text-to-
Speech)

TTSDEU (German

Text-to-Speech)

TTSENU (US English

Text-to-Speech)

TTSENG (British Eng-

lish Text-to-Speech)

TTSESP (Spanish Text-to-

Speech)

TTSFRA (French Text-to-

Speech)

TTSITA (Italian Text-to-Speech)

TTSNLD (Dutch Text-to-

Speech)

Tutorial TutDEU (German Tuto-

rial)

TutENX (English Tuto-

rial)

TutESP (Spanish Tuto-

rial)

TutFRA (French Tutorial)

TutITA (Italian Tutorial)

TutNLD (Dutch Tutorial)

Speech—DEU
(German)

Sub-features for DEU

(German)

DEUGeneral (German

General Large, Swiss Ger-

man General, Empty Dic-

tation General)

DEULegal (German

Legal)

DEUMedical (German Medical

Large)

DEURadiology (German Med-

ical Radiology Large)
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Feature Sub-feature

Tutorial TutDEU (German Tuto-

rial)

TutENX (English Tuto-

rial)

TutESP (Spanish Tuto-

rial)

TutFRA (French Tutorial)

TutITA (Italian Tutorial)

TutNLD (Dutch Tutorial)

Speech ENX (Eng-

lish)—

ENU (US English)

Dragon Nat-

urallySpeaking and

Medical: Sub-features

for ENU (US English)

ENULegal (US English

Legal Large)

ENUGeneral (US Eng-

lish General Medium,

US English Empty Dic-

tation,

US English Commands

Only)

ENUGenSvc

(US English Large Gen-

eral)

The ENU sub-feature
includes support for
the following accents:

n General — Use if your

accent is not covered by

the other choices or you are

not sure which accent to

select.

n Australian accented English

n British accented English

n Indian accented English

n Inland Northern US (Great

Lakes area)

— Covers Upstate New

York through the Chicago

area.

n SEAsian accented English

— South East Asian

n Southern US — Covers

most of the Southern

United States, including

Texas.

n Spanish Accented English.

Speech ENX
(English)—
ENU (US English)
(continued)

Note:EN-
URadiology and
ENUPathology
are not available
in the Dragon
Medical Small
Practice Edition.

Dragon Medical: Sub-

features for ENU (US

English):

ENUCardiology

(US English Medical

Large Cardiology,

Pediatric Cardiology)

ENUEmergency (US

English Emergency

Medicine Large)

ENUObGyn (US English

Medical Large ENT, Fetal

Medicine, Midwifery, Obstet-

rics and Gynecology, Oph-

thalmology)

ENUOncology (US English

Medical Large Oncology, Radi-

ation Therapy)
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Feature Sub-feature

ENUGeneralPractice

(US English Large

Family Medicine, Allergy

and Immunology,

Dermatology,

Epidemiology, Geriatric,

Hematology, Infectious

Disease, Internal

Medicine, Medical

Education and Writing,

Nephrology, Nursing,

Osteopathy, Pulmonary

Disease, Rheumatology,

Sleep Lab)

ENUMedical

(US English General

Medical Large—No Spe-

cialty)

ENUMentalHealth

(US English Large

Medical Addiction

Psychiatry; Endocrinology,

Diabetes, and

Metabolism; Psychiatry,

Psychology)

ENGNeurology

(US English

Anesthesiology,

Neurology, Pain

Medicine, Physical

Medicine and

Rehabilitation, Vascular

and Interventional

Radiology)

ENUOrthopaedic (US English

Medical Large Dentistry, Large

Hand Surgery, Neurosurgery,

Orthopaedics, Oral and Facial

Surgery, Orthopaedic Surgery,

Plastic Surgery, Podiatry)

ENUPathology (US English

Medical Large Pathology)

ENUPediatrics (US English

Medical Large Pediatrics,

Neonatal and Perinatal Medicine,

Pediatric Dentistry)

ENURadiology (US English

Medical Large Nuclear Medicine

or Radiology)

ENURehabilitation (Neurology,

Physical Medicine, Rehabilitation

and Speech and Language

Pathology)

ENUSurgery (US English

Medical Large Cardiac Surgery,

Colon and Rectal Surgery,

Surgery, Thoracic Surgery,

Urology, Vascular Surgery)

Speech ENX
(English)—
ENG (UK
English)

Dragon Nat-

urallySpeaking and

Medical: Sub-features

for ENG (UK Eng-

lish):

ENGGeneral (UK

English General Large,

Empty Dictation Gen-

eral, Commands Only

The ENG sub-feature

includes support for the fol-

lowing accents:

n General — Use if your

accent is not covered by

the other choices or you are

not sure which accent to

select.
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Feature Sub-feature

n Australian accented

English.

n Indian accented English.

n SEAsian accented English

– South East Asian.

Speech ENX
(English)—
ENG (UK
English)

Dragon Medical:Sub-

features for ENG (UK

English):

ENGCardiology (

UK English Cardiology

Large)

ENGEmergency

(UK English Emergency

Large)

ENGGastroenterology

(

UK English Gas-

troenterology Large)

ENGGeneralPractice

(UK English General

Practice Large)

ENGMedical

(UK English Medical

Large — No Specialty)

ENGMentalHealth

(UK English Mental

Health Large)

ENGNeurology (

UK English Neurology

Large)

ENGObGyn (UK English

ObGyn Large)

ENGOncology (

UK English Oncology Large)

ENGOrthopaedic

(UK English Large Orthopedic)

ENGPathology (

UK English Large Pathology)

ENGPediatrics

(UK English Large Pediatrics)

ENGRadiology

(UK English Large Radiology)

ENGSurgery

(UK English Large Surgery)

Speech—ITA
(Italian)

Sub-features for ITA

(Italian):

ITA (Italian General

Large and Italian Empty

Dictation General Large)

Speech—NLD
(Dutch)

Sub-features for NLD

(Dutch)

NLDGeneral (Dutch

General Large and Dutch

Empty Dictation General

Large)
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Feature Sub-feature

Dragon Medical Only-
Sub-features for NLD
(Dutch):

NLDCardiology
(Dutch Cardiology)
NLDGeneralPractice
(Dutch General Prac-
tice)
NLDMedical (Dutch
Medical Large)
NLDOrthopaedics
(Dutch Orthopaedics
Large)

NLDPathology (Dutch Pathol-

ogy Large)

NLDPediatrics (Dutch Pedi-

atrics)

NLDRadiology (Dutch Radi-

ology Large)

NLDRalph (Dutch Ralph Large)

NLDSurgery (Dutch Surgery

Large)

Speech—FRA
(French)

Sub-features for FRA

(French):

FRAGeneral (French

General Large, French

Empty Dictation General

Large)

FRAMedical (French Medical

Large)

FRARadiology

(French Radiology Large)

Speech—

ESP (Span-

ish)

Sub-features for ESP

(Spanish)

ESP (Latin American

Spanish General Large)

ESP (Latin American

Spanish Empty

Dictation General Large)

ESP (Castilian Spanish

General Large)

Speech—ESP (Spanish)
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Installing Visual C++ Runtime for
Dragon

Caution: Before you carry out an installation of Dragon using msiexec.exe, you must install Visual

C++ Runtime for Dragon on every dictation client computer. You can install it one of the fol-

lowing ways:

n Use the Dragon setup.exe on the command line, which automatically installs vcruntime.exe for

you.

n Include a vcruntime.exe command line in your admininstall.bat script (see Carrying Out an

Administrative Installation).

n If you are using msiexec.exe to install Dragon, manually install vcruntime.exe from the DVD

(see instructions below).

Manually Installing Visual C++ Runtime
Note: These steps are included in the msiexec.exe installation of Dragon.

1. Find the ISSetupPrerequisites/VCRuntime directory on the product DVD and open it. In this

directory you find the vcruntime.exe and vcruntime_x64.exe files. If you are installing Version

10 rather than Version 10.x or 11, look in the ISSetupPrerequisites\{1FAD9007-0FF1-4B05-

B7CE-ADE12FB7DEC5} directory; you find only the 32-bit version of vcruntime.exe for Ver-

sion 10.

2. Copy the vcruntime files to your server or to another accessible location. These .exe files install

Visual C++ Runtime for Dragon. Run vcruntime.exe on each 32-bit computer where you

intend to install Dragon and vcruntime_x64.exe on each 64-bit computer.

Caution: Do not attempt to extract the .msi file from either vcruntime.exe or vcruntime_x64.exe.

Installing the Visual C++ Runtime for Dragon as part of an msiexec.exe command line installation

of Dragon is not recommended and not supported.

Pushing an installation of the Visual C++ Runtime
You can install the Visual C++ Runtime for Dragon using a Windows installer (MSI).

To create the MSI file for the C++ Runtime, perform the following steps:

1. On the Dragon installation disc, find the vcruntime.exe file.

2. Double-lick the vcruntime.exe file.

3. When the Welcome dialog-box displays, use Windows explorer to navigate to the Windows

user's %TEMP% directory.

4. In the newest directory under the %TEMP% directory, look for a file called Visual C++ 9.0

Runtime for Dragon NaturallySpeaking.msi.

You can now use a server application and the Visual C++ 9.0 Runtime for Dragon Nat-

urallySpeaking.msi file to push the Visual C++ Runtime to multiple computers across a net-

work.
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See Overview of Installing Dragon using the Windows installer (MSI) for more information on

pushing MSI installations and using MSI files from a command prompt.

Using an MSI file to install the Visual C++ Runtime
from a command line
You can use the Visual C++ 9.0 Runtime for Dragon NaturallySpeaking.msi file to install

the C++ Runtime from a command line.

From a command line, pass the MSI file name as the application to install to the msiexec.exe

command using the /i option:

msiexec.exe /i "Dragon NaturallySpeaking11.msi"

Command Line Options for vcruntime.exe
Option Description

/L <Lang ID> To provide language ID. The default is US English.

/S Silent mode. To turn off GUI prompt for the Choose Setup Lan-
guage dialog box.

/v"<msiexec options>" To hide all GUI dialogs.To providemsiexec.exe parameters,
especially /qn for a silentmsiexec installation and /l*v to indi-
cate a file where extensive installation messages should be
logged. If you want fewer messages in the log, you can pass /l
without the v option. The * is a wildcard that calls all the other
logging options available.
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Chapter 6: Configuring and
using the Roaming feature
and Roaming User Profiles

This section describes how to set up, configure, and enable the Roaming feature on client computers.
This section also provides information on how to create, dictate with, and upgrade Roaming User pro-
files.
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Setting up the Roaming feature
The Roaming feature lets users dictate with Dragon from different network locations and on dif-

ferent computers without having to create and train individual User Profiles at each location.

The Roaming feature works by storing User Profiles in a central network location so that the infor-

mation Dragon learns from a user dictating on one computer is also available on other computers.

To set up Roaming User Profiles, carry out the steps shown in the table below, in chronological

order.

Topic Link

The Roaming feature Overview of the Roaming fea-

ture

Setting up the Roaming feature:

n Creating a network storage location for the Master Roam-
ing User Profiles

n Where to install and configure Dragon
n Storage space required for the Master and Local Roaming
User Profiles

n How Dragon Synchronizes Master and Local Roaming
User Profiles

n Estimating Network traffic caused by synchronization

Setting up the Roaming fea-

ture

Enabling the Roaming feature on each com-

puter where a user dictates:

n Setting Roaming User Profile locations
n Setting Roaming User Profile options
n Testing an HTTP or HTTPS connection

Enabling the Roaming feature

on each computer where a

user will dictate

Creating Roaming User Profiles:

n Creating and training a new Roaming User Profile
n Converting a non-roaming local User Profile into a Roam-
ing User Profile

n Copying a non-Roaming User Profile to the Master Roam-
ing User Profile location

Creating a Roaming User Pro-

file on the local computer

Dictating with a Roaming User Profile:

n Opening a Roaming User Profile
n Usingmultiple dictation sources with a single User Profile

n Running the Acoustic and Language Model Optimizer for
Roaming User Profiles

n SynchronizingMaster and Local Roaming User Profiles

Dictating with a Roaming

User Profile

Upgrade Roaming User Profiles from Dragon

NaturallySpeaking or Dragon Medical 9.x or 10.x

to Version 11

Upgrading Roaming User Pro-

files: Overview
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Topic Link

Enabling Roaming User Profiles as part of an

MSI installation

Enabling Roaming User pro-

files for an MSI installation
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Overview of the Roaming feature
The Roaming feature lets users dictate with Dragon from different network locations and on dif-

ferent computers without having to create and train individual User Profiles at each location.

Some situations that the Roaming feature makes possible:

n A doctor may need to dictate reports in a medical office building using a desktop computer, in a

hospital room using a Tablet PC, or at home using a laptop computer. The Roaming feature

allows the doctor to use the same set of User Profiles containing the same vocabulary words

with the acoustic information from each location.

n A user dictates on the same laptop at multiple offices and at home. Before leaving the office,

the user loads a set of User Profiles from a central location on the network to his laptop. Once

home, the user dictates and corrects as you normally would. When you return to the office, you

reconnect the laptop to the network. The next time the user opens a Dragon user profile, the

Roaming feature synchronizes the updated User Profiles on the laptop with those at the

network’s central location.

The relationship between the Master and the Local
Roaming User Profile
With the Roaming feature, each Dragon user profile has a single Master Roaming User Profile that

can be opened from multiple networked computers running Dragon. The Master Roaming User

Profile is stored on a network location accessible to your dictating users.

When a Master Roaming User Profile is opened from that central network location, Dragon trans-

fers a copy of that user profile to the local computer. That local copy is called the Local Roaming

User Profile.

The Local Roaming User Profile is a copy of the user data taken from the Master Roaming User

Profile but modified locally by corrections and acoustic data gathered during a dictation session.

You can set a central storage device to contain all your Master Roaming User Profiles. By loading a

Dragon User Profile from the central network location, your users can dictate at any computer

where Dragon is installed. When users exit Dragon and save the changes to their User Profiles,

these changes are saved in that central location. The next time the user runs Dragon, all the

changes saved are available regardless of which computer on the network he or she uses for dic-

tation.

Advantages of the Roaming feature
It is important to distinguish the Roaming feature from simply browsing to a network directory

and creating files there. Nuance recommends using the Roaming feature rather than storing non-

Roaming User Profiles in a network directory. Using the Roaming feature, you can:

n Minimize network traffic. When Dragon opens a User Profile, if there is already a copy of the

Roaming User Profile on the local computer, only the updates are downloaded from the

network. When the user closes the User Profile at the end of his or her dictation session, only

the updates from the current session are uploaded to the network. These updates typically
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amount to no more than a few KB of data, as opposed to roughly 25 MB of data if the entire

User Profile is opened and closed over the network.

n Allow the user to use Dragon even if the network directory is unavailable. In that case, Dragon

opens the local copy of the Roaming User Profile.

n Give the administrator precise control over where users can put User Profiles. If the Roaming

feature is enabled, the administrator can specify whether or not to also allow users to browse to

any User Profile location; the default is not to allow browsing. This means that the administrator

can easily see how many User Profiles have been created and who created them. If the Roaming

feature is not enabled, users can browse to any location to which they have access and create

User Profiles there.

n If HTTP Roaming is configured, it can be used to provide username/password authentication

on User Profiles.

Hosting Master Roaming User Profiles
There are several methods for hosting your Master Roaming User Profiles:

n On a file server you connect to over a Mapped Drive

n On a file server that you connect to over a UNC (Universal Naming Convention) address

n On a web server that you connect to over HTTP (http://)

n On a secure web server that you connect to over SSL (https://)

Why the Master Roaming User Profiles should be in
shared directories
Nuance recommends placing the master Roaming User Profiles in a shared directory to make cer-

tain administrative tasks more efficient. These tasks include:

n Scheduling an Acoustic and Language Model Optimizer task that optimizes multiple User

Profiles

n Upgrading multiple User Profiles to a new major release of Dragon

n Keeping track of how many User Profiles have been created, which helps with licensing

compliance (note that Dragon is licensed per user, not per workstation)

It is possible, though not recommended, to place Roaming User Profiles in a non-shared, user-spe-

cific location such as the user’s home drive, provided every user’s home drive is mapped to the

same drive letter (this is because the Roaming User Profile location is an administrative setting

that is per-workstation, not per-user).

Using multiple Roaming User Profile locations

If you have a large number of Roaming User Profiles, you may want to divide them among mul-

tiple shared directories. This facilitates performing tasks such as scheduling the Acoustic and Lan-

guage Model Optimizer on a subset of User Profiles. You can choose how to divide your User

Profiles, for example:

n By department

n By alphabetical groupings (for example A through H, I through M, N through R, and S through

Z)
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On each PC, you can configure any number of Roaming User Profile locations. Make sure you

give each Roaming User Profile location a display name that makes it clear to your users which

location to choose from.

Controlling user access to other user's profiles
If you have multiple Dragon users on an end-user workstation, those users will have multiple User

Profilexs to choose from in Dragon's Open User Profile dialog box.

If you use a shared directory for User Profiles, whether they are roaming or non-roaming, you may

be concerned about the ability of a user to see and/or open another user’s profile as well as their

ability to open the correct profile. There are several ways to address this concern:

n Many of Nuance’s customers address this concern simply through user training. Each user

should be aware that if they open another user’s profile and try to use it, their accuracy will be

poor and user-specific customizations will not be available. Therefore, each user has an

incentive to use only their own profile. However, this fact does not prevent a malicious user

from damaging another user’s profile.

n If users always log into Windows with a unique Windows user ID, you can use Windows file

permissions to control access to the profiles. Typically, you do this by granting Full Control or

Read/Write/Modify access to the shared directory, but do not allow this permission to

propagate to sub-directories. That way, each user becomes the creator owner of any Dragon

User Profile that he or she creates. Users can still see all of the Dragon User Profiles in the

Open User Profile dialog box, but if they try to select another user’s profile, a message will

appear saying that they do not have permission to access that profile. Apply similar file

permissions to the local copy of each Roaming User Profile; the default location for local copies

is under
C:\Documents and Settings\All Users\Application

Data\Nuance\NaturallySpeaking11\Roaming Users.

n If users log in using a shared Windows user ID, the best way to control access is through HTTP

Roaming. In this configuration, you set up a web server running either IIS or Apache and with

the WebDAV file system enabled. On each workstation, you specify a URL on the web server

as the Roaming User Profile location. When a user launches Dragon, before displaying the Open

User Profile dialog it prompts for a user name and password, which it uses to authenticate

against the web server.

You can use file permissions on the web server to specify which User Profiles are accessible to

each account on the web server. File security is a function of the web server and the WebDAV

software.

Making it easier for users to select their User Profiles 

As described above, the Dragon Open User Profile dialog shows a list of all of the User Profiles in

a shared directory (unless you are using HTTP Roaming to limit access to User Profiles). If there

are more User Profiles than will fit on one screen, you can train users to go directly to a specific

User Profile by typing the first few letters of its name.

It is possible to create an icon in the Start Menu and/or the Windows desktop that opens a spe-

cific User Profile. This can be helpful if there are only a few users of Dragon who share a
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particular workstation. Make a copy of the Dragon icon for each user, and place the parameter

/user ″user name″ on the natspeak.exe command line.

In Dragon 11 , you can display and view groups of User Profiles in a tree-style structure. See

"Open User Profiles dialog box optimized for Roaming" in Dragon version 11 - What's New for

administrators for more information.

Backing up your Master Roaming User Profiles
Dragon does not backup local Roaming User Profiles on the end-user workstations and does not

backup the Master Roaming User Profiles on the location where they are stored on your network.

It is the responsibility of your local system administrator to backup the Master Roaming User Pro-

files.

Notes: For use of WebDAV

n After you install Internet Information Services and WebDAV, you need to use the Internet

Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom

Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in

IIS 7:

n For more information, see Configuring Internet Information Services and WebDAV for HTTP

Roaming.
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n If you connected to your Roaming User Profile Master Directory over HTTP and you find that

the Open User Profile dialog box does not display all the vocabularies and acoustic models for

your User Profiles, make sure that you:
l Add all file extensions within your Master Roaming User Profile directories and

sub-directories to the Registered MIME types list of your IIS server. You could

also add a wildcard ( .*) MIME-type. For more information on adding a wildcard

( .*) MIME-type, see
http://www.microsoft.com/technet/prodtechnol/
WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-

83a2c180cd32.mspx?mfr=true.

l Check that no files in your User Profile directory are locked, password

protected, or otherwise access-restricted by your server permissions.
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Setting up the Roaming feature
When setting up the Roaming feature, note the following:

n Creating a network storage location for the Master Roaming User Profiles

n Where to install and configure Dragon

n Storage space required for the Master and Local Roaming User Profiles

n Synchronizing Master and Local Roaming User Profiles

n Estimating Network traffic caused by synchronization

Note: To enable the Roaming feature and set the Roaming User Profile options, you must log into

an account with Windows Administrator privileges.
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Creating a network storage location
for the Master Roaming User Profiles

For any installation of Dragon, you must first determine where on the network the Master Roam-

ing User Profiles should be located. 

Dragon lets you store your Master Roaming User Profiles on:

n Any networked computer.

You are not strictly required to store Master Roaming User Profiles on a server. Any shared

location accessible to other computers on the network is a perfectly acceptable place to store

Master Roaming User Profiles.

n a Windows file server

n A web server (HTTP)

n A secure web server running SSL (HTTPS)

Note: The location(s) you pick must be accessible to all computers where users will dictate with a

Roaming User Profile. Each location must have adequate storage space for Roaming User Profiles.

For more information, see Storage space required for User Profiles.

What to consider for the Master Roaming User
Profile location
To set up a location for the Master Roaming User Profiles, you should first determine:

n The kind of network file server on which you want to store your Master Roaming User Profiles.

Make sure it has enough storage space. Each location you pick must be accessible to all

computers where your users will dictate with Roaming User Profiles. You can create multiple

network storage locations.

n How the computers from where your users will dictate will connect to that network location;

for example using a mapped drive, UNC connection, or an HTTP or HTTPS connection..

Using a networked computer or Windows file
server
If you choose to use a networked computer or Windows server, you should determine the path to

where the Master Roaming User Profiles will reside. You can create multiple network storage loca-

tions.

The Roaming feature supports the following types of locations for your Master Roaming User

Profiles:  

n Mapped Drives—Connects to a shared network folder that has a drive letter assigned to it.

n UNC Paths—Connects to a shared network folder using the Universal Naming Convention

(UNC) to locate a user profile. Format is: \\<servername>\<sharename>\<path>\<filename>.
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What you'll need to know to configure your local Roaming User Pro-
files

After you have chosen the type of computer to store the Master Roaming User Profiles, you

should determine the following information so that you configure your local copies of Dragon to

connect to a mapped or shared drive:

Mapped Drives

UNC paths

Using a HTTP or HTTPS web server
If you choose to use a HTTP or HTTPS web server, the Roaming feature supports the following

types of locations for your Master Roaming User Profiles

n HTTP (http:)—Connects to computer on the internet or your local intranet. Format is:

http://<myserver.com>/<webdav>

n HTTP with SSL (https:)—Connects to computer on the internet or your local intranet with

SSL. Format is: https://<myserver.com>/<webdav>

Supported web servers

If you want to store your Master Roaming User Profiles on a web server, Internet access to Master

Roaming User Profiles is supported on two web servers:

n Microsoft Internet Information Services (IIS) version 6.0, 7.0, and 7.5. For this type of server:

l Digest authentication through a proxy server with Internet Information Server

(IIS) 6.0 is not supported.

l Be sure that the server has Web-based Distributed Authoring and Versioning

(WebDAV) software is turned on to publish content to an Internet Information

Services (IIS) web server.

If you have not already installed the WebDAV component, use the Add or

Remove Programs in your Control Panel and run the Windows Components

Wizard. WebDav is listed under Application Server>Internet Information

Services>World Wide Web Service>WebDAV Publishing.

n Apache HTTP Server 2.0.54 and higher. For this type of server:
l Internet Roaming User—Redirects must be turned on when using Digest

authentication.

l Be sure that the server has Web-based Distributed Authoring and Versioning

(WebDAV) software turned on. The WebDAV Apache module is available free

of charge at http://www.webdav.org/mod_dav/.

What you'll need to know to configure your local Roaming User Pro-
files

After you have chosen the type of computer to store the Master Roaming User Profiles, you

should determine the following information so that you configure your local copies of Dragon to

connect to the HTTP server:
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n The network location: You need to know the URL address of your HTTP server.

For more information, see XXXXX.

n HTTP settings: For your http (or https) connection you need to know

authentication, firewall, and proxy server information. For more information, see

HTTP Settings.

Notes: For use of WebDAV

n After you install Internet Information Services and WebDAV, you need to use the Internet

Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom

Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in

IIS 7:

n For more information, see Configuring Internet Information Services and WebDAV for HTTP

Roaming.

n If you connected to your Roaming User Profile Master Directory over HTTP and you find that

the Open User Profile dialog box does not display all the vocabularies and acoustic models for

your User Profiles, make sure that you:
l Add all file extensions within your Master Roaming User Profile directories and

sub-directories to the Registered MIME types list of your IIS server. You could

also add a wildcard ( .*) MIME-type. For more information on adding a wildcard

( .*) MIME-type, see
http://www.microsoft.com/technet/prodtechnol
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/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-

83a2c180cd32.mspx?mfr=true .

l Check that no files in your User Profile directory are locked, password

protected, or otherwise access-restricted by your server permissions.
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Where to install and configure Dragon

Installing Dragon where you plan to dictate using
the Roaming feature
Dragonmust be installed each computer where you plan to have users dictating with Roaming

User Profiles.

Installing Dragon on the same computer as your
Master Roaming User Profiles
Nuance recommends that you install Dragon on the same computer where the Master Roaming

User Profiles for your network are located.

As the system administrator, you are responsible for running the Acoustic and Language

Model Optimizer on the network location of the Master Roaming User Profiles. The Acoustic

and Language Model Optimizer and the Acoustic and Language Model Optimizer Sched-

uler can only be run on the Master Roaming User Profiles.

Running the Acoustic and Language Model Optimizer updates the Master Roaming User Profiles

with the accumulated acoustic data from any corrections and additional training done by the users

at the computers where they dictate. Running the Acoustic and Language Model Optimizer will

increase your overall accuracy. Any optimizations done by the Acoustic and Language Model

Optimizer are copied to each Local Roaming User Profile when synchronization occurs.

Running the Acoustic and Language Model Optimizer over the network can result in a large

amount of data being transferred between the server and the workstation running the optimizer.

For more information, see Running the Acoustic and Language Model Optimizer for Roaming

User Profiles.

If you are using Dragon 11 , see Using multiple acoustic models with a User Profile for infor-

mation on using the Acoustic and Language Model Optimizer with a User Profile that has two

acoustic models.

Notes:

n You must have Windows Administrator privileges on the computer where you are running the

Scheduler for the Acoustic and Language Model Optimizer.

n Do not enable the Roaming feature on the administrator computer where you plan to run the

Acoustic and Language Model Optimizer.

n When the Roaming feature is enabled on a computer where someone dictates, that computer is

blocked from locally running the Acoustic and Language Model Optimizer or the Acoustic

and Language Model Optimizer Scheduler on the local copy of the Roaming User Profiles.

For more information on installing or upgrading
Dragon
For more information on installing or upgrading Dragon on the computers in your network, see:
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n Upgrading Roaming User Profiles: Overview for information how to upgrade Roaming User

Profiles from Dragon NaturallySpeaking or Dragon Medical 9.x or 10.x to Version 11.

n The Installation Guide that came with your copy of Dragon for information on installing Dragon

on a single computer

n The System Administrator's Guide for information on how to use MSI to install or upgrade

Dragon on multiple computers.
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Storage space required for the Master
and Local Roaming User Profiles

Adequate storage space must be available for User Profiles that store information about each par-

ticular user’s speech patterns.

You need to plan for storage space on:

n Each computer where you plan to have users dictating with a Roaming User Profile.

n The network accessible central computer or computers where Master Roaming User Profiles are

stored.

These are guidelines only and not definitive specifications—actual size will vary from site to site.

For each Master Roaming User Profile- on the
network
For each Master Roaming User Profile (User Profiles stored on the central network location), you

should plan on:

n 25 MB for each set of Roaming User Profiles, This includes:
l 8 MB for each additional vocabulary you add for this user profile

l 18 MB for each additional dictation source you add for this user profile

n 500 MB for acoustic optimizer data associated with each dictation source of each User Profile

For each computer where Dragon is installed
You must install 1 copy of Dragon on each computer where your users will be dictating with the

Roaming feature. Multiple users can use a single Dragon installation.

Each installation of Dragon takes a minimum of 1 GB of free hard disk space for a custom Instal-

lation where you install only the program files and 1 set of User Profiles. Installations can range

from 800 MB (US English Home Edition) to 2.5 GB (US English Medical Edition), depending on

which languages and vocabularies you install. See Dragon system requirements for information on

disk space requirements for Dragon 11 .

Each installation of Dragon takes a minimum of 1 GB of free hard disk space for a custom Instal-

lation where you install only the program files and 1 set of User Profiles. Installations can range

from 800 MB (US English Standard Edition) to 2.5 GB (US English Medical Edition), depending

on which vocabularies you install. See Dragon system requirements for information on disk space

requirements for Dragon 11 .

For each Local Roaming User Profile- on the client
PC
On each installation of Dragon where your users plan to dictate using the Roaming feature, each

Local Roaming User Profile (the User Profiles stored on the local computer running Dragon),
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require the following:

n 25 MB for each set of Roaming User Profiles. This includes:
l 8 MB for each additional vocabulary you add for this user profile

l 18 MB for each additional dictation source you add for this user profile

n 10 MB per topic for language model optimizer data in the topic container data

n 240 MB for acoustic optimizer data associated with each dictation source of each User Profile

How much acoustic optimizer data is retained locally is controlled by settings on the Data tab of

the Options dialog box:

1. To set the number of minutes of audio to retain locally, click the Archive size... button and

position the slider.

2. To turn off retaining this data locally, check the Conserve disk space required by user pro-

file (for portability) option.

A non-Roaming User Profile requires approximately twice as much disk space as a local Roaming

User Profile. Dragon periodically creates a backup copy of a non-Roaming User Profile and stores

the copy on the local computer. On the other hand, a Roaming User Profile is stored in a network

storage location and Dragon does not create a backup copy of a Roaming User Profile.

An administrator should create backup copies of all Roaming User Profiles on a regular basis.
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How Dragon Synchronizes Master and
Local Roaming User Profiles

When a user that uses a Roaming User Profile exits Dragon, switches User Profiles, closes a User

Profile, or saves a User Profile, Dragon saves changes to the Local Roaming User Profile and then

synchronizes these changes with the Master Roaming User Profiles on the network.

In a networked situation, this occurs at the time one of these operations is performed.

When a user dictates using a computer not currently connected to a network, all changes are saved

to the Local Roaming User Profile; synchronization occurs when the user reattaches the computer

to the network containing the Master Roaming User Profile and opens that User Profile again.

For more information on what options effect what data gets synchronized between the Master and

Local Roaming User Profile, see Setting/selecting Roaming User Profile options.

Note: During synchronization, changes to the Master Roaming User Profile overwrite any changes

made to a Local Roaming User Profile that a user has been using for dictating and correcting dic-

tation while not on the network.

What happens during synchronization
The following changes take place when Local and Master Roaming User Profiles are synchronized:

n Combines words added to the Local Roaming User Profile during a dictation session with the

Master Roaming User Profile vocabulary,

n Removes words deleted from the Local Roaming User Profile from the Master Roaming User

Profile vocabulary.

n Copies acoustic data (from files with a .DRA or .NWV extension) from the Local Roaming User

Profile and adds them to the Master Roaming User Profile where the data become available to

the Acoustic Optimizer (Note that .DRA files saved voluntarily by the user along with a

document do not get added to the Master Roaming User Profile. The.DRA files created

automatically by Dragon for use by the optimizer are the only ones that get added to the Master

Roaming User Profile). For more information on running the Acoustic Optimizer, see Running

the Acoustic and Language Model Optimizer for Roaming User Profiles.

n Copies any custom commands created or modified locally (using theMyCommands editor) to

the Master Roaming User Profile.

n Saves any local user options that you changed on the Options or Formatting dialog box to the

Master Roaming User Profile, except the options listed below.

What changes don't get synchronized

The following options are not synchronized with the Master Roaming User Profile; they remain

exclusively on the local computer with the Local Roaming User Profile:

Locally set options on the Options dialog:

n On the Data tab:
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l Conserve disk space required by user profile option

l Create usability log option in the Advanced dialog box

l Incremental adaptation in general training option

n On theMiscellaneous tab:

l Voice enable menus and dialog controls option

l Launch Dragon in QuickStart mode when Windows starts option

n On other tabs of Options dialog box:

l All the options on the Playback/Text-to-speech tab

l All the options on the Hot keys tab

n Settings in the Auto-Formatting dialog box:

l The UK and Canadian postcodes option

l Medical Auto-Formatting options

What files are synchronized
The following table explains how and when individual files are copied or updated to the master

Roaming User Profile or to the local cache when the Master and Local Roaming User Profiles are

synchronized.

For more information on what options effect what data gets synchronized between the Master and

Local Roaming User Profile, see Setting/selecting Roaming User Profile options.

These options can effect how much data is transferred across your network when the Master and

Local Roaming User Profiles are synchronized. For more information, see Estimating Network traf-

fic caused by synchronization.

File name or type
Copied or updated with the master
Roaming User Profile

Copied or updated to local
cache

Acoustic files:*.usr
and *.sig

At save time if the Always copy
acoustic information to network
option in the Administrative set-
tings is on. See Acoustic files for
more details.

Copied if version number on
server is different

Vocabulary files:*.voc Copied only after the acoustic files
for the user profile have been mod-
ified with information from Learn
from specific documents, Learn
from sent e-mails, Import a list
of words or phrases, and similar
procedures.

Copied if version number on
server is different
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File name or type
Copied or updated with the master
Roaming User Profile

Copied or updated to local
cache

Acoustic archive
created for each dic-
tation session: acar-
chive.nwv
(encryption disabled),
acarchive.enwv
(encryption enabled)

Copied to session folder if it exists;
once master voice_container limit
is reached, nothing more is copied.
The local copy is deleted and a
zero-length file is created.

Never

Audio.ini Copied to master after running the
Check Microphone wizard or at
User Profile close if not copied suc-
cessfully after running the
Check Microphone wizard

Copied if version number on
server is different; also copied
right before Check Micro-
phone wizard is run

Backups Never - Dragon does not backup
local Roaming User Profiles on the
end-user workstations and does not
backup the Master Roaming User
Profiles on the location where they
are stored on your network.

See Backups for more details.

Never

DRA files, aco.ini;
drafiles.ini

Copied to session folder if the
master voice_container has space.
Files are deleted after being copied;
aco.ini and drafiles.ini are recreated
at zero-length

Never

Custom commands
created on client
PC:Mycmds.dat

Copied when User Profiles are
saved, or a User Profile is closed
and saved.

Copied at User Profile open if
version number on server is
different

Options.ini, sop-
tions.ini, itnop-
tions.ini

Copied at User Profile close,
options dialog close when the times-
tamp on the local file has changed.

Copied on User Profile open,
options dialog open if version
number is different on the
server

History of changes to
the vocabulary: Voc-
delta.dat

Merged to master copy on

User Profile save and open.

When vocabularies are copied

up, vocdelta.dat is reset to

zero in the master copy for

that topic.

Copied to local cache on User
Profile open andmerged into
the voc if version number is
different on the server

nsuser.ini, local.ini,
nssystem.ini, nat-
speak.ini

Never (machine dependent) Never

Acoustic files

If the setting is off (the default), after the acoustic optimizer runs on the master Roaming User

Profile, the server incorporates the changes
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In Dragon 11 , a user can set the Save Acoustic information option to control if Dragon saves

the .usr and .sig files on each computer they dictate on. See "Controlling updates to the acoustic

components of a User Profile" in Dragon version 11 - What's New for administrators for more

information.

Backups

It is the responsibility of your local administrator to backup the Master Roaming User Profiles.

However, Dragon does automatically back up local non-Roaming User Profiles on the end-user

workstations as specified in the Miscellaneous tab of the Administrative Settings dialog box.
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Estimating Network traffic caused by
synchronization

The following table explains how and when individual files are copied or updated to the master

Roaming User Profile or to the local cache when the Master and Local Roaming User Profiles are

synchronized and how much data is transferred in the process.

In addition, this table which option controls whether the data is transferred. For more information

on what options effect what data gets synchronized between the Master and Local Roaming User

Profile, see Setting/selecting Roaming User Profile options.

The estimates of the data transferred across the network is for a single Roaming User Profile.

Files copied to the Master
Roaming User Profile

Transfer Direction
& Data Amount

Files copied to the
Local Roaming User

Profile

Administrative
Setting to enable
for Transfer

Acoustic files: *.user

and *.sig

User Action: Dic-

tation, Audio Setup

Transfer time: When

the User Profile is

saved

15 MB

<---->

Transfer

time: Copied

if server ver-

sion is dif-

ferent from

client version

n Always copy acous-
tic information to
network

n Save Acoustic infor-
mation

Vocabulary files:

*.voc

User Action: Dic-

tation, Learn from spe-

cific documents, Learn

from sent e-mails,

Vocabulary Optimizer.

Transfer time: Copied

only after the vocab-

ulary files for the user

have been modified

with information from

Learn from specific doc-

uments, Learn from

sent e-mails, and the

Vocabulary Optimizer.

Copy only happens

after saving or closing a

User Profile.

13 MB

<---->

Transfer

time: Copied

if server ver-

sion is dif-

ferent from

client version

Access net-

work at user

profile

open/close

only
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Files copied to the Master
Roaming User Profile

Transfer Direction
& Data Amount

Files copied to the
Local Roaming User

Profile

Administrative
Setting to enable
for Transfer

Acoustic archive

created for each dic-

tation session: acar-

chive.nwv,

acarchive.enwv

User Action: Dic-

tation, Correction

Transfer time: Copied

to session folder if it

exists. Once master

voice_container limit is

reached, nothing more

is copied. Copy only

happens after saving or

closing a User Profile.

240 MB

<------

Transfer

time: Never.

The local

copy is

deleted and a

zero-length

file is created

after files are

copied to the

server.

Access net-

work at user

profile

open/close

only

DRA files created dur-

ing dictation: DRA

files, aco.ini, drafiles.ini

User Action: Dic-

tation, Correction

Transfer time: Copies

to session folder if the

master voice_container

has space.

1.3 MB/min-

ute

<------

Transfer

time: Never.

Files are

deleted after

being copied;

aco.ini and dra-

files.ini are rec-

reated at zero-

length

Conserve

archive size

on network

Custom commands

created on client PC:

Mycmds.dat

User Action: Changes

to some Options on the

local PC

Transfer time: Copied

when a User Profile is

closed or saved.

66 K

<---->

Transfer

time: Copied

when a User

Profile opens

on the local

PC and the

version

number on

the server is

different from

the version

number on

the server

.INI file changes on

client PC: options.ini,

< 1 k

<---->

Transfer

time: Copied
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Files copied to the Master
Roaming User Profile

Transfer Direction
& Data Amount

Files copied to the
Local Roaming User

Profile

Administrative
Setting to enable
for Transfer

soptions.ini, itnop-

tions.ini

User Action: Changes

to some Options on the

local PC

Transfer time: Copied

at User Profile close,

Options dialog close

when the timestamp on

the local file has

changed

to local cache

on when a

User Profile

opens and

merged into

the voc if the

version

number is dif-

ferent on the

server

History of changes to

the vocabulary: Voc-

delta.dat

User Action: Adding

words, changing word

properties

Transfer time: Merged

to master copy a User

Profile is saved or

opened. When vocab-

ularies are copied up,

vocdelta.dat is reset to

zero in the master copy

for that vocabulary

500 KB

max. (12

bytes/word)

<---->

Transfer

time: Copied

when a User

Profile opens

or the

Options

dialog opens if

the server ver-

sion is dif-

ferent from

the client ver-

sion

Merge con-

tents of voc-

delta.dat

into network

user profile

when file is

full

Log file: Dragon.log

User Action: Any use

of Dragon

Transfer time: Copied

if the Administrative

option is set.

< 1 MB

<------

Transfer

time: Never

Copy

Dragon log

to network
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Enabling the Roaming feature on each
computer where a user will dictate

After you have set up the network location for the Master Roaming User Profiles and installed or

upgrading Dragon on the computers in your network, you must enable the Roaming feature on

each computer where the user will dictate using a Roaming User Profile.

Step 1: Start Dragon
You must start Dragon to enable the Roaming feature.

Step 2: If already Dragon is running, select
Administrative Settings
If Dragon is already running, on the DragonBar, select Tools > Administrative Settings and

click Proceed. This action closes all open User Profiles and displays the Administrative Settings

dialog box.

Step 3: Turn on the Roaming feature
After closing any open User Profiles:

1. If Dragon is running, from the DragonBar menu, select Tools > Administrative Settings.

This action displays the Administrative Settings dialog box.

Note: You do not have to be running Dragon to act as an administrator of the product.

Instead of opening the Administrative Settings dialog box from the DragonBar

menus, you can open the dialog box from the command line by selecting Start > Run,

then entering the following command in the Open text box (include a space between

natspeak.exe and the /SetAdministrativeOptions option that follows it):

“C:\Program Files\N-
uance\NaturallySpeaking11\Program\natspeak.exe”
/SetAdministrativeOptions

2. On the Roaming tab, check Enable.

3. Click Apply to save the changes and keep the dialog box open.
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Note:With the Roaming feature enabled, the Open User Profile dialog box later displays only

User Profiles in the Roaming User Profile storage locations. To let the users open both local (non-

roaming) and Roaming User Profiles, check the Allow non-roaming user profiles to be opened

option in the Administrative Settings dialog box. Clearing this option prevents users from dic-

tating with a non-roaming (local) User Profile by mistake, but you should check it now if you want

to ensure you can open existing local User Profiles so that you can convert them to Roaming User

Profiles.

Step 4: Set the location of Master Roaming User
Profiles
On each computer where you plan to have users dictating as a Roaming User Profiles, you must

tell that installation of Dragon where the Master Roaming User Profiles are located.

After selecting Enable on the Roaming tab:

1. Click the Add button. The Roaming User Network Location dialog box displays. You use the

Roaming User Network Location dialog box to define the network location of the master

Roaming User Profiles. The location you pick must be accessible to all computers on the net-

work that you want available for dictation with Dragon.

2. Set the Display Name to the way the name of the directory should display in other dialog

boxes. The display name later appears in the Roaming tab of the Administrative Settings

dialog and the Location of user profile text box of both the Open User Profile and theMan-

age User Profiles dialog boxes.

3. Set the Network Location. See the types of locations that the Roaming feature supports in

Creating a network storage location for Master Roaming User Profiles.

4. If you are using a web server to store Master Roaming User Profiles, click the HTTP Settings

and SSL Settings (if you are using HTTPS) button to set information about your HTTP and

HTTPS connection and proceed with HTTP Settings and SSL Settings for further information.

After entering the HTTP and SSL Settings, use the Test Connection button to make sure

your settings are correct. For help troubleshooting a problem with the connection, see Testing

and troubleshooting an HTTP connection .

5. Click OK in the Roaming User Network Location dialog box.

For more information on setting the location of the master Roaming User Profiles, see Roaming

User Network Location.

Note: You cannot create a non-Roaming User Profile on an HTTP connection. You

can only create Roaming User Profiles on an HTTP connection when the Roaming

feature is enabled.

Step 5: Set location of Local Roaming User Profiles
When a user opens a Master Roaming User Profile, Dragon transfers a copy of that User Profile to

the local computer. That local copy is called the Local Roaming User Profile. This is the location

on the computer where changes made during a dictation session, such as corrections or new acous-

tic data, are stored before they are synchronized with the master Roaming User Profile.
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You can set this location, called <Roaming Local>, from the Administrative Settings dialog box.

Nuance recommends leaving this option at the default setting.

Note: the location of <Roaming Local> is per-PC and cannot be changed to a user-specific loca-

tion.

<Roaming Local>

To accept the default <Roaming Local> location (which Nuance recommends), click OK on

the Administrative Settings dialog box. You will be prompted to create the default directory if it

does not already exist. When you see the following message, click Yes.

The default location of <Roaming Local> is:

n XP: C:\Documents and Settings\All Users\Application
Data\Nuance\NaturallySpeaking11\RoamingUsers\<display name>\

n Vista: C:\Users\All
Users\Nuance\NaturallySpeaking11\RoamingUsers\<display
name>\

See Dragon file structure for information on the default location of the RoamingUsers directory

for Dragon 11 on Windows 7.’

The <display name> is the name you defined for the Master Roaming User Profile location. You

can have multiple network storage locations for your Master Roaming User Profiles and each has

its own corresponding directory for Local Roaming User Profiles.

Changing the default location for <Roaming Local>
1. Use the Browse for Folder dialog box to open a location where you want to store the local

Roaming User Profile. This is the location on the computer where changes made during a dic-

tation session, such as corrections or new acoustic data are stored before they are synchronized

with the master Roaming User Profile.

2. If the directory does not currently exist, click Make New Folder and type a name for the new

folder. The new directory can have any name, but calling it something meaningful, such as Local

Roaming User Profiles, will make the folder easier to find in the future.

3. Click OK.

Step 6: Set Roaming feature options
The Administrative Settings dialog box also contains several options that affect how the Roam-

ing feature works. You select the options that indicate how you want a Roaming User Profile to

function at each Roaming User Profile location. For a list of the options to choose from, refer to

Selecting Roaming User Profile options. 
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Notes:
n Once you set up an installation of Dragon to use the Roaming feature, users on that computer

can only open Roaming User Profiles; they cannot open any locally created User Profiles unless

you choose the "Allow non-roaming user profiles to be opened" option. For a list of the

options to choose from, refer to Selecting Roaming User Profile options. 

n If a user is dictating with a Roaming User Profile, the Acoustic and Language Model

Optimizer Scheduler is disabled on the local user's computer. You must run the Acoustic

and Language Model Optimizer on the computer where your Master Roaming User Profiles

are located or on an administrator’s workstation. For more information, see Running the

Acoustic and Language Model Optimizer with a Roaming User Profile.

213



Dragon Administrator Guide version 11

Administrative Settings: Roaming tab
You use the Roaming tab of the Administrative Settings dialog box to set up the Roaming fea-

ture. You must set up the Roaming feature on each computer where you want users to dictate

with a Roaming User Profile.

When Roaming is enabled in Administrative Settings by default the Open User Profiles dialog box

displays large numbers of User Profiles quickly. They can also be organized into subfolders. See

"Creating subfolders for Roaming User Profiles" in the Dragon Help for more information.

Enable

Select Enable to activate the Roaming feature and the Roaming User Profile options.

Network Directories

To set the location of the master Roaming User Profile(s):

1. Click the Add button. You use the Roaming User Network Location dialog box to define

the network location of the master Roaming User Profiles. The location you pick must be acces-

sible to all computers on the network that you want available for dictation with Dragon.

2. Set the Display Name and the Address underNetwork Location. The Roaming feature sup-

ports the following types of locations:
n Mapped Drive—the format is: <drive letter>:\<folder name>. For example,

y:\roaming.

n UNC Path—the format is: \\servername\sharename\path\filename.

n HTTP (http:)—the format is: http://myserver.com/<name_of_virtualdirectory>

where <name_of_virtualdirectory> is the name of the virtual directory set up by an

administrator during setup of the IIS or Apache web site. For HTTP locations, click

the HTTP Settings button to set information specific to your HTTP connection.

You can also test your connection to the HTTP server from the HTTP Settings

dialog box.

n HTTP with SSL (https:)—the format is: https://myserver.com/<name_of_

virtualdirectory> where <name_of_virtualdirectory> is the name of the virtual

directory set up by an administrator during setup of the IIS or Apache web site. For

HTTP with SSL locations, click the SSL Settings button to set information specific

to your HTTP with SSL connection. You can also test your connection to the

HTTP with SSL server from the SSL Settings dialog box.

Local directory (for cache)

When a user opens a Master Roaming User Profile, Dragon transfers a copy of that user profile to

the local computer. The local copy is called the Local Roaming User Profile.

You can change the setting of this location, always called <Roaming Local>.

The default location of <Roaming Local> on Windows XP is:

Documents and Settings\All Users\Application Data\N-
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uance\NaturallySpeaking11\RoamingUsers\<display name>\<u-
sername>

See Dragon file structure for information on the default location of the RoamingUsers directory

for Dragon 11 on Windows Vista and Windows 7.

The <display name> is a name you assigned as a Master Roaming User Profiles location. You can

have multiple network storage locations for your Master Roaming User Profiles.

The <username> is the name of an individual Master Roaming User Profile. There is a separate

directory for each user profile.

Click the Browse button to find or create a new location.

Check Boxes for Roaming User options

The check boxes and other components below the Local directory are the Roaming User

options. You can also configure the Open User Profiles dialog box to display the Classic Open

User Profiles dialog if desired. See Selecting Roaming User Profile options. for details.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed

Dragon. Note that the default is to have the Roaming feature turned off.

Notes: For use of WebDAV

n After you install Internet Information Services and WebDAV, you need to use the Internet

Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom

Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in

IIS 7:
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n For more information, see Configuring Internet Information Services and WebDAV for HTTP

Roaming.

n If you connected to your Roaming User Profile Master Directory over HTTP and you find that

not all your User Profiles are listed in the Open User Profile dialog box, or after creating a

Roaming User Profile you cannot open it again, or the Open User Profile dialog box does not

display all the vocabularies and acoustic models for your User Profiles, make sure that you:
l Add all file extensions within your Master Roaming User Profile directories and

sub-directories to the Registered MIME types list of your IIS server. You could

also add a wildcard ( .*) MIME-type. For more information on adding a wildcard

( .*) MIME-type, see
http://www.microsoft.com/technet/prodtechnol
/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-

83a2c180cd32.mspx?mfr=true.

l Check that no files in your User Profile directory are locked, password

protected, or otherwise access-restricted by your server permissions.
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Administrative Settings: Roaming
User Network Location

You use the Roaming User Network Location dialog box to define the network location of the

master Roaming User Profiles.

The location you pick must be accessible to all computers where users will dictate using a Roam-

ing User Profile.

Display Name
Sets the directory name displayed in the following locations:

n The Roaming tab of the Administrative Settings dialog box

n The Location of user profile drop-down list in the Open User Profile dialog box.

Note:With the Roaming feature enabled, the Open User Profile dialog box displays only User

Profiles in the Roaming User Profile locations. To let the users open both local (non-roaming)

and Roaming User Profiles, select the Allow non-roaming user profiles to be opened option

on the Administrative Settings dialog box. Clearing this option prevents users from dictating

with a non-roaming (local) User Profile by accident. For more information, see Enabling the

Roaming feature on each computer where a user will dictate.

n The Location of user profile drop-down list in theManage User Profiles dialog box.

Network Location—Address
On each computer where you plan to have users dictating as a Roaming User Profiles, you must

tell that installation of Dragon where the Master Roaming User Profiles are located.

The Roaming feature supports the following types of locations:

Mapped Drives and UNC Paths

Mapped drives connect to a shared network folder that has a drive letter assigned to it.

UNC paths connect to a shared network folder using the Universal Naming Convention (UNC) to

locate a user profile. The UNC is a way to identify a shared file on a computer or network without

having to know the storage device it is on. The UNC path format is:

\\servername\sharename\path\filename.

To use a mapped drive or UNC path:

1. UnderNetwork Location, enter the address of the mapped drive or UNC path.

You can click Browse to browse for the location of the mapped drive or UNC path. This dis-

plays the Browse for Folder dialog box. You can also create a new directory on the mapped

drive or UNC path by clicking the Make New Folder button.

2. Click OK when you are done.
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Intranet/Internet connections

The Intranet/Internet connection supports both HTTP and HTTP over an encrypted Secure

Sockets Layer (SSL).

To use an Intranet/Internet connection:

1. Under Network Location, enter the URL address of your HTTP or HTTPS server where your

master Roaming User Profiles are located.

2. Click
n HTTP Settings...to display the HTTP Settings dialog box, where you can set

information specific to your HTTP connection like Authentication, Firewall, and

Proxy Server information. You can also test your connection to the HTTP server

from this dialog box. For more information, see HTTP Settings.

n SSL Settings...to display the SSL Settings dialog box, where you can set

information specific to your HTTPS (SSL) connection. You can also test your

connection to the HTTPS server from this dialog box. For more information, see

SSL Settings.

Note: You cannot create a non-Roaming User Profile on an HTTP or HTTPS connection. You

can create only Roaming User Profiles on an HTTP or HTTPS connection and only when the

Roaming feature is enabled.
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Setting up HTTP Connection: HTTP
Settings

You use the HTTP Settings dialog box to define and configure the connection to your

web (HTTP) server. Enter information about your connection in the following sections and text

boxes of the dialog box:

Authentication
Passwords

Defines how a user that uses a Roaming User Profile enters the server username and password.

This username/password is to the server, not a local login:

n Prompt for User and Password: Select if local users will be prompted for a

username/password when they connect to the HTTP server.

n User/password: Sets the default username/password needed to connect to the HTTP server.

Be sure to put the domain name followed by a backslash in front of the user login name; for

example, Nuance\JWyman.

Authentication Type

Sets the type of authentication used on the HTTP server you specified as the Address in the

Roaming User Network Location dialog box. Select the type that indicates how your server is

configured:

n Basic: Choose if the server is configured for Basic authentication, where the username and

password are passed over the network as clear text

n Digest: Choose if the server is configured for Digest authentication, where the passwords are

never transmitted across the internet in unencrypted form. Digest is not supported for IIS.

Note: Digest authentication through a proxy server with Internet Information Server (IIS) 6.0 is

not supported.

Note: For security reasons, be sure that anonymous logins are disabled on the HTTP or

HTTPS server.

Connection
Follow Redirects

If you are storing the Master Roaming User Profiles on a server that redirects incoming con-

nections to another location, you can define how Dragon handles these redirects:

n Never: redirects are never followed, but ignored.

n Always: redirects are always followed.

n Same Scheme Only: only redirects using the same scheme as the client request are permitted.

Keep Connection Alive

This setting tells the client and server to keep the connection alive after the current session ends.
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Firewall and Proxy Servers
Use Proxy Server

Select Use Proxy Server if you are connecting to your HTTP server through a proxy server.

Type

Select the type of firewall used on the HTTP server from the drop-down list:

n HTTP Proxy: Select for a proxy server that specializes in HTML (web page) transactions.

n Tunnel: Select if you are connecting to the server with tunneling software.

n SOCKS4: Select for a SOCKS4 protocol that relays TCP sessions at a firewall host to allow

application users transparent access across the firewall. SOCKS4 doesn't support authentication,

UDP proxy. SOCKS4 clients require full Domain Name Service (DNS).

n SOCKS5: Select for a SOCKS5 protocol that relays TCP sessions at a firewall host to allow
application users transparent access across the firewall. SOCKS5 supports multiple
authentication methods. SOCKS5 clients use the SOCKS5 server to perform the DNS
lookup.

Server

Enter the server name provided by your network administrator.

Port

Enter the port number needed to connect to the proxy server or firewall.

User

Enter any username needed to log in to the proxy server or firewall.

Password

Enter any password needed to log in to the proxy server or firewall.

Firewall Data or Proxy Authorization

Enter any special authentication string provided by your network administrator.

Timeouts
Lock

Set to the number of seconds the server should wait before breaking the lock on any open Master

Roaming User Profiles. Setting the lock to 0 uses the default setting from the server. Specifying

another time overrides the server default. The administrator is responsible for breaking this type

of lock.

A network locks prevent anyone from opening a Master Roaming User Profile that someone else

has already opened. While this process does not take a long time, network problems can cause a

lock to become “stuck” and not release when the opening process is completed. When this
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happens, the next time you try to open that user profile, you see a message informing you of the

lock.

The Administrator has to break the lock.

Connection

Number of seconds before Dragon should close the connection to the server either when the con-

nection is idle or after the connection has been open for that duration.

Type

Sets when the connection timeout in the previous text box applies:

n Inactivity: Closes the connection after the Roaming User Profile is inactive for the specified

time.

n Absolute: Closes the connection after the specified time independent of any Roaming User

Profile network activity. Use this option with caution, as it could close the connection during

synchronization.

Test Connection
Once you have filled in the information, you can click the Test Connection button to test the

connection to the HTTP server.

Restore Defaults
Restores the default settings.

After you click OK, you return to the Administrative Settings dialog box.
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Setting up secure web server
connection: SSL Settings

You use the SSL Settings dialog box to define and configure the connection to your secure

web (HTTPS) server. Enter information about your connection in the following sections and text

boxes of the dialog box:

Certificate Store
Here you indicate the type of certificate that provides server identity, certificate, and public key

information to clients that try to establish a connection:

Certificate Store Type

Select the certificate store type used for the client certificate on the local computer:

n User (default): For Windows, choose if the certificate store is a certificate store owned by the

current user. For Java, choose if the certificate store is the name of a JKS (Java Key Store) file.

If the provider is OpenSSL, choose if the certificate store is a file that contains the PEM

encoded certificate and private key.

n Machine: Choose if the certificate store is a machine store (not available in Java or when

provider is OpenSSL).

n PFX file: Choose if the certificate store is the name of a Private Key Server or PFX (PKCS12)

file containing certificates. If the provider is OpenSSL, the file may contain only one certificate

and private key.

n PFX Blob: Choose if the certificate store is a string (binary or base64 encoded) representing a

certificate store in PFX (PKCS12) format.

n PEM Key: Choose if the certificate store is a string or file name that contains a Privacy

Enhanced Mail (PEM) encoded certificate and private key. This store type is currently not

supported in Java.

Certificate Store

The name of the certificate store for the client certificate on the local computer:

The storage location is called the certificate store. A certificate store will often have numerous cer-

tificates, possibly issued from a number of a different certification authorities:

n MY: A certificate store holding personal certificates with their associated private keys.

n CA: A certificate store holding Certifying Authority (CA) certificates.

n ROOT: A certificate store holding ROOT certificates.

n SPC: A certificate store holding Software Publisher Certificate (SPC) certificates.

n Other: Any other Certificate Store not listed above.

Notes:

n If you select PFX file for the Certificate Store Type, for the Certificate Store select Other

and enter the name of the file in the associated text box below it.
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n If you select PFX Blob for the Certificate Store Type, for the Certificate Store select Other

and enter the binary contents of a PFX file (for example, the PKCS12) in the associated text

box below it.

n If you are using OpenSSL, for the Certificate Store select Other and enter the name of the file

containing a certificate and a private key in the associated text box.

Certificate Store Password

The password for the Certificate Store on the local computer if one is required.

Open SSL
Select Using OpenSSL if the HTTPS server uses OpenSSL as a Certificate Authority. OpenSSL

is a free non-commercial implementation of SSL.

When you select Using OpenSSL, you must provide:

n Cipher List: A string that controls the ciphers to be used by SSL. The cipher list consists of

one or more cipher strings separated by colons.

n Certificate Authority File: Name of the file containing the list of certificate authorities (CAs)

trusted by your application. The file set by this property should contain a list of CA certificates

in PEM format.

n CA Directory: Path to a directory containing CA certificates. The path set by this property

should point to a directory containing CA certificates in PEM format.

General
Use this section to enable/disable the supported security protocols on the HTTPS server.

n TLS1: Version 1 of the Transport Layer Security (TLS) protocol.

n SSL3: Version 3 of the Secure Sockets Layer (SSL) protocol.

n SSL2: Version 2 of the Secure Sockets Layer (SSL) protocol.

n PCT1: Version 1 of the Private Communications Transport (PCT) protocol.

Notes:

n Although a number of sites still support SSL2, Nuance recommends that you disable it because

of potential security vulnerabilities.

n If you select Using OpenSSL, this functionality is provided by the Cipher List.

Test Connection
Once you have filled in the information, you can click the Test Connection button to test the

connection to the HTTPS (SSL) server.

Restore Defaults
Restores the default settings.

After you click OK, you return to the Administrative Settings dialog box.

223



Dragon Administrator Guide version 11

Testing and troubleshooting an HTTP
connection

Once you have supplied all the necessary information needed to connect to your HTTP server,

press the Test Connection button. The Test Connection button tests the connection to your

HTTP server based on the information you supplied in the Roaming User Network Location and

HTTP Settings dialog boxes.

Troubleshooting test connections
The table below lists the possible messages you might receive after pressing the Test Con-

nection button.

Message Solution

Connection test successful! n None—test successful.

Could not connect to the

network location.

n Check spelling and syntax of the HTTP address in the HTTP Settings
dialog.

n Check your local network for problems.

Could not copy a file to the

network location

n Check create andwrite privileges on the server
n WebDav Server not installed or active. For more information, see
Configuring Internet Information Services andWebDAV for HTTP
Roaming.

Could not create a directory

on the network location

n Check the create directory privileges on the server for the Master
Roaming directory.

n Check the privileges for creating sub-directories under the Master
Roaming directory.

Could not delete a file from

the network location

n Check permissions on the Master Roaming directory. The user must
have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.

Could not delete a directory

from the network location

n Check permissions on the Master Roaming directory. The user must
have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.

Could not copy files into a

directory created on the net-

work location

n Check permissions on the Master Roaming directory. The user must
have read, write, andmodify privileges.

n Check for authentication time-out on your server.
n Check your local network for problems.

Could not list the contents

of a directory created on the

network location

n Check permissions on the Master Roaming directory. The user must
have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.

Contents of newly created

directory TempDir were

incorrect

n Caused by an incomplete directory listing. Try again. If the problem
persists, check the condition of your network.
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Message Solution

Could not copy a file from

the network location

n Check permissions on the Local Master Roaming directory.
n Check that the Local Master Roaming directory exists.
n MIME types not set to *.* (the file is .txt).

Could not get the size of a

newly created directory on

the network location.

n Apache: Make sure DavDepthInfinity directive is set to "on" for
Master Roaming directory.

Could not rename a file on

the network location

n Check permissions on the Master Roaming directory. The user must
have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.

Could not rename a direc-

tory on the network location

n Check permissions on the Master Roaming directory. The user must
have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.

Could not copy a directory

within the network location

n Check permissions on the Master Roaming directory. The user must
have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.
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Setting and selecting Roaming User
Profile options

The Administrative Settings dialog box also contains several options that you can choose from

to indicate how you want a Roaming User Profile to function at each Roaming User Profile loca-

tion.

These options can effect how much data is transferred across your network when the Master and

Local Roaming User Profiles are synchronized. For more information, see Estimating Network traf-

fic caused by synchronization and How Dragon Synchronizes Master and Local Roaming User Pro-

files.

Roaming User Profile options on the Administrative
Settings dialog box
Display Classic Open User Profiles dialog

Enable this option to display the Classic Open User Profiles dialog box. The setting configures

the Open User Profiles dialog box to display only folders that contain actual Dragon Medical

User Profiles in the Location of User Profiles box.

Note:

For faster performance at large sites with Roaming User Profile directories, Nuance recommends

using the default appearance for the Open User Profiles dialog box. Displaying the Classic Open

User Profiles dialog box takes longer because Dragon Medical first verifies that directories con-

tain valid Dragon Medical User Profiles. Directory structures do not display with the Classic set-

ting.

Allow non-Roaming User Profiles to be opened

Select this box to permit the user to open non-Roaming (local) User Profiles. Nuance rec-

ommends clearing this option to prevent anyone from dictating with a non-Roaming (local) user

profile by accident. You may want to set this option temporarily in order to convert non-roaming

(local) User Profiles to Roaming User Profiles, and then clear it when you are done.

Merge contents of vocdelta.dat into network user profile when file is
full

Select this box to copy the contents of the local vocdelta.dat file to the master Roaming User Pro-

file without running the Acoustic and Language Model Optimizer.

If you do not set this option and if you have not run the Acoustic and Language Model Optimizer

for a long time, the user will see a message when the vocdelta.dat file becomes full. If you do not

run the Acoustic and Language Model Optimizer regularly, you should set this option to prevent

end users from seeing this message.

Vocdelta.dat is the file used to store vocabulary changes in the Master Roaming User Profile. It is

updated whenever a Local Roaming User Profile is closed, and it is used to update the Local

226



Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles

Roaming User Profile with vocabulary changes every time that user profile is opened. When you

run the Acoustic and Language Model Optimizer on the Master Roaming User Profile, Dragon

incorporates the contents of vocdelta.dat into the vocabulary (.voc) file and clears the content of

vocdelta.dat.

If you check this setting, Dragon monitors the size of the vocdelta.dat file. When the voc-

delta.dat file reaches 90% of it's maximum size (500 KB), Dragon incorporates the contents of

the vocdelta.dat file into the vocabulary (.voc) file and clears vocdelta.dat

This operation occurs when the user opens the local Roaming User Profile. This operation can

take a long time because the vocabulary file must be transferred over the network twice. Sub-

sequently, opening the local Roaming User Profile on another workstation can also take a long

time because the entire vocabulary file must be copied from the master to the local Roaming User

Profile.

Selecting this option will transfer at maximum 500 KB, or 12 bytes/word across the network at

synchronization if the Roaming and Local copies are different..

Access network at user profile open/close only 

Select this box to synchronize changes made to the local Roaming User Profile to the Master

Roaming User Profile only when a local Roaming User Profile opens or closes. If this box is not

selected, then these local changes are immediately transferred to the Master Roaming User Profile.

The only changes affected by this setting are the changes a user makes locally from the Options

dialog box, therefore this setting is highly unlikely to have a perceptible impact on Dragon’s per-

formance.

At synchronization, setting this option will copy approximately

n 13 MB of vocabulary files (*.voc).

n 240 MB of acoustic archive files create for each dictation session (acarchive.nwv and

acarchive.enwv).

Note: These files are only copied from the Local to the Roaming User Profile; they are never

copied from the Roaming User Profile to the local User Profile.

These file will synchronize across the network when:

n Vocabulary files - when the Local user modifies the vocabulary with information from the

Learn from specific documents, Learn from sent e-mails, or Vocabulary Optimizer dialogs

or when the Roaming and Local copies are different.

n Acoustic archive files - these files will be copied to session folder if it exists. Once the master

voice_container limit is reached, nothing more is copied.

Ask before breaking locks on network user profiles (recommended
for UNC and mapped drives)

Select this box to keep the option of maintaining or breaking a network lock when opening a

Roaming User Profile. Normally, network locks prevent anyone from opening a Roaming User Pro-

file at the same time someone else is opening that user profile. While this process does not take a

long time, network problems can cause a lock to become "stuck" and not release when the open-

ing process is completed. When this happens, the next time anyone tries to open that user profile,
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Dragon displays a message stating that the user profile is locked and giving them the option of over-

riding it. If you do not want this message displaying and always want to break a network lock in

this situation, you can clear this option to prevent the message from appearing. Because the pres-

ence of a lock can indicate a problem that needs to be addressed, Nuance recommends that you

enable this option.

Notes:

n This option is valid for users connecting to the Master Roaming User Profile location using a

mapped drive or UNC drive, but is not supported for users connecting over HTTP.

n Be careful when in breaking a locked Roaming User Profile. For example, if you break a lock

when another user is writing to the Master Roaming User Profile, breaking the lock may corrupt

the Master Roaming User Profiles.

n If a user opens a Roaming User Profile while the Acoustic and Language Model Optimizer is

running on the Master Roaming User Profile, the user will see a message but can continue.

Set audio levels on each machine (recommended)

Select this box to run the Check your microphone option from the Accuracy Center window

before your first session with a Roaming User Profile. This includes the Volume Check and the

microphone Quality Check. Check this option if your users are dictating on different computers

or on a single computer, like a laptop, in many different locations. When a user changes computers

or locations, the audio setup data can vary depending on differences in the microphone and sound

card, as well as differences in ambient sound levels of each Roaming User Profile location. In sit-

uations where Dragon detects a significant difference between operating systems, sound cards,

microphones, or other hardware, the program will prompt you to run Check your microphone

even if you do not have this option selected. 

Save acoustic information

A user selects the Save acoustic information option to make sure that their acoustic information

is saved along with their local User Profile. By saving the acoustic information, the user ensures

that any corrections they make will be available after they close and re-open the User Profile. This

option also makes sure that these corrections will be synchronized between the Local and Master

Roaming User Profile if the user also enables the Always copy acoustic information to network

option.

This option is turned on by default

Copy Dragon Log to Network

Select this box to copy the Dragon.log file from the local workstation to the master Roaming User

Profile location whenever the program synchronizes the local and master Roaming User Profile.

Dragon.log contains information that can help to diagnose problems that your users might

encounter using Dragon.

Note: The Dragon.log file will not be copied once the maximum size is reached in the Disk space

reserved for network archive option.

Selecting this option can increase how long it takes to close a Roaming User Profile. It can also

limit the usefulness of the Acoustic and Language Model Optimizer because it reduces the
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amount of acoustic data that can be stored in the network archive. Nuance recommends that you

not set this option unless requested by Nuance Technical Support.

Selecting this option will transfer 1 MB or less of data across the network at synchronization.

These files are only copied from the Local Roaming User Profile to the Master Roaming User Pro-

file; they are never copied from the Master Roaming User Profile to the Local Roaming User Pro-

file.

Always copy acoustic information to network

Select this box to copy the user profile’s acoustic model (.usr and .sig files) to the Master Roaming

User Profile location.

If you chose not to copy the user profile’s acoustic information to the network, updates to the

acoustic model that you make on one computer (for example by correcting and training words)

will not be available on other computers used by that particular Roaming User Profile until you

run the Acoustic and Language Model Optimizer on the Master Roaming User Profile loca-

tion and the Local and Master Roaming User Profiles synchronize. Therefore, if you do not run

the Acoustic and Language Model Optimizer on the Master Roaming User Profiles regularly,

you should set this option.

By always copying the acoustic information to the Master Roaming User Profile location, you

ensure these accuracy improvements will be available when the Master Roaming User Profile is

opened from another location. However, setting this option can increase the amount of time it

takes to close a Roaming User Profile.

In Dragon 11 , a user can set the Save Acoustic information option to control if Dragon saves

the .usr and .sig files on each computer they dictate on.

See "Controlling updates to the acoustic components of a User Profile" in Dragon version 11 -

What's New for administrators for more information.

The transfer of acoustic information based on this option's setting is not limited by setting the

Disk space reserved for network archive option.

Setting this option will copy approximately 15 MB across the network at synchronization if the

Roaming and Local copies are different.

Conserve archive size on network 

Select this box to prevent copying of .DRA files (files that contain the acoustic data from the

latest dictation session) to the Master Roaming User Profile location when the program syn-

chronizes the Local and Master Roaming User Profiles. Leaving this box unchecked allows the

local .DRA files to synchronize with the Master Roaming User Profile, which makes the .DRA

files available to the Acoustic and Language Model Optimizer when it is run on the Master

Roaming User Profile locations and provides increased accuracy.

However, because .DRA files can be large, if you experience excessive network slowdowns,

checking this option may solve the problem by eliminating the copying of these files each time

the Master and Local Roaming User Profiles synchronize. You can still run the Acoustic and Lan-

guage Model Optimizer on the Master Roaming User Profile, but since it will not have the

.DRA files to process, the accuracy gains will be less.
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Note: The .DRA files will not be copied once the maximum size is reached in the Disk space

reserved for network archive option.

At synchronization, setting this option will copy approximately 1.3 MB for each minute of dic-

tation saved in the .DRA files. These files are only copied from the Local Roaming User Profile to

the Master Roaming User Profile; they are never copied from the Master Roaming User Profile to

the Local Roaming User Profile.

Disk space reserved for network archive

Use this option to specify the maximum size of the directory containing the acoustic data (the .dra

and the log files) available to the Acoustic Optimizer. By default the archive size is 500 MB per

dictation source. To conserve space, you can reduce the default size and select the Conserve

archive size on network option.
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Creating a Roaming User Profile on
the local computer

There are two ways to create a Roaming User Profile:

n Train a new Roaming User Profile

n Convert a non-roaming local User Profile into a Roaming User Profile

To open or create a Roaming User Profile, your local installation of Dragon must be configured for

Roaming User Profiles. For more information, see Enabling the Roaming feature on each com-

puter where a user will dictate.

Notes
n If you use a variety of microphones or input devices with your Roaming User Profile, see the

topic: Using multiple dictation sources with a single user profile.

n If you modify a master Roaming User Profile while you have a local Roaming User Profile open

on a computer that is not currently connected to the network (for example, a laptop at a remote

location), the changes to the master Roaming User Profile will overwrite any changes you make

to the local Roaming User Profile when you synchronize the local and master Roaming User

Profiles.

n When a user that is using a Roaming User Profile exits Dragon, switches User Profiles, closes a

User Profile, or saves a User Profile, Dragon saves changes to the Local Roaming User Profile

and then synchronizes these changes with the Master Roaming User Profile on the network. For

more information, see How Dragon Synchronizes Master and Local Roaming User Profiles
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Creating and training a new Roaming
User Profile

To create and train a new Roaming User Profile:

1. To display the Open User Profile dialog box, select Profile > Open User Profile on the Drag-

onBar.

Note:When the Roaming feature is enabled, users can create only Roaming User Profiles. The

Location of user profiles field displays only the Roaming User Profile locations you defined in

the Administrative Settings dialog box. To let the users create both local (non-roaming) and

Roaming User Profiles, select the Allow non-Roaming User profiles to be opened option on

the Roaming tab of the Administrative Settings dialog box. Clearing this option prevents

User Profiles from dictating with a non-roaming local User Profile by accident. For more infor-

mation, see Enabling the Roaming feature on each computer where a user will dictate.

If you allow users to open both non-roaming local and Roaming User Profiles, be sure they

select the correct location from the Location of user profiles field.

If there are multiple roaming profile locations, make sure each user selects the correct location

from the Location of user profiles field.

2. Click New and begin training the User Profile as you would any other User Profile.

3. When you are finished training the User Profile, the program saves the User Profiles into the

master Roaming User Profile location specified in the Location of user profiles field.
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Converting a non-roaming local User
Profile into a Roaming User Profile

You can convert an existing non-roaming local user profile to a Roaming User Profile from the

Manage User Profiles dialog box. Converting a non-roaming local User Profile copies that user

profile to the Master Roaming User Profile location.

To convert a non-Roaming User Profile to a Roaming User Profile:

1. Select Profile >Manage User Profiles from the DragonBar. This action displays theMan-

ager User Profiles dialog box.

2. In the Location of user profile drop-down list at the bottom of the dialog box, select the non-

roaming local location of your User Profiles. Now the list under User Profiles should include

all the non-roaming local User Profiles that you can convert to Master Roaming User Profiles.

3. Select the non-roaming local User Profiles you want to convert to a Master Roaming User Pro-

file.

4. Click the Advanced button and then select Save to Roaming from the menu that pops up.

The Save to Roaming dialog box appears.

5. Under Select Roaming Master Location to save the user, select the appropriate Master

Roaming User Profile location from the drop-down list. In the Choose subdirectory if

wanted field, you can select a subdirectory within the Roaming Master location. When finished,

click OK. A Master Roaming User Profile location appears in this list only if it is currently avail-

able to the local computer.

6. Repeat the process for any other non-roaming local User Profiles you want to convert to Master

Roaming User Profiles.
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Dictating with a Roaming User Profile
You dictate with a Roaming User Profile the same way you would with any other User Profile. For

specific information about working with a Roaming User Profile, refer to the following topics:

n Opening a Roaming User Profile

n Using multiple dictation sources with a single user profile

n Running the Acoustic and Language Model Optimizer for Roaming User Profiles

n Synchronizing Master and Local Roaming User Profiles
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Opening a Roaming User Profile
When the Roaming feature is enabled, you can only open Roaming User Profiles (unless you set an

option allowing speakers to open both Roaming and Local User Profiles).

To open a Roaming User Profile:

1. On the DragonBar, select Profile > Open User Profile.

2. On the Open User Profile dialog box, select a User Profile from the list, and click Open.

If you do not see the User Profile you are looking for, press F5 to refresh the list of User Pro-

file.

Notes:
n If you allow users to select both non-roaming local and Roaming User Profiles , make

sure they select the correct location from the Location of user profiles drop-down

list.

n When the Roaming feature is enabled, you can only open Roaming User Profiles. The

Location of user profiles drop down list displays only the Roaming User Profile

locations you defined in the Administrative Settings dialog box. To let the users

open both local (non-roaming) and Roaming User Profiles, select the Allow non-

Roaming User profiles to be opened option in the Administrative Settings dialog

box. Clearing this option prevents users from dictating with a non-roaming local User

Profile by accident. For more information, see Enabling the Roaming feature on each

computer where a user will dictate.

n If you connect to your Roaming User Profile Master Directory over HTTP or HTTP

with SSL, and you find that the Open User Profile dialog box does not display all the

vocabularies and acoustic models for your User Profiles, make sure that:
n The .INI extensions is registered in MIME types (ini.png) list of your IIS

server.

Add all file extensions within your Master Roaming User Profile directories

and sub-directories to the Registered MIME types list of your IIS server.

You could also add a wildcard ( .*) MIME-type. For more information on

adding a wildcard ( .*) MIME-type, see:
http://www.microsoft.com/technet/prodtechnol/
WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-
83a2c180cd32.mspx?mfr=true

n The user's topics.ini and acoustics.ini files are not locked, password

protected, or otherwise access restricted by your server permissions.
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Using multiple dictation sources with
a single User Profile

It is possible to have a variety of dictation sources (audio input devices) for a single set of User

Profiles so that the speaker can deploy various microphones or portable recording devices. This

ability is especially useful with the Roaming feature. By allowing multiple dictation sources, you

can still have the same User Profiles for each location regardless of the microphone type.

To add a new dictation source to a user profile
1. In the Open User Profile dialog box, select the User Profile to dictate with the new dictation

source.

2. Click the Source button and then click New. The New Dictation Source dialog box appears.

3. Select a new input device for dictation from the list on the New Dictation Source dialog box.

You can choose from among different microphone or recorder types.

4. Click OK. You return to the Open User Profile dialog box.

5. Select the user profile you just created and click Open. If you have not previously trained the

user profile with the new dictation source, the Profile Creation wizard appears and you can

begin training.
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Running the Acoustic and Language
Model Optimizer for Roaming User
Profiles

When the Roaming feature is enabled on a workstation, that workstation cannot run the Acous-

tic and Language Model Optimizer or the Acoustic and Language Model Optimizer

Scheduler because the optimizer or scheduler can only be run on the Master Roaming User Pro-

file. Later, any optimizations done by the Acoustic and Language Model Optimizer are copied

to each Local Roaming User Profile when synchronization occurs.

The system administrator is responsible for running the Acoustic and Language Model Opti-

mizer on the network location of the Master Roaming User Profiles. The administrator can install

Dragon on the computer where the Master Roaming User Profiles are located or an administrator's

computer that has network access to the Master Roaming User Profiles and run the Scheduler for

the Acoustic and Language Model Optimizer. If possible, the administrator’s workstation

should be co-located with the server because a large amount of data needs to be transferred

between the server and the workstation running the optimizer.

Note: You must have Windows Administrator privileges on the computer where you are running

the Scheduler for the Acoustic and Language Model Optimizer.

Running the Acoustic and Language Model
Optimizer on a multi-core computer
If a Roaming User Profile is created and used on a multi-core computer with the Roaming feature

enabled, when an administrator runs the Acoustic and Language Model Optimizer on that profile

on a single-core computer, all accuracy improvements may not be applied to the profile. If an

administrator runs the Acoustic and Language Model Optimizer for a Roaming User Profile on a

single-core computer, when a user opens the profile on a multi-core computer, only the first acous-

tic model will load.

To make sure that corrections and accuracy improvements that users make are applied to their

Roaming User Profile, an administrator should run the Acoustic and Language Model Optimizer

on Roaming User Profiles only on a multi-core computer.

Running the Acoustic and Language Model
Optimizer on a User Profile with two acoustic
models
If the computer that a user dictates on meets certain system requirements, Dragon 11 , can use

two acoustic models (instead of one) with a User Profile. Using two acoustic models instead of
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one increases recognition and dictation accuracy. Acoustic models that can be added in pairs to a

User Profile are called Two-pass models.

See Using multiple acoustic models with a User Profile for more information.

To run the Acoustic and Language Model Optimizer
to optimize Roaming User Profiles
1. Be sure that a copy of Dragon is installed on the computer where you plan to run the Acoustic

and Language Model Optimizer. Also be sure that the Roaming feature is not enabled.

2. On the Windows Start menu, select Programs > Dragon NaturallySpeaking 11.0 >

Dragon NaturallySpeaking Tools > Scheduler for Acoustic and Language Model Opti-

mizer to start the Acoustic and Language Model Optimizer Scheduler.

3. Access the master directory of the Roaming User Profiles you want to optimize: select File >

Set Speaker Directory from the menu of the Acoustic and Language Model Optimizer

Scheduler window. In the Set User Profile Directory dialog box, either enter the path of the

directory or click the Browse button. If the User Profiles you want to optimize are located in

multiple directories, you can change directories to locate the additional User Profiles.

4. Select the User Profile(s) you want to optimize and set a schedule for running the Acoustic

and Language Model Optimizer. For specific instructions, click the Help button in the win-

dow.
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Controlling user access to other user's
profiles

If you have multiple Dragon users on an end-user workstation, those users will have multiple User

Profiles to choose from in Dragon's Open User Profile dialog box.

If you use a shared directory for User Profiles, whether they are roaming or non-roaming, you may

be concerned about the ability of a user to see and/or open another user’s file as well as their abil-

ity to open the correct file. There are several ways to address this concern:

n Many of Nuance’s customers address this concern simply through user training. Each user

should be aware that if they open another user’s file and try to use it, their accuracy will be poor

and user-specific customizations will not be available. Therefore, each user has an incentive to

use only their own file. However, this fact doesn't prevent a malicious user from damaging

another user’s file.

n If users always log into Windows with a unique Windows user ID, you can use Windows file

permissions to control access to the files. Typically, you do this by granting Full Control or

Read/Write/Modify access to the shared directory, but do not allow this permission to

propagate to sub-directories. That way, each user becomes the creator owner of any Dragon

User Profile that he or she creates. Users can still see all of the Dragon User Profiles in the

Open User Profile dialog box, but if they try to select another user’s profile a message will

appear saying that they do not have permission to access that profile. Apply similar file

permissions to the local copy of each Roaming User Profile; the default location for local copies

is under
C:\Documents and Settings\All
Users\ApplicationData\Nuance\NaturallySpeaking11\Roaming Users

n If users log in using a shared Windows user ID, the best way to control access is through HTTP

Roaming. In this configuration, you set up a web server running either IIS or Apache and with

the WebDAV file system enabled. On each workstation, you specify a URL on the web server

as the Roaming User Profile location. When a user launches Dragon, before displaying the Open

User Profile dialog it prompts for a user name and password, which it uses to authenticate

against the web server.

You can use file permissions on the web server to specify which User Profiles are accessible to

each account on the web server. File security is a function of the web server and the WebDAV

software.

Making it easier for users to select their User
Profiles
As described above, the Dragon Open User Profile dialog shows a list of all of the User Profiles in

a shared directory (unless you are using HTTP Roaming to limit access to User Profiles). If there

are more User Profiles than will fit on one screen, you can train users to go directly to a specific

User Profile by typing the first few letters of its name.
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In Dragon 11 , you can display and view groups of User Profiles in a tree-style structure. See

"Open User Profiles dialog box optimized for Roaming" in Dragon version 11 - What's New for

administrators for more information.

Notes: For use of WebDAV

n After you install Internet Information Services and WebDAV, you need to use the Internet

Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom

Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in

IIS 7:

n For more information, see Configuring Internet Information Services and WebDAV for HTTP

Roaming.

n If you connected to your Roaming User Profile Master Directory over HTTP and you find that

the Open User Profile dialog box does not display all the vocabularies and acoustic models for

your User Profiles, make sure that you:
l Add all file extensions within your Master Roaming User Profile directories and

sub-directories to the Registered MIME types list of your IIS server. You could

also add a wildcard ( .*) MIME-type. For more information on adding a wildcard

( .*) MIME-type, see
http://www.microsoft.com/technet/prodtechnol/
WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-

83a2c180cd32.mspx?mfr=true.
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l Check that no files in your User Profile directory are locked, password

protected, or otherwise access-restricted by your server permissions.
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Configuring Internet Information
Services and WebDAV for HTTP
Roaming

Here we discuss how to configure Internet Information Services (IIS) and Dragon Professional

and Medical to allow you to use WebDAV shares as http roaming users profile locations.

You must perform two steps to use IIS and WebDAV for Dragon HTTP Roaming:

1. Configuring Internet Information Services and WebDAV

2. Configuring Dragon internet roaming

242



Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles

Configuring Internet Information
Services and WebDAV

To run WebDAV, you must install Internet Information Services (IIS) version 6 or greater on a

server operating system such as Windows 2003 Server or Windows Server 2008.

In this section we discuss installing and configuring WebDAV on both IIS 6.0 and IIS 7.0.

Installing and configuring WebDAV on Internet
Information Services 6.0
Internet Information Services 6.0 - Install WebDAV

Perform the following steps after you install IIS 6.0

1. In Windows Server 2003, to install WebDAV on the IIS 6 server.

2. In Control Panel, open Add or Remove Programs .

3. Run the Windows Components Wizard.

4. Navigate to Application Server > Internet Information Services > World Wide Web Serv-

ice

5. In the World Wide Web Service, dialog box, select WebDAV Publishing.

6. Click OK.

7. In the Internet Information Services (IIS) Manager dialog box, select Web Service Exten-

sions.

8. Make sure the status for the WebDAV item is set to Allowed.

Internet Information Services 6.0 - Configuring WebDAV
1. Create a virtual directory that points to the Roaming User directory. For more information, see

http://msdn.microsoft.com/en-us/library/zwk103ab.aspx

2. Enable Basic Authentication for the Roaming User directory. For more information, see:
http://www.microsoft.com/technet/prodtechnol/
WindowsServer2003/Library/IIS/9b619620-4f88-488b-8243-
e6bc7caf61ad.mspx?mfr=true

3. Do not enter a value for default domain. In the Dragon Roaming configuration settings, when

you specify a username without specifying a domain or computer name, the domain of the com-

puter is used as the default domain.

4. For DNS, add the “wildcard MIME mapping" to the virtual directory. For instructions, see
http://support.microsoft.com/kb/326965

5. In the IIS Manager, select Default Web Site.

6. Double-click WebDAV Authoring Rules.

7. Select WebDAV Settings.

8. In the WebDAV Settings page, under Property Behavior,set the Allow Property Queries

with Infinite Depth property to True.
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9. Make sure that the files in your Roaming User Profile directory are not locked, password pro-

tected, or otherwise restricted for access by server permissions.

Installing and configuring WebDAV on Internet
Information Services 7.0
Internet Information Services 7.0 - Install WebDAV
1. Install WebDAV on the IIS 7 server. For more information, see

http://technet.microsoft.com/en-us/library/cc431377.aspx

Internet Information Services 7.0 - Configuring WebDAV
1. Create a virtual directory that points to the Roaming User directory. For more information, see

http://msdn.microsoft.com/en-us/library/bb763173.aspx

2. Enable Basic Authentication for the Roaming User directory. For more information, see:
http://technet.microsoft.com/en-us/library/cc733010(WS.10).aspx

3. In the IIS Manager, select Default Web Site in the left pane.

4. In the main view, double-click WebDAV Authoring Rules.

5. Select WebDAV Settings.

6. In the WebDAV Settings page, under Authoring Behavior, set the Allow Unknown MIME

Types property to True.

7. Under Property Behavior, set the Allow Custom Properties and Allow Property Queries

with Infinite Depth properties to True.
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8. Click Apply to save the changes.

9. Make sure that the files in your Roaming User Profile directory are not locked, password pro-

tected, or otherwise restricted for access by server permissions.
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Configuring Dragon internet roaming
Perform the following steps to configure Dragon internet roaming on all workstations.

1. Start Dragon.

2. Open the Administrative Settings dialog. On the Dragon Bar, select Tools > Administrative

Settings.

3. In the Roaming tab, select Enable.

4. Click the Add button to add a new network location.

5. Set the Display Name and the Network Location. The Roaming User Network Location dialog

box displays examples of what you can enter in the Address field.

l For HTTP locations, you can click the HTTP Settings button to set information specific

to your HTTP connection like Authentication, Firewall, and Proxy Server information.

Nuance strongly recommends that you test your connection to the HTTP server from the

HTTP Settings dialog box.
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Upgrading Roaming User
Profiles: Overview

This section describes how to upgrade Roaming User Profiles from Dragon NaturallySpeaking or

Dragon Medical 9.x or 10.x to Version 11.

Since the Local Roaming User Profile is a copy of a subset of the user data taken from the master

Roaming User Profile, an administrator cannot directly upgrade the Local Roaming User Profile

when they upgrade the local Dragon installation from Dragon 9.x or 10.x to Version 11.

See "Upgrading User Profiles to Dragon version 11 " in Dragon version 11 - What's New for

administrators for more information.

Notes:

n Upgrading a set of Dragon 9.x or 10.x master Roaming User Profiles to Dragon 11 leaves the

Dragon 9.x or 10.x master Roaming User Profiles unchanged. Leaving the Dragon 9.x or 10.x

files intact allows the users in the network to run Dragon 9.x or 10.x while the administrator

plans the upgrade.

n Plan to upgrade the master Roaming User Profiles at a time when User Profiles are not in use,

for example during the night or on a weekend.

n Even though the Dragon 11 User Profile Upgrade Wizard supports both mapped drives and UNC

paths, Nuance strongly recommends that administrators upgrade the Master Roaming User

Profiles on a drive on a computer where Dragon 11 is locally installed. Nuance does not

recommend that administrators upgrade the Master Roaming User Profiles across a network to

either a mapped drive or UNC path; upgrading over a network will take a undetermined length

of time. In addition, the User Profile Upgrade Wizard does not support upgrading User Profiles

over an HTTP connection.

n If upgrading from Dragon version 8.x or earlier to Dragon 11 , version 8.x or earlier custom

words and commands can be re-used in Dragon 11 :

1. In Dragon 8.x or earlier, export the custom words and commands

2. In Dragon 11 , create a new User Profile

3. In Dragon 11 , import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and

commands.

Step 1: Preparing to upgrade Roaming User Profiles
To upgrade Master Roaming User Profiles from a previous version of Dragon, Nuance rec-

ommends that an administrator install Dragon 11 directly on the network computer where the

Dragon 9.x or 10.x Master Roaming User Profiles are located and upgrade those Master Roaming

User Profiles directly to Dragon 11 Master Roaming User Profiles.

If an administrator is unable to install Dragon where the Dragon 9.x or 10.x Master Roaming User

Profiles are located, Nuance recommends that the administrator:

247



Dragon Administrator Guide version 11

n Install Dragon 11 on a separate computer where the administrator will perform the upgrades.

n Copy the Dragon 9.x or 10.x Master Roaming User Profiles from the network location to the

computer where Dragon 11 is installed.

n Upgrade the Dragon 9.x or 10.x Master Roaming User Profiles on the computer where Dragon

11 is installed.

n Copy the upgraded Dragon 11 Master Roaming User Profiles to a network accessible directory

on the original network location.

For more information, see Preparing to upgrade Roaming User Profiles.

Step 2: Upgrading the User Profiles
An administrator must separately upgrade the master Roaming User Profiles to Dragon 11 using

the User Profile Upgrade Wizard.

After an administrator upgrades the Dragon 9.x or 10.x Master Roaming User Profiles, they can

then proceed to upgrade end-user systems that deploy the Roaming feature.

For more information, see Upgrading master Roaming User Profiles

Step 3: Upgrade the end-user systems
After an administrator upgrades the master Roaming User Profiles, they can then proceed to

upgrade end-user systems that deploy the Roaming feature.

For more information, see Upgrading end-user systems.
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Chapter 7: Customizing and
optimizing Vocabularies

This section contains information on how you can add words to a vocabulary, train words in a vocab-
ulary, and optimize language models.

Customizing Vocabularies with the Dragon Vocabulary Tool (Voctool) 250

Voctool command line examples 263

Definition: The language model 265

About language model slots 266

Storing language model information 266
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Customizing Vocabularies with the
Dragon Vocabulary Tool (Voctool)

You use the Dragon Vocabulary Tool to customize a vocabulary by adding new words and by opti-

mizing the language model.

This section of the Administrator Guide Help describes the Vocabulary Tool Wizard and includes

the following topics:

n Starting Voctool — Starting the Voctool UI and command line.

n Step 1: Introduction— The type of information available that can be modified on the

introduction screen.

n Step 2: Choosing Documents — Selecting documents for the Vocabulary Tool to analyze.

n Step 3: Choosing Word Lists — Selecting word lists for analysis.

n Step 4: Analysis Settings — Specifying how the Dragon Vocabulary Tool analyzes the

documents and word list files you chose.

n Step 5: Analyzing Files — Confirming the file list; stopping and resuming the analysis.

n Step 6: Previewing New Words — Reviewing new words, their frequency, etc.; clearing,

editing, saving, and training words from the word list.

n Step 7: Training Added Words — Selecting the words to train.

n Step 8: Build the Language Model — Building a new language model with the information you

collect.

n Summary Page — Displaying information about the newly-built language model.

n Voctool command line switches — Listing command line switches.

Starting Voctool

There are two ways to start Voctool:

n Click Start > All Programs > Dragon NaturallySpeaking 11.0 > Dragon

NaturallySpeaking Tools > Voctool.

n You can run the Vocabulary Tool using MS-DOS commands. To view a list of command-line

switches for running the Vocabulary Tool, type voctool.exe /? at the prompt inside a

command-prompt window. See Voctool command line switches for a list of switches. By

default, voctool is located in:
C:\Program Files\Nuance\NaturallySpeaking11\Program

Notes

When you start the Vocabulary Tool, you use the Introduction page to select a User Profile and

vocabulary. Before you run the Vocabulary Tool, you can click the Change User/Vocabulary

button to change the user profile. If you try to change the user profile or vocabulary while the

Vocabulary Tool is running, the tool stops and discards any changes it made.
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Voctool: Introduction

You can use the Vocabulary Tool to customize a vocabulary by adding new words and opti-

mizing the language model.

You can use the Introduction page in the Vocabulary Tool to find and modify the following

information:

User

The name of the user profile that the Vocabulary Tool modifies.

Vocabulary

The vocabulary type you apply when you create a User Profile.

The Change User/Vocabulary button

You click this button to open the Select User dialog box and choose a different user profile from

a list of available user profiles.

Using the Introduction page to add words to a
vocabulary

1. Select one of the following two options to add new words to the vocabulary:

l Use the Add new words from documents and adapt to writing style option to instruct

the Vocabulary Tool to examine the documents you choose in the Choosing Documents

page. In general, you should select documents that reflect the preferred writing style and

vocabulary of the person that uses the modified User Profiles for dictation.

l Use the Add new words from word list files option to instruct the Vocabulary Tool to

examine the files you choose in the Choosing Word Lists page. When you choose this

option, the Vocabulary Tool only add words and does not analyze word frequency or other-

wise adapt the vocabulary to a particular writing style.

2. Click Next.

Notes

n If you plan to create a User Profile with an empty vocabulary, you must first run the Voctool on

the empty vocabulary, and specify the enrollment text you plan to use for the User Profile. For

more information, see "Customizing vocabularies with the Vocabulary Tool".

If you do not first run the Voctool, efenroll produces an error similar to the following:

"Unable to start enrollment. Error # 0x80004005

Error description : No results could be used for training"
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n Do not change the current user profile or the vocabulary when you run the Vocabulary Tool.

If you do try to change the user profile or vocabulary, the Vocabulary Tool stops running and

does not save any changes it made.

n You can use MS-DOS commands to run the Vocabulary Tool from a command line. To view

a list of command-line switches for the Vocabulary Tool, on a command line, type

voctool.exe /?.

Voctool:Choosing Documents

You use the Choose Documents page of the Vocabulary Tool to select documents for the

Vocabulary Tool to analyze. The Vocabulary Tool identifies words in a document that are not

in the current vocabulary. The tool analyzes the frequency and order of the words in the samples

to understand the writing style of the author of the document.

You can modify the list of documents that display on this page, then click Next to proceed with

the wizard.

The following information and buttons appear on this page:

The document list

The document list is a list of documents that the Vocabulary Tool will process. If no documents

appear in the list, click the Add Folder or Add Document button to find and add a folder or a

document. You can use the button to the right of the document list to add and remove doc-

uments or folders from the list.

The Add Folder button

You click the Add Folder button to open the Browse for Folder dialog box and select a folder

of documents to display in the documents list. You can click the Add Folder button as many

times as necessary to add additional folders of documents to the list.

The Add Document button

You click the Add Document button to open the Add Documents dialog box and select doc-

uments from a folder to display in the documents list. You can press the CTRL key and select

multiple documents at once. You can also press the SHIFT key and select a range of documents

by clicking the first and last documents in a range of documents. You can click the Add Doc-

uments button as many times as necessary to select different documents to add to the list.

The Remove Document button

You select documents and click the Remove Document button to remove documents from the

document list. You can press the CTRL key and select multiple documents at once. You can also

press the SHIFT key and select a range of documents by clicking the first and last documents in a

range of documents.
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The View Document button

You press the View Document button to view a document in its native application. For example,

if you select a document that has a .doc file extension, when you press the View Document but-

ton, Dragon starts Microsoft Word to display the document.

In order to view a document in its native application, the native application must be installed on

the same computer as Dragon.

The Save List button

You click the Save List button to open the Save Document List as File dialog box and save the

current list of documents as a .txt file in a folder. The text file contains the names of each file and

the full path to each file. The Vocabulary Tool can process the following types of files:

n Microsoft Word (*.DOC)

n Corel WordPerfect (*.WPD)

n ASCII Text (*.TXT)

n Rich Text Format (*.RTF)

n HyperText (*.HTM, *.HTML, *.SHTM, and *.SHTML)
If your computer does not have access to an application that can open a particular type of file, the

Vocabulary Tool will not be able to process the document.

The Load List button

You click the Load List button to open the Load Document List from File dialog box and load

a file that contains a list of documents. This is the file you create using the Save List button. If

you attempt to load a file that does not contain an appropriate file list, an error message displays

and the contents of the file do not appear in the document list.

Note: Only process documents that contain valid text and that reflect the writing style of the

user. Otherwise, the documents may damage the vocabulary or decrease the recognition accuracy

of Dragon by building a Language Model from examples that do not reflect the dictation style of

the user.

Voctool:Choosing Word Lists

You use the Choosing Word Lists page of the Vocabulary Tool to select word lists for the

Vocabulary Tool to analyze. The Vocabulary Tool can identify if a word is in the current vocab-

ulary.

A word list is an ASCII text document that contains words or shorts phrases to add to a vocab-

ulary. Each word or phrase should be on a separate line. You can use a backslash (\) to separate

the written form of a word from the spoken form of a word. For example: "& Co.\and Company"

The following information and buttons appear on this page:
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Word Lists

A list of files that contain the word lists that the Vocabulary Tool can process. You can use the

buttons on the right of the word lists to add or remove files from the list. You can select Export

custom word and phrase list on the Vocabulary menu of the DragonBar to create a word list

file from a current Dragon User Profile.

The Add Word List button

You click the Add Word button to open the Add Word List Files dialog box and to select file

names to display in the documents list. You can press the CTRL key and select multiple files at

once. You can also press the SHIFT key and select a range of files by clicking the first and last

files in a range of files. You can click the Add Word List button as many times as necessary to

select different folders that contain files to add to the document list.

The Remove Word List button

You click the Remove Word List button to remove a file or set of files from the documents list.

You can press the CTRL key and select multiple documents at once. You can also press the

SHIFT key and select a range of files by clicking the first and last files in a range of files.

Note: Only process documents that contain valid text and that reflect the writing style of the

user. Otherwise, the documents may damage the vocabulary or decrease the recognition accuracy

of Dragon by building a Language Model from examples that do not reflect the dictation style of

the user.

Voctool:Analysis Settings

You use the Analyze Settings page in the Vocabulary Tool to configure how the Vocabulary

Tool analyzes documents and word list files. You use the Choosing Documents page or the Choos-

ing Word Lists page in the Vocabulary Tool to select documents and word list files.

You can change the following settings:

The Vocabulary Tool: Find unknown words

You use the Find unknown words option to have the Vocabulary Tool find words that are not

already in the vocabulary. This option is only available if the Vocabulary Tool is analyzing doc-

uments and not word lists.
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The Vocabulary Tool: Find known words with unknown
capitalization

You use the Find known words with unknown capitalization option to have the Vocabulary

Tool find words that are in the vocabulary but with a different capitalization. Only use the Find

known words with unknown capitalization option with word lists that you want to add to a

vocabulary. Otherwise, you might add words to a vocabulary unintentionally.

The Vocabulary Tool: Enable word frequency counting

The Enable word frequency counting option only displays when you select Add new words

from documents.

You use the Enable word frequency counting option to let Dragon count how many times a

new word appears in your documents and display that number in the Vocabulary Tool after

Dragon analyzes the documents. Dragon counts up to 100 occurrences of a word.

Note: If you are analyzing a large set of text, you should disable frequency counting to improve

performance.

The Vocabulary Tool: Preview the list of unknown
words

You use the Preview the list of unknown words option to make the Vocabulary Tool open the

Preview New Words page and display unknown words and known words with unique cap-

italization. A Preview NewWords page appears where you can modify the list and select specific

words that the Vocabulary Tool found.

The Vocabulary Tool: Add all unknown words without
previewing them

You use the Add all unknown words without previewing them option to have the Vocab-

ulary Tool skip the Preview NewWords page. The Vocabulary Tool then adds all the

unknown words and the known words with unique capitalization to the vocabulary without letting

you modify the list.

Voctool: Analyzing Files

You use the Analyzing Files page of the Vocabulary Tool to analyze the documents and word

list files you choose in the Choosing Documents page or the Choosing Word Lists page.

The Analyzing Files page contains the following information and controls:
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The File list

The file list is a scrollable list that displays the files or documents that the Vocabulary Tool is

processing.

n A check mark next to a file name indicates that the Vocabulary Tool successfully analyzed the

file.

n An X mark next to a file name indicates that the Vocabulary Tool did not successfully

complete its analysis of a file. The Vocabulary Tool may not complete its analysis of a file if a

user presses the Stop button or if an error occurs while the tool is reading the contents of a file.

n An hourglass symbol next to a file name indicates that the Vocabulary Tool is currently

analyzing the file.

When the Vocabulary Tool finishes analyzing all the files in the file list, a message displays

below the file list with information about the number of documents the Vocabulary Tool

analyzed.

The Stop button and the Resume button

You click Stop to stop the Vocabulary Tool from processing a file.

You click Resume to have the Vocabulary Tool restart the analysis of a file.

The Progress bar

During the Vocabulary Tool’s analysis of a file, the Progress bar displays how much of the file

has been analyzed.

Voctool: Preview New Words

You can use the Preview NewWords page of the Vocabulary Tool to view the list of words

that the Vocabulary Tool identifies as either not in the current vocabulary or as having a unique

capitalization.

The following information and buttons appear on this page:

Word

You can scroll the Word list and use the check box to the left of a word to tell the Vocabulary

Tool to add or not add the word to the vocabulary. Check this option to add a word to a vocab-

ulary. Uncheck this option to not add a word to a vocabulary.
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Frequency

Frequency indicates how many times a word appears in the documents the Vocabulary Tool

analyzes. This information appears only if you select the Enable word frequency counting

option on the Introduction page of the Vocabulary Tool. Dragon counts up to 100 occurrences

of a word.

Check All

Click the Check All button to check all the words in the Word list.

Clear All

Click the Clear All button to clear all the words in the Word list.

Edit

You can select a word in the list and click the Edit button to open the Edit Word dialog box and

change the written form and spoken form of a word. The Edit Word dialog box also displays the

context and frequency with which the word appears in the document the Vocabulary Tool

analyzes.

Save

You can click the Save button to open the Windows Save As dialog box and save the contents of

the Word list as a file. Use the dialog box to provide a name and a location for the file. You can

use this file with the Vocabulary Tool at a later time to modify the vocabulary of other User Pro-

files.

Train added words

You can select the Train added words option to open the Training Added Words page of the

Vocabulary Tool and train selected words and fine tune Dragon's recognition of your pro-

nunciation.

The Train added words feature is only available when you run the Vocabulary Tool as part of a

normal installation of Dragon. You cannot use the Vocabulary Tool to train words if you are run-

ning the DSS SDK edition of Dragon.

Voctool: Training Added Words

You can use the Training Added Words page of the Vocabulary Tool wizard to train Dragon to

better recognize your pronunciation.
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This feature is available only when you run the Vocabulary Tool as part of a normal installation of Dragon.

You cannot use the Vocabulary Tool to train words if you are running the Dragon SDK Server Edition

(DSS) .

The following information and buttons appear on this screen:

Word

The Word list contains the words you selected on the Preview New Words screen. Select the

words you want to train from this list. A check mark in the box to the left of the word indicates

that you want to train that word.

Check All

Click the Check All button to select all the words in the Word list.

Clear All

Click the Clear All button to deselect all the words in the Word list.

Train

You can click the Train button to open the Train dialog box where you can train Dragon to rec-

ognize your pronunciation of the words you selected. If you have selected more than one word to

train, the Train dialog box display the words in the order that they appear in the list.

NOTE

Only the person that will dictate with the User Profile you are modifying can perform the training.

If that person is unavailable for this Vocabulary Tool session, then training can also occur during

a Dragon session. See "Training individual words and phrases" in the Dragon Help for more infor-

mation.

Voctool: Language Model Build Settings

You can use the Language Model Build Settings page of the Vocabulary Tool wizard to build

a new language model with the information the tool gathers. You also use this page to provide

Dragon with the location and maximum size of the new vocabulary.

The following settings appear on this page:

Build language model

You can use the Build language model option to have the Vocabulary Tool build a new lan-

guage model that contains the words and other information you provide to the tool in other pages

of the Vocabulary Tool.

258



Chapter 7: Customizing and optimizing Vocabularies

Language Model locator

If you are building a language model for a Solution Series version of Dragon, you can select either

the Middle or the User slot as a location for a language model. If you are building a language model

for the Preferred edition of Dragon, select the User slot as the location of the language model.

Language model size limit (Solution Series or SDK
Server Edition only)

If you build the Language Model into theMiddle slot, you can use the Language model size

limit list to limit the size of the model. You can specify a size limit between 0.5 MB and 5 MB. If

you do not want to set a limit, select Unspecified from the list.

Existing Model built by:

You can use the Existing Model built by option to specify the version of the Vocabulary

Builder that created the previous Language Model. This information only appears if the user pro-

file you are building a language model for has an existing language model.

Preserve existing model

This option only appears if the user profile you are building a language model for has an existing

language model. Selecting Yes merges the new language model with the current one. Selecting

No builds a new language model to replace the existing one. Normally, you should accept the rec-

ommended value, which can vary depending on the location of the language model and the ver-

sion of Dragon. The recommendations for the Solution Series and Preferred editions of Dragon are:

n For Dragon NaturallySpeaking Solution Series, middle slot, the recommendation is No.

n For Dragon NaturallySpeaking Solution Series, user slot, the recommendation is Yes.

n For Dragon NaturallySpeaking Preferred, user slot, the recommendation is Yes.

You cannot build a language model in the middle slot of Dragon NaturallySpeaking Preferred edition.

Voctool: Summary page

The Summary page of the Vocabulary Tool wizard displays information about the newly built

language model. After you review the information on this page, click Finish to exit the wizard.

The following information appears on this page:

Details

The details box contains the following information:
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User

The name of the User Profile the Vocabulary Tool modifies.

Vocabulary

The base vocabulary type of the User Profile.

Language

The language of the vocabulary, including any specific variation of that language, such as United

States English.

Additional information

The following information may also appear:

n The number of documents the Vocabulary Tool analyzed.

n The names of the documents or word lists that the Vocabulary Tool processed.

n The number of unknown words that the Vocabulary Tool found.

n The number of words the Vocabulary Tool added.

n Whether the Vocabulary Tool saved the previous language model or built a new language

model, and if it did, which language model location was used.

n Any warnings or any non-critical errors that might have occurred during processing

Save speech files

You can select the Save speech files option to save the new User Profile and make it available

for future Dragon sessions.

Voctool command line switches

When you start the Voctool from the command line, you must first switch to the follow directory:

C:\Program Files\Nuance\NaturallySpeaking11\Program

Then type the following syntax:

voctool.exe switches

where switches is one or more (or a combination of) the following:

Switch Required with /S Purpose

/S NA Silent mode - do not display a GUI and do
not display messages on the screen when you
run voctool.

/U <user> Yes. User name - indicate the user profile whose
vocabulary you are running the voctool on.

voctool requires that you use this switch
when you use /S.

/V <vocabulary> Yes, for an existing vocab- Vocabulary name - voctool requires that you
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Switch Required with /S Purpose

ulary. use this switch if the vocabulary exists; other-

wise use /VN to create a new vocabulary.

/VN <vocabulary> Yes, if vocabulary does not

yet exist.

Create a new vocabulary if one doesn't exist
for this user profile. voctool uses the empty
new vocabulary as the base vocabulary.

Use this switch if the vocabulary does not yet
exist; otherwise, if the vocabulary exists, use
/V to use the current vocabulary name.

If you are using a version of Dragon that does
not have base vocabularies, you must include
/VB to indicate the base vocabulary alongside
/VN.

/VB <base vocabulary>  No. Use in conjunction with /VN to indicate the

name of the base vocabulary.

<doc file> Yes, either this doc, /WI

with a word list, or /WLI

with a list of word lists.

Input document.

/DI <doc list file> No. A list of input documents - a list of documents

to retrieve words from for the vocabulary.

/DO <doc list file> No. A list of output documents - a list of doc-

uments to export words from the vocabulary to.

/WI <word list file> Yes, either this option, <doc

file>, or /WLI with a list of

word lists.

An input predefined word list.

/WLI <wordlists list

file>

Yes, either this option, <doc

file>, or /WI with a list of

words.

An input file that lists predefined word lists.

/WO <word list file> No. An output list of added /new words in the

vocabulary to the file indicated.

/WLO <word list file> No. Output list of added words from both prede-

fined word lists and documents along with

word frequency.

/AW[C][<n>] No. Add unknown words to a vocabulary:

C=add known words with unknown cap-
italization.

n=the minimum number of times that a word
must appear in a document. If a word appears
the minimum number of times, add the word to
the vocabulary.

/LM- No. Do not build language model - include the

minus sign at the end of /LM.

/LM[M|U][N|I] No. The Build language model:

261



Dragon Administrator Guide version 11

Switch Required with /S Purpose

M=Middle Slot* (default)

U=User Slot*

N=Non-incremental (default)

I=Incremental

/LMSIZE <size> No. The size of the Middle Slot language model -

one of (0.5, 1, 2, 3[default], 4, or 5).*

/NS No. Do not save changes to the vocabulary. Applies

only in Silent mode.

/Summary <file> No. Write summary of session actions to a file.

/? No. Displays this list of options.

*For more information on language model slots, see Storing language model information.

To see some examples of running voctool.exe on the command line, see Voctool command line

examples.
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Voctool command line examples
The following are examples of how to use the Voctool from the command line:

Example 1

To use Voctool to add a set of new words to the General vocabulary of a user profile named Katar-

ina Phelps, you would first copy the file that contains the words (NewWords.txt) to the Program
Files\Nuance\NaturallySpeaking11\Program directory, then type the following on the com-
mand line:

voctool.exe /S /U "Katarina Phelps" /V "General - Large" /WI NewWords.txt
/AW /Summary voc_actions.txt

The /AW option is required to add the new "unknown" words to the vocabulary.

The voc_actions.txt file contains a summary of the actions that Voctool performs.

Dragon Vocabulary Tool Version x.xx

User:______________Katarina Phelps
Vocabulary:________General - Large
Language:__________0x409 - English (United States)

Processed 1 word list file(s):
________NewWords.txt

7 unknown word(s) found.
7 word(s) added.

Language model was not built.
No errors occurred.
No warnings occurred.

Example 2

In this example, we perform all of the actions from Example 1 and also build the language model

using the new words. On the command line, we include the /LM option to build the language

model. To have Voctool store the language model in the Middle slot, you would addM after

/LM; to store the language model in the User slot, you would add U after /LM.

You can instruct Voctool to have the language model include all previous changes (called non-

incremental) by adding anN after /LM or have the language model include only the most recent

changes (called incremental) by adding an I after /LM.

If you include /LM on the command line and do not specify a particular slot to build the language

model in or do not specify the type of build to do, Voctool builds the language model non-incre-

mentally and stores it in the Middle slot.

To build the language model in an incremental fashion and store it in the User slot, type the fol-

lowing on the command line:

voctool.exe /S /U "Katarina Phelps" /V "General - Large" /WI NewWords.txt
/AW /LM U I /Summary voc_actions.txt
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Example 3

To use Voctool to add a list of drug names to the vocabulary of a medical provider named Jackson

Stone, you would first copy the file that contains the drug names (DrugNames.txt) to the Pro-

gram Files\Nuance\NaturallySpeaking11\Program directory, then type the following on

the command line:

voctool.exe /S /U "Jackson Stone" /V "Internal Medicine - Large"
/WI DrugNames.txt /AW /Summary actions.txt

Be sure to use the full name of the vocabulary, including "- Large" in this case.

The actions.txt file contains a summary of the actions that Voctool performs:

Dragon Vocabulary Tool Version x.xx

User:______________Jackson Stone
Vocabulary:________Internal Medicine - Large
Language:__________0x409 - English (United States)

Processed 1 word list file(s):
________DrugNames.txt

7 unknown word(s) found.
7 word(s) added.

Language model was not built.
No errors occurred.
No warnings occurred.

264



Chapter 7: Customizing and optimizing Vocabularies

Definition: The language model
In addition to a word list, a vocabulary has a language model that contains statistical information.

The statistics help predict which words are most likely to occur in the context of a user's speech.

This information includes:

n unigram probability: The likelihood that a word occurs in text compared to other words in the

same vocabulary. For example, if the verb write is more likely to occur in text compared with

the name Wright, then write will have a higher unigram probability.

n bigram and trigram probabilities: The likelihood that a two-word or three-word sequence occurs

in text. For example, if the bigramMr. Wright is more likely thanMr. write, then the language

model should favorMr. Wright even though write has a higher unigram probability than

Wright. In this context the bigram/trigram probability outweighs the unigram probability.
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About language model slots
A vocabulary includes three slots for storing language model information. Not all vocabularies con-

tain information in each slot.

n base slot - Stores the base language model that ships with Dragon. You cannot modify the

information in the base slot.

n middle slot - Can contain a custom language model based on a significant amount of data,

developed for a target group of users. The only way to modify the middle slot is by using the

Vocabulary Tool.

n user slot - Can contain a language model based on a relatively small amount of data for use by at

most a few users. Individual users can modify the user slot using the Vocabulary Builder feature

of Dragon. You can also modify the user slot using the Vocabulary Tool.

Storing language model information
A vocabulary stores language model information in three slots. Not every vocabulary contains

information in each slot.

Slot Description

base Stores the base language model that ships with Dragon. You cannot mod-
ify the information in the base slot.

middle Can contain a custom language model based on a significant amount of
data, developed for a target group of users. The only way you can modify
the custom slot is by using the Vocabulary Tool.

user Can contain a language model based on a relatively small amount of data
for use by at most a few users. Individual users can modify the user slot
using the Vocabulary Builder feature of Dragon. You can also modify
the user slot using the Vocabulary Tool.

In the Professional editions of Dragon NaturallySpeaking, you can use vocabularies with a middle

slot language model that you modify with the Vocabulary Tool.

In the SDK Client and SDK Server editions of Dragon, you can use the Vocabulary Tool to mod-

ify middle slot language models.
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This section contains information on how you can add or remove the custom words, vocabularies, and
commands for a User Profile.
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The Nsadmin utility for new words, vocabularies, and commands 276

Using paths with the nsadmin utility 284
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Adding words, commands, or
vocabularies to User Profiles

You use the nsadmin utility or the Data Distribution Tool to make new words, customized

vocabularies, or new commands available to all User Profiles on a particular installation of Dragon.

Both the nsadmin utility and Data Distribution Tool can work across a network. Dragon Med-

ical Small Practice Edition does not support the nsadmin utility or the Data Distribution Tool.

The nsadmin utility lets you use the command line to make new words, commands, and vocab-

ularies available to users. The nsadmin utility can perform only one action at a time. However,

you can create a batch file or script that can perform multiple nsadmin operations on a computer.

The Data Distribution Tool lets you use a GUI to interact with the nsadmin utility and make

new words, commands, and vocabularies available to users.

Note: You can use the Voctool to customize a vocabulary by adding new words or optimizing the

language model for a particular User Profile. For more information, see the Voctool Help.

Using the Data Distribution Tool
With the Dragon Professional, Legal, and Medical editions, you can use the Data Distribution

Tool to interactively make new words, customized vocabularies, or custom commands available

to all users on a particular installation of Dragon.

You run the Data Distribution Tool on each installation of Dragon where you want the new

words or vocabularies to be available to Dragon users.

This section describes:

n Creating the Data Distribution Directory

n Starting the Data Distribution Tool

n Adding and removing custom words

n Adding and removing custom vocabularies

n Adding and removing custom commands

You can also run the nsadmin utility from the command line. For more information, see The

Nsadmin utility for new words, vocabularies, and commands.
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Creating the Data Distribution
Directory

You create a data distribution directory to store word lists, commands, or both, that you plan to

distribute to multiple users of Dragon NaturallySpeaking or Dragon Medical.

When word lists and commands are in the data distribution directory, as soon as a person opens

their User Profiles, Dragon automatically imports words and commands from the data distribution

directory into the User Profiles. This occurs regardless of the location of the computer the user

dictates on.

You can use the Data Distribution Tool to put words and commands into a data distribution

directory. For more information, see Starting the Data Distribution Tool.

Note: In Windows XP, the default installation of Dragon places custom words for existing Dragon

User Profiles in:
C:\Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-

urallySpeaking11\custom.

See Dragon file structure for information on default locations on Windows Vista and Windows 7.

Create a data distribution directory in a location other
than the default location

Repeat the following steps for each workstation that should share the distributed words or com-

mands.

1. In Dragon, close all open User Profiles.

2. On the network, create a directory and give all users that dictate with Dragon access to the direc-

tory. Grant read access to providers that dictate. Grant write access only to administrators.

3. If Dragon is running, on the DragonBar, select Tools > Administrative Settings. When the

Administrative Settings dialog box opens, proceed to Step 6.

4. If Dragon is not running, select Start > Run. When the Run dialog box opens, in the Open

text box, type the following, making sure to put a space between natspeak.exe and the /Se-

tDefaultAdministrativeOptions option:
C:\Program Files\Nuance\NaturallySpeaking11\Program\natspeak.exe” /Se-

tDefaultAdministrativeOptions

(The quotation marks are required because Program Files contains a space. Your path might

not require quotation marks.)

5. Click OK.

6. When the Administrative Settings dialog box opens, if the User Profile opens automatically,

click Cancel to close the User Profile or go to the DragonBar and select Profile > Close

User Profile.

7. Click theMiscellaneous tab.
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8. In the Data distribution location text box, click Change... and browse to a location where

you want Dragon to store custom words and commands.

9. Click OK.

10. Click Apply to save the changes.

11. Click OK to close the dialog box.

You can now use the Data Distribution Tool or the nsadmin command line utility to put new

words and commands into the data distribution directory. For more information, see Starting the

Data Distribution Tool or Starting the nsadmin command line utility.

Starting the Data Distribution Tool

You can use the Data Distribution Tool to make new words, customized vocabularies, or new

commands available to all Dragon users on a particular installation of Dragon.

You can run the Data Distribution Tool on a local computer or through a network connection.

The tool supports both mapped drives and UNC paths.

Before you use the Data Distribution Tool, you must create a data distribution directory. For

more information, see Creating the Data Distribution Directory.

Start the Data Distribution Tool

A default installation of Dragon stores custom commands for Dragon User Profiles in:

n Windows XP:
\Documents and Settings\All Users\Application Data\Nuance\Dragon

NaturallySpeaking11\Custom\<language>.

n Windows Vista and Windows 7:
\ProgramData\Nuance\NaturallySpeaking11
\Data\enx\Custom\<language>

1. Select Start > All Programs > Dragon NaturallySpeaking 11.0 > Dragon Nat-

urallySpeaking Tools > Data Distribution Tool.

Dragon displays the first page of the Data Distribution wizard.

2. Select one of the following options:

l Add or remove base vocabularies

l Add or remove shared commands

l Add or remove word to share across vocabularies

3. Click Next.

4. Click the Advanced button to set the location where the local installation of Dragon stores cus-

tomized words and commands.
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Adding and removing custom words

You can use the Data Distribution Tool to make new words available to all users on a particular

installation of Dragon.

Before you use the Data Distribution Tool, you must create a data distribution directory. For

more information, see Creating the Data Distribution Directory.

You must first either create a text file or export words from an existing user's installation of Dragon

before you can distribute the words (for example, a list of new drug names) to a different instal-

lation of Dragon.

After you use the nsadmin utility to import the custom words, you must close your User Pro-

files, re-open the User Profiles, and save them for the changes to become available.

Create a text file that contains custom words

Perform one of the following two actions before you distribute a set of custom words to a par-

ticular installation of Dragon:

Create a text file that contains custom words
1. Create a text file.

2. In the text file, add each word or phrase that you want to add to the vocabulary. Make sure each

word or phrase uses correct spelling and is a on a separate line.

l To add a multiple-word phrase, such as "Mayberry Tribune", type it on one line.

l To include a spoken form of a word, type the word followed by a backslash (\) and the

spoken form of a word. For example, to have Dragon enter "Robert F. Kennedy"when you

say "RFK", type Robert F. Kennedy\RFK in the text file.

Create a text file that contains custom words
1. If you have Dragon available on another computer, you can use it to create custom words and

export the words to a .txt file. For more information, see the main Dragon Help file.

Add custom words to a shared location

When you use nsadmin, you can enter paths as complete local paths, relative paths, mapped net-

work drives, a UNC path, or the path to removable media such as a CD-ROM or ZIP drive. For

more information, see Using paths with nsadmin.

You must create a .txt file (newwords.txt in the following examples) that contains custom words

before you perform the following steps. For more information, see "Create a text file that contains

custom words" above.

1. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory.

2. On each computer that a user uses for dictation, map a network drive to the location of the data

distribution directory. As an alternative, you may reference the network UNC address of the

location of the nsadmin utility.
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3. Start the Data Distribution Tool. For more information, see Starting the Data Distribution

Tool.

4. In the Data Distribution Tool, make the appropriate selections to add the list of words to the

data distribution directory. For more information, see Use the Data Distribution Tool to add

custom words.

Use the Data Distribution Tool to add custom words

If you add custom words to a Commands Only vocabulary, when you upgrade a User Profile,

the upgrade process does not retain the custom words. In general, you should not add custom

words to a Commands Only vocabulary.

1. On the Data Distribution Tool, select Add or remove words to share across vocabularies.

2. (optional) To choose a location for the custom words on the local computer, click Advanced.

In the Custom directory text box of the Advanced Settings dialog box, type the path to the

new location for the custom words. If you do not take this step, Dragon copies the files to the

following default location (in Windows XP):
\Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-

urallySpeaking11\Custom\enx

See Dragon file structure for information on default locations on Windows Vista and other oper-

ating systems.

3. Click Next.

4. Associate a language with the custom words.

5. Click Next.

6. When the list of files appears, use the Import button to select the .txt files that contain custom

words. To view the content of a file, select the file and click View. To remove a file from the

list of files, select the file and click Remove. To remove all files from the list, click Remove

All.

Note: Once you add a text file that contains custom words to the data distribution directory,

and a user opens the profile, you cannot use the Remove and Remove All buttons to remove

the custom words.

7. Click Next. The Data Distribution Tool displays a log of the operations it performs.

8. Click Finish to re-display the first page of the Data Distribution Tool or click Cancel to exit.

Adding and removing custom vocabularies

You can use the Data Distribution Tool to make a customized vocabulary available to all users

on a particular installation of Dragon. For example, you can use the Data Distribution Tool to

copy a user profile's vocabulary and set it as the base vocabulary on any installation of Dragon.

After you add a base vocabulary to an installation of Dragon, new User Profiles you create can use

that vocabulary.
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Notes
n The default installation of Dragon places vocabularies for existing Dragon User Profiles here (in

Windows XP). See Dragon file structure for information on Windows Vista and other operating

systems.
\Documents and Settings\All Users\Application

Data\Nuance\NaturallySpeaking11\users\<user_name>\current

n Vocabulary files end with the *.voc extension.

n If you create a User Profile on a dual core computer that uses a custom vocabulary, make sure

that the User Profile uses the BestMatch IV speech model (BestMatch IV has the greatest

recognition accuracy on dual-core systems with more than 2 GB of RAM). To check this, select

the Advance button on the Create User Profile screen of the Creating a Profile wizard and make

sure that BestMatch IV is selected.

Prepare to use the Data Distribution Tool to add a
vocabulary

1. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory.

2. On each computer that a user uses for dictation, map a network drive to the network location of

the data distribution directory.

3. Start the Data Distribution Tool. For more information, see Starting the Data Distribution

Tool.

4. In the Data Distribution Tool, add the vocabulary to the data distribution directory. For more

information, see "Use the Data Distribution Tool to add a vocabulary" below.

Use the Data Distribution Tool to add a vocabulary

1. In the Data Distribution Tool, select Add or remove base vocabulary.

2. Click Next.

3. Click Add to add a Base Vocabulary. Dragon displays the Add Base Vocabulary dialog.

4. In the Add Base Vocabulary dialog box:
n Give the vocabulary a name. The name should describe the content of the

vocabulary, such as Astronomy orMarketing.

n Select the location of the vocabulary, either a mapped drive or a UNC address.

n Give the vocabulary an unique numeric ID. Use a value greater than 9000 for the

topic ID parameter.

5. Click OK.

The next time you open a User Profile, Dragon automatically updates the user profile's vocabulary.
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Use the Data Distribution Tool to add an exported
vocabulary

You can use the Data Distribution Tool to distribute a vocabulary that you create using a sep-

arate installation of Dragon. A Dragon vocabulary that you export saves as a group of files.

One of the exported files has a .top file extension, the other files have .to* file extensions, where

* is an integer.

1. In a command prompt, provide the path to the file with the .top file extension as an argument

to the nsadmin utility. Do NOT include the .top file extension on the command line.

The following command adds the myvoc exported topic (myvoc.top) as a new base vocabulary:

<PATH>\nsadmin /vocabulary D:\MyDocuments\myvoc "US English | Large |
Nuance" 9005

Use the Data Distribution Tool to remove a base
vocabulary

1. In the Data Distribution Tool, select Add or remove base vocabulary.

2. Click Next. Dragon displays the existing base vocabularies by ID and username.

3. Select the vocabulary to delete.

4. Click Remove and then click Next. The Data Distribution Tool displays a message when the

vocabulary is deleted.

5. Click Finish to close the Data Distribution Tool or click your browser's back button to re-dis-

play the screen.

Adding and removing custom commands

Custom commands are voice commands that you can create and modify to enter text, insert graph-

ics, or activate menus and keystrokes in any application. You can use theMyCommands Editor

to create custom commands or the Command Browser to modify custom commands. 

You can use the Data Distribution Tool to copy a set of custom commands to the data dis-

tribution directory and make the set of custom commands available to all users at a particular instal-

lation of Dragon.

Before you use the Data Distribution Tool, you must have already created a data distribution

directory, as explained in Creating the Data Distribution Directory.

Notes:

n The default installation of Dragon places custom commands for existing Dragon User Profiles

here (in Windows XP). See Dragon file structure for information on Windows Vista and other
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operating systems.
\Documents and Settings\All Users\Application

Data\Nuance\NaturallySpeaking11\Custom\<language>

n After you import the custom commands to Dragon, for the changes to become available to those

User Profiles, you must close your User Profiles, then re-open and save the User Profiles.

n You can enter a path as a complete local path, a relative path, a mapped network drive, a UNC

path, or the path to removable media, such as a DVD, CD, or ZIP drive. For more information,

see Using paths with nsadmin.

Prepare to use the Data Distribution Tool to export
custom commands

1. In Dragon, create custom commands.

2. Use the Command Browser to export the custom commands to a .dat file, for example, New-

Commands.dat.

3. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory.

4. On each computer that a user uses for dictation, use the Data Distribution Tool to add the

.dat file to the data distribution directory. For more information, see Adding custom

commands.

Use the Data Distribution Tool to add custom
commands

1. Start the Data Distribution Tool. For more information, see Starting the Data Distribution

Tool.

2. In the Data Distribution Tool, select Add or remove shared commands .

3. Click Next.

4. Select the languages for the User Profiles that you will add custom words to.

5. Click Next.

6. Use the Import button to select the .dat files that contain the custom commands to add. Place

the .dat files into the New shared commands list in the upper half of the dialog box. You can

modify the list by selecting particular file names and using the Remove and Remove All but-

tons.

7. Click Next. The Data Distribution Tool displays a log of all the operations it performs.

8. Click Finish to re-display the Data Distribution Tool main screen or click Cancel to exit.

The next time you open a User Profile, Dragon updates the commands in the associated User

Profiles. 
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Use the Data Distribution Tool to remove shared
commands

1. In the Data Distribution Tool, select Add or remove shared commands.

2. Click Next.

3. Select the languages for the User Profiles that you will remove words from.

4. Click Next.

5. In the Existing shared commands list, select the command.

6. Click Remove.

7. Click Next. The Data Distribution Tool displays a log of all operations it performs.

8. Click Finish to re-display the Data Distribution Tool main screen or click Cancel to exit.

The Nsadmin utility for new
words, vocabularies, and
commands

Dragon Professional, Dragon Legal, and Dragon Medical include the nsadmin utility. The nsadmin

utility is a command line utility that lets you make new words, customized vocabularies, and new

commands available to all users on a particular installation of Dragon.

The nsadmin utility performs only one operation at a time. You can write a batch file or script to

execute multiple nsadmin operations on each computer.

For step-by-step instructions on using the nsadmin utility, see the following topics:

n Creating the Data Distribution Directory

n Starting the nsadmin command line utility

n Adding custom words from a command line

n Adding and removing custom vocabularies from a command line

n Adding custom commands from a command line

You can use the Data Distribution Tool to run the nsadmin utility from a GUI. For more infor-

mation, see Starting the Data Distribution Tool.
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Starting the nsadmin command line utility

You can use the nsadmin utility on a command line to make new words, vocabularies, or com-

mands available to users.

The nsadmin utility performs only one operation at a time. However, you can write a batch file

or script to execute multiple nsadmin operations on a computer. You can place the network loca-

tion of new words or vocabularies in a script and run the script from a client computer to copy the

new functionality to the computer.

You can find the nsadmin.exe file in the \Program directory under the parent Dragon instal-

lation directory. The default installation directory for Dragon is

C:\Program Files\Nuance\NaturallySpeaking11\Program.

The nsadmin utility supports both mapped drives and UNC paths. For more information, see

Using paths with nsadmin.

Before you can use the nsadmin utility, you must create a data distribution directory. For more

information, see Creating the Data Distribution Directory.

Start the nsadmin utility

1. Select Start > All Programs > Dragon NaturallySpeaking 11.0 > Dragon Nat-

urallySpeaking Tools > NSAdmin

The nsadmin utility starts in a DOS window and lists the nsadmin syntax.

Display help information for the nsadmin utility

1. From a command prompt, type nsadmin/?

Command line syntax for the nsadmin utility

The nsadmin.exe utility uses the following syntax.

nsadmin <operation> <parameters> [options]

Commands and parameters Description

/commands <src_filename> Adds a command file to the local installation of Dragon.

/words <src_filename> Adds a list of new words to the local installation of Dragon.

/vocabulary delete <topic ID> Deletes the base vocabulary specified by <topic ID>.

Options

/language enx | fra | deu | ita | esp
| nld

Specifies an installed language that you want to addwords, com-
mands, or a vocabulary to. The default value is "enx".

/? Displays the command syntax.
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Commands and parameters Description

/overwrite yes | no | ask Specifies overwrite rules if a file exists with the same name as the
file you are adding. The default value is ask.

Adding custom words from a command line

You can use the nsadmin utility to make new words available to all User Profiles on a particular

installation of Dragon.

You must first either create a text file or export words from an existing User Profile's installation

of Dragon before you can distribute the words (for example, a list of new drug names) to a dif-

ferent installation of Dragon.

After you use the nsadmin utility to import the custom words, for the changes to become avail-

able, you must close your User Profiles, re-open the User Profiles, and save them.

Create a text file that contains custom words

Perform one of the following two actions before you distribute a set of custom words to a par-

ticular installation of Dragon:

Create a text file that contains custom words
1. Create a text file.

2. In the text file, add each word of phrase that you want to add to the vocabulary. Make sure each

word or phrase uses correct spelling and is a on a separate line.

l To add a multiple-word phrase, such "Mayberry Tribune", type it on one line.

l To include a spoken form of a word, type the word followed by a backslash (\) and the

spoken form of a word. For example, to have Dragon enter "Robert F. Kennedy"when you

say "RFK", type Robert F. Kennedy\RFK in the text file.

Export words from a Dragon installation

If you have Dragon available on another computer, you can use it to create custom words and

export the words to a .txt file. For more information, see the main Dragon Help file.

Add custom words to a shared location

When you use nsadmin utility, you can enter paths as complete local paths, relative paths,

mapped network drives, a UNC path, or the path to removable media such as a CD-ROM or ZIP

drive. For more information, see Using paths with nsadmin.

Perform the following steps after you create a text file that contains custom words or after you

export words from an installation of Dragon:

1. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory on page 269.

278



Chapter 8: Customizing a User Profile

2. On each computer that a user uses for dictation, map a network drive to the location of the data

distribution directory. As an alternative, you may reference the network UNC address of the

location of the nsadmin utility.

3. In a command prompt, type a command to add the custom words from the .txt file. The fol-

lowing command copies the NewWords.txt file to the following directory:
C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking11\Custom\enx\NewWords.txt.

<PATH>\nsadmin /words G:\NsAdmin\NewWords.txt

The next time you open a User Profile, Dragon automatically updates the User Profile's words to

include the words from the .txt file.

Use the command line to overwrite a custom word file

1. Use the /overwrite option to overwrite an existing custom word file. In Windows XP, if the

custom word file already exists in the\Documents and Settings\All Users\Application
Data\Nuance\NaturallySpeaking11\Custom\enx directory, Dragon overwrites it without
prompting you. See Dragon file structure for information on default locations on Windows

Vista and Windows 7.

The following command overwrites the NewWords.txt custom word file:

<PATH>\nsadmin /words G:\NsAdmin\NewWords.txt /overwrite=yes

Note:

If you add custom words to a Commands Only vocabulary, Dragon does not retain those words

if you upgrade the User Profile at a later date. In general, you should not add custom words to a

Commands Only vocabulary.

Adding and removing custom vocabularies from a command line

You can use the nsadmin to make a customized vocabulary available to all users on a particular

installation of Dragon. For example, you can use the nsadmin utility to copy a User Profile's

vocabulary and set it as the base vocabulary on any installation of Dragon. After you add a base

vocabulary to an installation of Dragon, new User Profiles you create can use that vocabulary.

The nsadmin command uses the following syntax:

<PATH>\nsadmin /vocabulary <directory> "<language or dialect> | <model
name> | <category>" <topic_ID>

Parameters Description

<language or
dialect>

Links a vocabulary to a language. For example, US English or UK Eng-
lish for an English install

The language or dialect must exist in the version of Dragon on the com-
puter.
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Parameters Description

<model_name> Specifies the size of the vocabulary you are importing.

<category> Describes the content of the vocabulary, for example, Astronomy orMarketing.

<topic_ID> Sets an ID for a topic.

The following nsadmin command copies the model name (Large), the category (Nuance), and the

topic ID (9005) to the models.ini file and copies the contents of the myvoc directory to
\Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-

urallySpeaking11\Custom\enx\Custom9005\.

<PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large |
Nuance" 9005

Notes:
n The default installation of Dragon installs vocabularies for existing Dragon User Profiles in the

following directory (in Windows XP). See Dragon file structure for information on default

locations on Windows Vista and other operating systems.
\Documents and Settings\All Users\Application

Data\Nuance\NaturallySpeaking11\users\<user_name>\current

n Vocabulary files have a *.voc file extension.

n You can use Voctool to customize a vocabulary. For more information on Voctool, see

Customizing Vocabularies with the Dragon Vocabulary Tool (Voctool).

n If you create a User Profile on a dual core computer that uses a custom vocabulary, make sure

that the User Profile uses the BestMatch IV speech model (BestMatch IV has the greatest

recognition accuracy on dual-core systems with more than 2 GB of RAM). To check this, select

the Advance button on the Create User Profile screen of the Creating a Profile wizard and make

sure that BestMatch IV is selected.

Prepare to use the command line to add a vocabulary

1. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory.

2. On each computer that a user uses for dictation, in a command prompt, start the nsadmin util-

ity and use it to add the vocabulary to the data distribution directory. Make sure to reference the

network UNC address of the computer in the command. Use the following syntax for the com-

mand:

<PATH>\nsadmin /vocabulary <directory> "<language or dialect> | <model
name> | <category>" <topic_ID>

The next time you open a User Profile, Dragon automatically updates the user profile's vocabularies.
For more information on using the nsadmin utility, see Starting the nsadmin command line utility.
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Use the command line to overwrite a vocabulary

1. Use the /overwrite option to overwrite an existing vocabulary file. If the vocabulary file already

exists in \Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-
urallySpeaking11\Custom\enx\Custom9005\, Dragon overwrites it without prompting you.

The following command overwrites the myvoc topic:

<PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large |
Nuance" 9005 /overwrite=yes

Use the command line to add an exported vocabulary

You can use the nsadmin utility to distribute a vocabulary that you create using a separate instal-

lation of Dragon. A Dragon vocabulary that you export saves as a group of files.

One of the exported files has a .top file extension, the other files have .to* file extensions, where

* is an integer.

1. In a command prompt, provide the path to the file with the .top file extension as an argument

to the nsadmin utility. Do NOT include the .top file extension on the command line.

The following command adds the myvoc exported topic (myvoc.top) as a new base vocabulary:

<PATH>\nsadmin /vocabulary D:\MyDocuments\myvoc "US English | Large |
Nuance" 9005

Use the command line to remove a base vocabulary

1. On each client computer, in a command prompt, enter a command to delete the vocabulary and

the corresponding entry inmodels.ini. You cannot use vocabularies that are based on a base

vocabulary you delete. Use the following syntax:

<PATH>\nsadmin /vocabulary delete <topic_ID>

The following nsadmin utility command deletes a vocabulary with a topic id of 9005:

<PATH>\nsadmin /vocabulary delete 9005

Adding custom commands from a command line

Custom commands are voice commands that you can create and modify to enter text, insert graph-

ics, or activate menus and keystrokes in any application. You can use theMyCommands Editor

to create custom commands or the Command Browser to modify custom commands. 
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You can use the nsadmin utility to copy a set of custom commands to the data distribution direc-

tory and make the set of custom commands available to all users of a particular installation of

Dragon

Before you use the nsadmin utility, you must have already created a data distribution directory, as

explained in Creating the Data Distribution Directory.

Notes:

n The default installation of Dragon places custom commands for existing Dragon User Profiles

here:
\Documents and Settings\All Users\Application
Data\Nuance\NaturallySpeaking11\Custom\<language>

n After you import the custom commands to Dragon, for the changes to become available to those

User Profiles, you must close your User Profiles, then re-open the User Profiles, and save the

User Profiles.

n You can enter a path as a complete local path, a relative path, a mapped network drive, a UNC

path, or the path to removable media, such as a DVD, CD, or ZIP drive. For more information,

see Using paths with nsadmin.

Use the command line to add custom commands

1. In Dragon, create custom commands.

2. Use the Command Browser to export the custom commands to a .dat file, for example, New-

Commands.dat.

3. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory.

4. On each computer that a user uses for dictation, in a command prompt, type a command line

using the following syntax, to add the custom commands from the .dat file. In the command,

reference the network address of the data distribution directory in the command:

<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat

The next time you open a User Profile, Dragon updates the commands in the User Profiles for the

user.

Use the command line to add custom commands to a language
other than English

Use the /language option to associate commands with a non-English language.

The following command associates the NewCommands.dat file with the language of French.

<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat /language=fra
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Use the command line to overwrite a custom command file

Use the /overwrite option to overwrite an existing command file.

The following command overwrites the NewCommands.dat file if it already exists in the

G:\NsAdmin directory. Dragon overwrites the file without prompting you.

<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat /overwrite=yes
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Using paths with the nsadmin utility
When you use the nsadmin utility, you can use a path that is a complete local path, a relative

path, a mapped network drive, a UNC path, or the path to removable media, such as a DVD, CD,

or ZIP drive. If a path name includes spaces, you must enclose the path name in quotation marks.

When you are running the nsadmin utility from a directory other than the one nsadmin resides

in, you must provide the full path to the nsadmin.exe program on the command line.

The following command copies the NewCommands.dat file to the following directory:
<drive>:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking11\Custom\enx\NewCommands.dat.

 <PATH>\nsadmin /commands \\HostComputer\NsAdmin\NewCommands.dat
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This section contains information on the tools and procedures you can use to maintain Dragon instal-
lations, including User Profiles and vocabularies. You can also view information on resources that can
help you trouble shoot issues that may occur in Dragon.
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Hardware Compatibility List 295
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Maintaining Installations
There are several actions you can take to maintain your Dragon installations:

n Run the Acoustic and Language Model Optimizer and schedule the Optimizer to run

automatically (see Using Acoustic and Language Model Optimizer and Scheduler Tools ).

n Export User Profiles from one computer and import them to another as outlined in Exporting

and Importing User Profiles.

n Work with the Dragon.log file to determine the cause of error messages (see Handling Dragon

Error Messages).

n Work with a Usability log file—create a usability log (DgnUsability.log) by pressing

the Advanced button on the Data tab of the Options dialog box. For more information, see

Working with the Usability Log.

n Work with the Dragon knowledge base as outlined under Accessing Dragon Knowledge

Database.

n Work with the hardware compatibility list (see Hardware Compatibility List)

n Manage who has administrative privileges (see Managing Who Has Administrative Privileges).
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Using Acoustic and Language Model
Optimizer and Scheduler Tools

You run Acoustic and Language Model Optimizer Scheduler to:

n Choose to optimize the acoustic files for the user profile

n Choose to optimize the language model for the user profile

n Schedule one or both types of optimization to occur on a particular day or time at particular

intervals

n Enable or disable the scheduled optimizations

n Separate procedures exist for running the optimization on a Non-Roaming User Profile (see

Running Acoustic and Language Model Optimizer on Non-Roaming User Profiles) or a

Roaming User Profile (see Running Acoustic and Language Model Optimizer on Roaming User Profiles

on page 288).

Running Acoustic and Language Model Optimizer on
Non-Roaming User Profiles
An open local user cannot run the optimizer tools on User Profiles. Only an administrator can run

the Acoustic and Language Model Optimizer or the associated Scheduler tools. You must

have Windows Administrator privileges (at the operating system level) on the computer where

you are running the Scheduler. If you want to optimize a Roaming User Profile on the computer

where you are running the Acoustic and Language Model Optimizer, disable roaming and browse

to the Master Roaming User Profile location as if it were local.

As system administrator, you are responsible for running the Acoustic and Language Model

Optimizer on the network location of the Master Roaming User Profiles. You can install Dragon

on the computer where the Master Roaming User Profiles are located or on any computer that has

network access to the Master Roaming User Profiles, then run the Scheduler. Later, any opti-

mizations that result from running these tools are copied to the Local Roaming User Profile when

Dragon synchronizes it with the Master Roaming User Profile. You can run the Acoustic and Lan-

guage Model Optimizer from the Windows Start menu (Select Start > All Programs >

Dragon NaturallySpeaking 11.0 > Dragon NaturallySpeaking Tools > Acoustic and Lan-

guage Model Optimizer Scheduler) without opening a User Profile, or you can run it from the

DragonBar using the Tools menu when a User Profile is open as indicated here.

Running the Acoustic and Language Model
Optimizer on a multi-core computer
If a non-Roaming User Profile with a BestMatch IV speech model is created and used on a multi-

core computer, when an administrator runs the Acoustic and Language Model Optimizer on that

profile on a single-core computer, all accuracy improvements may not be applied to the profile.
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The Acoustic model will revert to a single model. When a user opens the profile on a multi-core

computer, only the first acoustic model will load.

To increase the accuracy of the User Profile, select Audio > Launch Accuracy Tuning from the

DragonBar.

To make sure that corrections and accuracy improvements that users make are applied to their

non-Roaming User Profile, a user should run the Acoustic and Language Model Optimizer on

non-Roaming User Profiles only on a multi-core computer.

To run the acoustic and language model optimizers
on non-Roaming User Profiles:
1. On the DragonBar, select Profile > Open User Profile.

2. In the Open User Profile dialog box, select a User Profile to run the optimization on and click

Open.

3. On the DragonBar, select Help > Improve my accuracy. The Accuracy Center opens.

4. Click Launch Accuracy Tuning now. The Acoustic and Language Model Optimizer dialog

box opens.

5. If the user has not dictated and corrected recognized text since the last time the optimizer was

run, you receive this message: There is no new data in the acoustic archive. Acoustic Opti-

mizer does not need to be rerun. Click OK and the Acoustic and Language Model Opti-

mizer opens with the Perform Acoustic Optimization option grayed out.

6. Check the types of optimization you want to perform, Perform Acoustic Optimization (to

optimize the acoustic files of the user profile), Perform Language Model Optimization (to

optimize the language model of the user profile), or both.

7. Click Go to start the process. The process may take some time to complete. When the process

completes, you receive a message notifying you that it has completed.

8. Click Done.

9. When asked if you would like to save your User Profiles click Yes to return to the Accuracy

Center. Click Exit in the Accuracy Center dialog box.

Running Acoustic and Language Model Optimizer on
Roaming User Profiles
To run the Acoustic and Language Model Optimizer on Roaming User Profiles:

1. Be sure that a copy of Dragon is installed on the computer where you plan to run the Acoustic

and Language Model Optimizer.

2. Select Start > All Programs > Dragon NaturallySpeaking 11.0 > Dragon Nat-

urallySpeaking Tools > Acoustic and Language Model Optimizer Scheduler. The

Acoustic and Language Model Optimizer Scheduler dialog box opens.
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3. To access the master directory of the Roaming User Profiles you want to optimize, in the

Acoustic and Language Model Optimizer Scheduler dialog box, select File > Set User

Directory. The Set a Directory Containing User Files dialog box opens.

4. On the Set a Directory Containing User Files dialog box, either enter the path to the direc-

tory or click the Browse button and browse to the location of theMaster Roaming User Pro-

files, then click OK. If the User Profiles you want to optimize are located in multiple

directories, you can later repeat the steps outlined here and change this directory to locate the

additional User Profiles.

5. In the tree of User Profiles, select the user profile you want to optimize. Notice that if you

expand that user profile in the tree, you see one or more dictation sources under the Acoustic

Optimization tasks in the tree. You also see the vocabulary of the User Profile under the Lan-

guage Model Optimization tasks.

OR

Select File > New Task. The Windows user name and password dialog box opens. To set a

schedule for running the Acoustic and Language Model Optimizer, either double-click on

the dictation source or the language model under that User Profile.

6. Before you proceed, enter your Windows user name and password. If you are logged in to a

domain, you must insert the domain name in front of your user name; for example, Hos-

pitalDB\RSessions for the HospitalDB domain.

7. Click OK. The Select Frequency dialog box opens.

8. UnderOptimization, select Perform Acoustic Optimization, Perform Language Model

Optimization, or both.

9. Under User Information, you can either select another User Profile from the User Name

drop-down list or, to select multiple User Profiles, click theMultiple Users button to open

the Select User Profiles dialog box.
In the Select User Profiles dialog box, use the Add> and <Remove buttons to put the User

Profiles you want to run optimization on in the Selected users in this task list to the right. Or

you can click Add All>> or <<Remove All to add or remove all User Profiles from the list.

You can also move a user profile up and down in the list by selecting a name and clicking the

Move Up orMove Down button. When you are satisfied with the list, click OK to proceed.

10. If you selected multiple User Profiles in the previous step, skip this step. Otherwise, in the Dic-

tation Source text box, select an audio input device from the drop-down list and in the Vocab-

ulary text box, select a vocabulary from the drop-down list.

11. Under Select Frequency and Start Date & Time, select how often and at what time you

want the optimization to run, as well as the first date it should run.

12. At the bottom of the dialog, click the Enabled (schedule task runs at specified time) check box

to enable the optimization.

13. Click Apply to apply the changes.

14. Click OK to close the Select Frequency dialog box. The Acoustic and Language Model

Optimizer Scheduler dialog box displays a list of the events scheduled in the right pane of its

dialog box. You can create more than one optimization schedule for a single user profile. When

you do, both optimization events appear in the schedule list.

15. Click Files > Exit to close the acoustic and language model optimizer scheduler
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Removing One or More Optimization
Schedules

To remove one or more scheduled optimizations from the scheduler:

1. Select the schedule you want to remove. You can select multiple schedules by holding the

CTRL key while clicking a schedule.

2. Press the Delete key on your keyboard or select Options > Delete Selected Tasks on the

toolbar.

3. Click OK when you are asked to confirm the deletion.

290



Chapter 9: Maintaining a Dragon installation

Exporting and Importing User Profiles
You can export User Profiles on one computer and import them for use on another.

When you export a user profile to a new location, any custom words added to a Local Roaming

User Profile do not accompany the User Profiles unless you first run the Learn from specific

documents wizard in the Accuracy Center .

Exporting User Profiles
To export User Profiles from Dragon:

1. On the DragonBar, select Profile >Manage User Profiles.

2. TheManage User Profiles dialog box opens.

3. Select the user profile in the list that you want to export.

4. Click the Advanced button and select Export from the menu that appears.

5. When the Browse For Folder dialog box opens, navigate to the folder where you want to store

the exported user profile (or create a new folder by clicking theMake New Folder button) and

click OK.

6. When a dialog box opens displaying a message indicating the export was successful, click OK.

7. Repeat steps 3 through 6 for each set of User Profiles you want to export.

8. Click Close to close theManage User Profiles dialog box.

9. In the operating system, navigate to the directory where you exported the User Profiles. In that

directory you find a separate folder for each exported user profile, labeled with the user name.

Importing User Profiles
To import User Profiles into Dragon that you previously exported on a different computer:

1. On the DragonBar, select Profile >Manage User Profiles. TheManage User Profiles

dialog box opens.

2. Click the Advanced button and select Import from the menu.

3. When the Browse For Folder dialog box opens, navigate to the folder to retrieve a set of

exported User Profiles from.

4. Select the folder in that directory that has the name of the User Profile to import and click OK.

5. If the user profile already exists aUser already exists dialog box opens and asks you to

choose how to proceed: Overwrite the existing user or Import the user with an alternate

name. If you choose to import the User Profile and assign it another name, enter the name in

the text box provided and click OK.

6. Repeat steps 2 through 5 for each user whose User Profiles you want to import.

7. Click Close to close theManage User Profiles dialog box.
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Handling Dragon Error Messages
When Dragon displays an error message:

1. Read the message carefully. It may give you enough information to determine what to do.

2. If you dictated text into your document, click Close to close the error message box and then

save your document.

3. Do not save your User Profiles.

4. Copy the error message log file (Dragon.log) to a safe place. To locate this file, click Start >

Programs > Dragon NaturallySpeaking 11.0 > Show Dragon Log. In Windows XP, this

file is normally located in the C:\Documents and Settings\<username>\Application
Data\Nuance\NaturallySpeaking11 folder. Technical Support may ask you to send this file
for further study.

See Dragon file structure for information on default locations on Windows Vista and other oper-

ating systems.

5. Exit Dragon and start it again. In some cases it may be necessary to restart your computer.

6. Insert your Dragon DVD into your DVD reader, run the installation program again, and choose

the Repair option on the first screen of the Dragon setup program. After setup finishes, reinstall

any Dragon patches that were previously installed.

7. If the error message does not provide enough information to determine what to do, search our

Web site for information on the error message. You may find a solution that can save you time

and trouble:
http://www.nuance.com/product-support/default.asp?

lang=us&prod=dn
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Working with the Usability Log
You can set up Dragon to create a usability log that logs all menu commands, toolbar buttons, and

voice commands that you use during a dictation session.

To set up a usability log:

1. With a user profile open, on the DragonBar, select Tools > Options.

2. Click the Data tab.

3. Click the Advanced button.

4. When the Advanced dialog box opens, check the Create usability log check box and click

OK to return to the Data tab.

5. Click Applyand then click OK to close the Data tab of the Options dialog box.

Later, you can find the log under (in Windows XP) C:\Documents and Set-
tings\<username>\Application Data\Nuance\NaturallySpeaking11.

See Dragon file structure for information on default locations on Windows Vista and other oper-

ating systems.
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Accessing the Dragon Knowledge
Database

Solutions to known problems with Dragon are provided at the Nuance Knowledge Base, located at

http://knowledgebase.Nuance.com/.

If there are problems using Dragon with Microsoft Word on Windows XP (for example if the pro-

gram freezes or commands stop working in a Microsoft Office XP application), it may be that the

Microsoft Word XP’s built-in speech recognition is interfering with Dragon.

To locate and use the Dragon Knowledge Database:

Navigate to http://knowledgebase.Nuance.com/.

1. In the Search by Product drop-down list, select Dragon NaturallySpeaking.

2. In the field that appears below the Search by Product field, select the Dragon ver-

sion number.

3. In the next field that appears, select the Dragon edition.

4. In the Refine by Category drop-down list, select a category to further refine the

search criteria.

5. In the Search by Keyword field, type the words that would be expected to be found

in the pages that contain the answer. Do not use words such as "how", "why", "the",

"in", or "on".

3. Beside the Search by Keyword field, click the magnifying glass to start the search.
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Hardware Compatibility List
You can find a list of headsets and microphones compatible with Dragon at the Nuance Com-

munications web site.

To find the hardware compatibility list:

1. Navigate to http://support.nuance.com/compatibility/default.asp

2. At the site, under Select a Product click on the product drop-down list and select Dragon Nat-

urallySpeaking.

3. Click Continue.

4. Under Select a device category click on the device category drop-down list and select the

type of microphone or recorder. For instance, you can select Wireless Microphones to see the

various types of bluetooth microphones that are compatible.

5. Click Continue.

6. A list of compatible hardware displays, along with a model, manufacturer, and accuracy scale

Dragon Score.

7. Click on the device name to open an Evaluation Report for the device that provides more

detail. Each device is eitherNuance Certified (meets highest standard), Nuance Authorized

(provides satisfactory performance), or Reseller Endorsed (not necessarily tested by Nuance,

but reported by resellers/VARs to provide satisfactory performance).
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Managing user administrative
privileges

Before You Give Windows Administrator Privileges

Before you decide to give a Dragon user Windows Administrator privileges on a laptop computer,

note that you are giving that person access to the Administrative Settings dialog box on that

computer.

Determining Logged In User Has Admin Privileges

If the logged in user has Windows Administrator privileges, the following line appears in the

Dragon.log file after he or she logs in:

09:33:10 LOG (MainWin): Windows user has administrative access to NatSpeak
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This section contains information on how you can use tools in Dragon to control access to your custom
commands.

Managing and Securing Custom Commands 298

Using the Convert XML to DAT tool 299

Using the MyCommands Protection Utility 301
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Managing and Securing Custom
Commands

Make your custom commands more secure in two ways:

To make the tool available only in Dragon, convert any XML files of commands to DAT format.

For details see Using the Convert XML to DAT tool.

To prevent any Dragon users from editing the commands, lock access to the file. For details see

Using the MyCommands Protection Utility.
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Using the Convert XML to DAT tool

You can use a text editor to open commands that are in XML format. To allow only Dragon users

to access those command files, you can convert them from XML format to DAT format. Dragon

uses .dat files to store commands.

You can use the XML to DAT tool (mycmdsxml2dat.exe) to extract user-defined Dragon com-

mands from an XML file. The tool writes the commands to a .dat file. Use the nsadmin utility

or the Data Distribution Tool to make the new.dat files available to those other users.

Note: If you are using the SDK Client Edition of Dragon, you can use the DgnEng-

ingControl::ImportMyCommands method to programmatically import Dragon commands from

an XML or DAT file into a Dragon User Profile.

Starting the Convert XML to DAT tool

n In Dragon:

Start > All Programs > Dragon NaturallySpeaking 11.0 > Dragon NaturallySpeaking

Tools >Convert XML to DAT

n In Dragon SDK Client Edition:

Start > All Programs > Dragon SDK Client Edition 9 > Dragon SDK Client Tools >

Convert XML to DAT

The Convert XML to DAT tool starts in an MS-DOS window, listing the tool's syntax.

Displaying syntax information for the Convert XML to
DAT tool

1. From a command line, navigate to the \Program directory in the installation directory of the

Dragon SDK Client. For example,

C:\Program Files\Nuance\NaturallySpeaking11\Program>.

2. From a command line, enter mycmdsxml2dat

Convert XML to DAT syntax

Convert XML to DAT (mycmdsxml2dat.exe) uses the following syntax:

mycmdsxml2dat.exe <dat-file-path> <xml-file-path> [options]
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Parameters Type Description

<dat-file-path> Required The full path to the local copy of the cur-

rent user's .DAT file

<xml-file-path> Required The full path to the .XML file

-v Optional Validates the specified .xml file over the

Internet with a Nuance DTD (Doc-

ument Type Definition) file. Disabled by

default.

Use the XML to DAT tool to convert data in an XML file

1. Create an XML file that contains the commands to use with Dragon.

2. On a command line, use mycmdsXML2DAT.exe to convert the XML file to DAT format.

3. Use the nsadmin utility or the Data Distribution Tool to copy the .dat file to the data dis-

tribution directory.

The next time you open a User Profile, Dragon incorporates the new commands from the .dat file

into the User Profile.

For more information, see:

n Adding custom commands (nsadmin)

n Adding and removing custom commands (Data Distribution Tool)
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Using the MyCommands Protection
Utility

In Dragon Medical and Dragon Legal, when you export a set of custom Text-and-Graphics, Step-

by-Step, Custom Command, and/or Advanced Scripting commands into a .dat file, you can

set the permissions on that file so that after a user imports them, that user can dictate the com-

mands but cannot view their source code, edit their source code, or re-export the commands. As a

result, the integrity of the commands remains intact.

To set the permissions on the .dat file of commands to protect the commands in this way:

1. Make a backup copy of the unprotected .dat file and store it in a secure location. You later use

that file to edit the commands, because once you protect the .dat file that you are distributing,

you cannot make the file available for editing again.

2. Select Start > Run and enter cmd into the Run dialog box.

3. Change directories to (In Windows XP)<drive letter>:\Documents and
Settings\<user name>\Application
Data\Nuance\NaturallySpeaking11\Custom\<language>

See Dragon file structure for information on default location on Windows Vista and other oper-

ating systems.

4. Enter the following on the command line:

protectcmds.exe <dat-file-path> <vendor-name> [<vendor-contact-info>]

5. Once you press return, after a user imports these commands, if that user attempts to edit any of

them, the following message indicates that the commands cannot be edited:

The command was protected by <vendor-name>.

Please contact <vendor-contact-info> for more information.

In the Command Browser, the same message appears as the Preview Content in Script mode.

Once you have protected the file, you can put it into the Data Distribution directory for dis-

tribution to multiple User Profiles. For more information about distributing saved commands,

refer to Creating the Data Distribution Directory, then refer to one of the following topics about

distributing commands to multiple User Profiles by either:

n Using the Data Distribution Tool (Data Distribution Tool: Adding and removing custom

commands)

n Using the nsadmin command line tool (nsadmin: Adding custom commands)
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application state

This section contains information how to create and use structured commands that perform actions
based on the state of the application.

Using Structured Commands 304

Structured Command Samples 305

Importing Sample Structured Commands 307
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Using Structured Commands
Dragon NaturallySpeaking Professional, Dragon Medical, and Dragon Legal include an extension to

Text-and-Graphics commands that let you to set the values of variables in text blocks based on

voice input.

You can create simple Text-and-Graphics commands with variables in theMy Commands

Editor without having to do extensive programming in Microsoft® VBA.

Application states

Structured commands let you control the action of a command based on the state of the appli-

cation. For example, if you assign a state to each field in a form, the same command can perform

different actions depending on which field is activated.

You can use Advanced Scripting methods to control the states within structured commands or

to set the initial state from a non-structured command. You can also create structured commands

that prompt the user to select values from a predefined list.

When the user speaks a command, the user is presented with a list of pre-defined values for the

command. Once the user selects a value, the value is inserted into the correct location in the cus-

tom command.

Samples

Dragon includes several sample Text-and-Graphics commands with variables and sample structured

commands. You can import the samples into Dragon to use them as templates for your own com-

mands. The sample commands are fully commented.

For more information, see:

n Structured Commands Samples

n Importing Sample Commands

Methods

For more information on the methods used by the sample commands, refer to the following topics

in the Main Help file:

n Global Methods

l SetState

l GetState

n EngineControl Methods

l MyCommandsActiveState

l PromptValue
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Structured Command Samples
Dragon includes several sample Text-and-Graphics commands with variables and sample struc-

tured Advanced Scripting commands. You can import the samples into Dragon to use them as

templates for your own commands. The sample commands are fully commented.

Sample location

The sample commands are installed in (Windows XP):

\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\Data\Enx\samplecommands

See Dragon file structure for information on default locations on Windows Vista and other oper-

ating systems.

A shortcut to this directory is available on the Windows Start menu. To open this directory, click

Start > Programs > Dragon NaturallySpeaking 11.0 >MyCommands Samples.

Importing Sample Commands

You can import the samples into Dragon to use them as templates for your own commands. For

information, see Importing Sample Commands

Samples

The following samples are included with Dragon:

GroceryListSample_DragonPad

GroceryListSample_DragonPad.xml contains Advanced Scripting commands that simulate

an on-line grocery order form in DragonPad. It demonstrates how to set and change command

states, activating and deactivating various state structured commands, and how to use the com-

mand prompt. The "Prepare Grocery List" voice command displays the first section of a

grocery list in DragonPad and sets a command state. Each section of the grocery list is designed

to have a separate state. The "What's Available" voice command prompts the user with a set of

grocery list commands that are active in the given section.

GroceryListSample_WordPad

GroceryListSample_WordPad.xml contains Advanced Scripting commands similar to those

of GroceryListSample_DragonPad.xml. It demonstrates how to set and change command

states and to use the command prompt in WordPad and uses a different coding style. The "Pre-

pare Grocery List" voice command starts the grocery list in WordPad, activate the initial grocery

list state, and prompt the user with a set of grocery list commands that are active in the given
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state. To read more about this sample and its commands, refer to the code comments in the XML

file.

SampleBoilerPlate_ColonCancer

SampleBoilerPlate_ColonCancer.xml contains Advanced Scripting commands that dem-

onstrate how to use structured commands and the command prompt for boilerplate text. This sam-

ple is modeled after a colon cancer checklist and is designed to work in Microsoft Word 2003.

The "Colon Cancer Checklist" voice command displays the boilerplate text and takes the user,

field by field, through the checklist.

SampleBoilerPlate_EndoBiopsy

SampleBoilerPlate_EndoBiopsy.xml contains a single Advanced Scripting custom command

that demonstrates how to set up boilerplate text and use the command prompt to guide users in

filling the boilerplate text without using states. This sample is modeled after an endoscopic biopsy

report and is designed to work in Microsoft Word 2003. The "Prepare Endoscopic Biopsy

Gross Template" voice command displays the boilerplate text and takes the user, field by field,

through the report.

SampleTGV_Restaurant

SampleTGV_Restaurant.xml contains Text-and-Graphics and Advanced Scripting com-

mands that are used in DragonPad to simulate an ordering system for a Chinese and Japanese res-

taurant. This sample demonstrates how to set states for structured commands as well as how the

same commands can be used to produce different results in different states. Either the "Chinese

Restaurant" or "Japanese Restaurant" voice command starts the ordering system and acti-

vates the structured commands created for the given state. The "Exit Ordering System" voice

command ends the ordering session.

SetStateSample

SetStateSample.xml contains simple Text-and-Graphics commands that demonstrate how to

use variables and text formats and Advanced Scripting commands to set and unset a command

state. This sample is designed to work in DragonPad with the initial command "Sample Set

State".When the command executes, a command state is set forDragonPad and a simple

exchange of greetings is simulated between the user and the system. The user speaks the greeting,

such as. "Good Morning", and the system responds in bold red text. When the user says

"Good-bye", the exchange is terminated and the command state is unset.

SampleInjuryReport

SampleInjuryReport.xml together with SampleInjuryReport.dot demonstrates how structured

commands and Microsoft Word templates can be used together to create a voice-enabled form fill-

ing environment. The template is a mock injury report with several text and checkbox fields can

be filled using the commands included in the XML file. You start a form filling session by speak-

ing the "Edit Report" voice command in a new document based on the sample template. Both

the template and the commands are designed to work in Microsoft Word 2003.
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Importing Sample Structured
Commands

You can import existing structured commands, such as the Structured Commands Samples, into

Dragon to use as templates for your own commands. Use the following procedure to import the

sample structured commands that are supplied with Dragon:

To import the sample structured commands:
1. On the DragonBar , select Tools > Command Browser to open the Command Browser

window.

2. Click theManage button on the Command Browser toolbar.

3. In theManage area, click the Import button, and in the Import Commands window choose

MyCommands XML files from the Files of type list.

4. Use the Import Commands window to browse to (in Windows XP) the following

directory:Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking11\Data\Enx\samplecommands

See Dragon file structure for information on default locations on Windows Vista and other oper-

ating systems.

5. Select one of the sample .XML files (for example, sampletgv_restaurant.xml) and click

Open.

6. Click OK on the Import Commands validation dialog box and then click Import on the

Import Commands window to import the commands contained in the file.

7. Click OK on the success message and return to theManage area of the Command Browser.

Note: The syntax of XML command files is defined by a document type definition (DTD) file

that resides on the Nuance web site. When you import an XML command file, the application

gives you the option of validating the syntax of the XML file against the DTD. The validation step

is useful if you receive a XML command file from another person and want to check it for syntax

errors prior to importing it.

To examine the sample code
1. Open the Command Browser and click theManage button.

2. Expand and select the appropriate item (for example, “<restaurant_type>Menu”)

3. Click the To Script button and then click the Edit button.

TheMyCommands Editor dialog box opens with the command you selected entered into it.

You can examine and modify the command with theMyCommands Editor.
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This section contains information how to use the Administrative options, in the Administrative Settings
dialog box, to set and control many administrative features in Dragon.

Summaries of Administrative Settings Dialog Boxes 310

Administrative Settings: Roaming tab 311

Administrative Settings: Roaming User Network Location 314

Administrative Settings: Miscellaneous tab 316

Administrative Settings: Scheduled Tasks tab 319
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Summaries of Administrative Settings
Dialog Boxes

The tabs in the Administrative Settings dialog box are:

n Roaming

n Miscellaneous

n Scheduled Tasks

For more on each tab, see the corresponding topic below:

n Administrative Settings: Roaming tab

n Administrative Settings: Miscellaneous tab

n Administrative Settings: Scheduled Tasks tab

310



Chapter 12: Configuring administrative features in Dragon

Administrative Settings: Roaming tab
You use the Roaming tab of the Administrative Settings dialog box to set up the Roaming fea-

ture. You must set up the Roaming feature on each computer where you want users to dictate

with a Roaming User Profile.

When Roaming is enabled in Administrative Settings by default the Open User Profiles dialog box

displays large numbers of User Profiles quickly. They can also be organized into subfolders. See

"Creating subfolders for Roaming User Profiles" in the Dragon Help for more information.

Enable

Select Enable to activate the Roaming feature and the Roaming User Profile options.

Network Directories

To set the location of the master Roaming User Profile(s):

1. Click the Add button. You use the Roaming User Network Location dialog box to define

the network location of the master Roaming User Profiles. The location you pick must be acces-

sible to all computers on the network that you want available for dictation with Dragon.

2. Set the Display Name and the Address underNetwork Location. The Roaming feature sup-

ports the following types of locations:
n Mapped Drive—the format is: <drive letter>:\<folder name>. For example,

y:\roaming.

n UNC Path—the format is: \\servername\sharename\path\filename.

n HTTP (http:)—the format is: http://myserver.com/<name_of_virtualdirectory>

where <name_of_virtualdirectory> is the name of the virtual directory set up by an

administrator during setup of the IIS or Apache web site. For HTTP locations, click

the HTTP Settings button to set information specific to your HTTP connection.

You can also test your connection to the HTTP server from the HTTP Settings

dialog box.

n HTTP with SSL (https:)—the format is: https://myserver.com/<name_of_

virtualdirectory> where <name_of_virtualdirectory> is the name of the virtual

directory set up by an administrator during setup of the IIS or Apache web site. For

HTTP with SSL locations, click the SSL Settings button to set information specific

to your HTTP with SSL connection. You can also test your connection to the

HTTP with SSL server from the SSL Settings dialog box.

Local directory (for cache)

When a user opens a Master Roaming User Profile, Dragon transfers a copy of that user profile to

the local computer. The local copy is called the Local Roaming User Profile.

You can change the setting of this location, always called <Roaming Local>.

The default location of <Roaming Local> on Windows XP is:

Documents and Settings\All Users\Application Data\N-
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uance\NaturallySpeaking11\RoamingUsers\<display name>\<u-
sername>

See Dragon file structure for information on the default location of the RoamingUsers directory

for Dragon 11 on Windows Vista and Windows 7.

The <display name> is a name you assigned as a Master Roaming User Profiles location. You can

have multiple network storage locations for your Master Roaming User Profiles.

The <username> is the name of an individual Master Roaming User Profile. There is a separate

directory for each user profile.

Click the Browse button to find or create a new location.

Check Boxes for Roaming User options

The check boxes and other components below the Local directory are the Roaming User

options. You can also configure the Open User Profiles dialog box to display the Classic Open

User Profiles dialog if desired. See Selecting Roaming User Profile options. for details.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed

Dragon. Note that the default is to have the Roaming feature turned off.

Notes: For use of WebDAV

n After you install Internet Information Services and WebDAV, you need to use the Internet

Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom

Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in

IIS 7:
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n For more information, see Configuring Internet Information Services and WebDAV for HTTP

Roaming.

n If you connected to your Roaming User Profile Master Directory over HTTP and you find that

not all your User Profiles are listed in the Open User Profile dialog box, or after creating a

Roaming User Profile you cannot open it again, or the Open User Profile dialog box does not

display all the vocabularies and acoustic models for your User Profiles, make sure that you:
l Add all file extensions within your Master Roaming User Profile directories and

sub-directories to the Registered MIME types list of your IIS server. You could

also add a wildcard ( .*) MIME-type. For more information on adding a wildcard

( .*) MIME-type, see
http://www.microsoft.com/technet/prodtechnol
/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-

83a2c180cd32.mspx?mfr=true.

l Check that no files in your User Profile directory are locked, password

protected, or otherwise access-restricted by your server permissions.

313

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/cd3e6b8e-b497-4b8c-b552-83a2c180cd32.mspx?mfr=true


Dragon Administrator Guide version 11

Administrative Settings: Roaming
User Network Location

You use the Roaming User Network Location dialog box to define the network location of the

master Roaming User Profiles.

The location you pick must be accessible to all computers where users will dictate using a Roam-

ing User Profile.

Display Name
Sets the directory name displayed in the following locations:

n The Roaming tab of the Administrative Settings dialog box

n The Location of user profile drop-down list in the Open User Profile dialog box.

Note:With the Roaming feature enabled, the Open User Profile dialog box displays only User

Profiles in the Roaming User Profile locations. To let the users open both local (non-roaming)

and Roaming User Profiles, select the Allow non-roaming user profiles to be opened option

on the Administrative Settings dialog box. Clearing this option prevents users from dictating

with a non-roaming (local) User Profile by accident. For more information, see Enabling the

Roaming feature on each computer where a user will dictate.

n The Location of user profile drop-down list in theManage User Profiles dialog box.

Network Location—Address
On each computer where you plan to have users dictating as a Roaming User Profiles, you must

tell that installation of Dragon where the Master Roaming User Profiles are located.

The Roaming feature supports the following types of locations:

Mapped Drives and UNC Paths

Mapped drives connect to a shared network folder that has a drive letter assigned to it.

UNC paths connect to a shared network folder using the Universal Naming Convention (UNC) to

locate a user profile. The UNC is a way to identify a shared file on a computer or network without

having to know the storage device it is on. The UNC path format is:

\\servername\sharename\path\filename.

To use a mapped drive or UNC path:

1. UnderNetwork Location, enter the address of the mapped drive or UNC path.

You can click Browse to browse for the location of the mapped drive or UNC path. This dis-

plays the Browse for Folder dialog box. You can also create a new directory on the mapped

drive or UNC path by clicking the Make New Folder button.

2. Click OK when you are done.
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Intranet/Internet connections

The Intranet/Internet connection supports both HTTP and HTTP over an encrypted Secure

Sockets Layer (SSL).

To use an Intranet/Internet connection:

1. Under Network Location, enter the URL address of your HTTP or HTTPS server where your

master Roaming User Profiles are located.

2. Click
n HTTP Settings...to display the HTTP Settings dialog box, where you can set

information specific to your HTTP connection like Authentication, Firewall, and

Proxy Server information. You can also test your connection to the HTTP server

from this dialog box. For more information, see HTTP Settings.

n SSL Settings...to display the SSL Settings dialog box, where you can set

information specific to your HTTPS (SSL) connection. You can also test your

connection to the HTTPS server from this dialog box. For more information, see

SSL Settings.

Note: You cannot create a non-Roaming User Profile on an HTTP or HTTPS connection. You

can create only Roaming User Profiles on an HTTP or HTTPS connection and only when the

Roaming feature is enabled.
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Administrative Settings:
Miscellaneous tab

TheMiscellaneous tab of the Administrative settings dialog box contains the following

options:

Check for product updates at startup

Automatically looks on the Nuance Web Dragon every time you start the program. Any change to

this option does not take effect until you restart Dragon.

Backup location for user profiles

Shows the location where Dragon will save backup User Profiles.

n Click the Change button to open a dialog box where you can specify a new location.

n Click the Use Default button if you want Dragon to use each Windows user's My Documents

folder.

You can change the Backup Location for User Profiles to any directory where Windows has

both read and write permissions, including portable devices such as Zip drives and CD/DVD

burners. If you change the location, backups for all User Profiles will be located in the same direc-

tory.

Note: On Windows XP, Windows Vista, and Windows 7, you must have administrator privileges

to change the Backup Location for User Profiles and Data Distribution location. These

fields are grayed out for restricted users. Dragon will not let restricted users create backup files in

directories reserved for the operating system (for example, the \Windows directory). When spec-

ifying a backup location, make sure that directory can be accessed by all users.

Data Distribution location

Shows the location where the local installation of Dragon stores customized words and com-

mands.

n Click the Change button to open a dialog box where you can specify the location for this

directory.

n Click the Use Default button to set the location to this default path:
C:\Documents and Settings\All Users\Application
Data\Nuance\NaturallySpeaking11\custom

You can change the Data Distribution location to any directory where Windows has both read

and write permissions, including portable devices such as Zip drives and CD/DVD burners.

For a default installation, custom words and commands are located in:

n Windows Vista and Windows 7:
C:\ProgramData\Nuance\NaturallySpeaking11\custom\<language>

n Windows XP:
C:\Documents and Settings\All Users\Application Data\Nuance\Dragon
11\Custom\<language>
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Do not allow restricted users to add or modify commands

Select this check box to prevent restricted Windows users from adding or modifying Dragon com-

mands. Selecting this option allows only users logged on with administrator privileges to add or

modify commands. (Windows XP Professional).

Disable use of Macro Recorder Commands

Select this box to prevent users from using macro recorder commands. Users can still run the com-

mands.

Disable use of Step-by-Step Commands

Select this box to prevent User Profiles from using step-by-step commands. Users can still run the

commands.

Disable use of Advanced Scripting Commands 

Select this box to prevent User Profiles from using advanced scripting commands. Users can still

run the commands.

Do not allow restricted users to modify Vocabularies

Select this box to prevent restricted Windows users from modifying Dragon Vocabularies. Select-

ing this option allows only users logged on with administrator privileges to modify Vocabularies.

(Windows XP Professional)

Record wave data between utterances

Select this option to capture all dictation, preserving all audio including any pauses, filler speech

like "ums" and "ahs", extraneous noises, and anything else the speaker may do like cough or laugh.

Correction Only Mode (no dictation available)

Select this option to enable Correction Only Mode.

Correction Only Mode allows transcriptionists to play back a speaker's dictation without having

their User Profile loaded. Note that dictation is disabled if you select this option.

Note: You must disable Correction Only mode before running the Acoustic and Language

Model Optimizer.

Disable Windows Advanced Text Services

Select this option to disable the Microsoft Alternative User Input Text Input Processor

(CTFMon) to eliminate potential conflicts with Dragon.

Dragon installs an add-in to Microsoft Word that can conflict with add-ins installed by other appli-

cations. After installing Dragon on a Windows XP system, errors may start appearing when using

Microsoft Word if the Microsoft Alternate User Input application (CTFMON.EXE) is also

installed and running. The Microsoft Alternate User Input application supports advanced text serv-

ices in Microsoft Office XP. These advanced text services include Microsoft speech, handwriting,

and East Asian keyboard input services. You can disable the Microsoft Alternate User Input appli-

cation during installation or later in the Administrative Settings dialog box.

Note: This option does not appear on systems running Windows Vista.
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Disable automatic acoustic model selection in the Acoustic Optimizer

Running the Acoustic Optimizer updates your User Profiles with accumulated acoustic data

from any corrections and additional training users may have done. Running Acoustic Optimization

increases your overall accuracy. In the process of increasing your accuracy, Acoustic Optimization

may select a different acoustic model for your User Profile. For example, if you chose a General

accent during User Profile setup, Dragon may change it if your speech more closely matches

another accent. For more information, see "About speech and acoustic models" in the Dragon

Help.

Select this option to disable the Acoustic Optimizer from selecting a different acoustic model

when run.

If you are using Dragon 11 , see Using multiple acoustic models with a User Profile for infor-

mation on acoustic model selection and User Profile's that use two acoustic models.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed

Dragon. Note that the default is to have the Roaming feature turned off.

Notes
n When the User Profile is closed, you cannot use Dragon to dictate or to perform actions by

voice.

n On Windows XP you must have administrator privileges to change the Backup Location.

Dragon will not let restricted users create backup files in directories reserved for the operating

system (for example, the \Windows directory). When specifying a backup location, make sure

that directory can be accessed by all users

n In some versions of Windows, such as Windows XP Pro, you must be logged on as the

administrator before you can access this dialog box.

n In some situations, a user who does not have administrator privileges may have access to

options on this dialog that they would not normally have.

n Dragon allows you to use the Universal Naming Convention (UNC) to locate a user profile. The

UNC is a way to identify a shared file on a computer or network without having to know the

storage device it is on. The format is: \\servername\sharename\path\filename.
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Administrative Settings: Scheduled
Tasks tab

The Scheduled Tasks tab of the Administrative settings dialog box allows you to schedule

Accuracy Tuning and Data Collection for all User Profiles created with this installation of Dragon

NaturallySpeaking.

Accuracy Tuning
Schedule Accuracy Tuning to help Dragon to learn from you and make your dictation more accu-

rate. Accuracy Tuning runs the Acoustic and Language Model Optimizer to update your User Pro-

file with

n frequently dictated word sequences

n acoustic data from any corrections you make, including with the keyboard

n trained words

n commands used

n any additional training you perform

Enabled scheduled Accuracy Tuning

Check to turn on periodic scheduled acoustic model tuning for all users. 

Clear this checkbox if you want to disable Accuracy Tuning for the User Profile. The setting is

enabled by default.

Configure 

Click Configure to open the Select Frequency, Data Collection tab and set the Data Col-

lection schedule. You are immediately asked to log in with your Windows Administrator password

to make a schedule change. After you log in, you can set one schedule for Acoustic model tuning

and another for Language Model tuning by clicking the appropriate tab and choosing Daily,

Weekly, orMonthly and the start date and time.

Data Collection
Enable Scheduled Data Collection—Check to allow Nuance to collect up to 500 MB of acous-

tic data and text from your dictation sessions. Once the data is collected, you have the option of

sending it to Nuance to help improve the accuracy of future versions of Dragon Professional. No

personal information is ever sent to Nuance and participation is voluntary.
n Click Configure to set the schedule for data collection. You are immediately asked to

log in with your Windows Administrator password to make a schedule change. After

you log in, you can choose Daily, Weekly, orMonthly and the start date and time.

Let the user choose when to run Accuracy Tuning and Data Collection—Check to give

users access to this tab, effectively allowing them to change the schedules for Accuracy Tuning

and Data Collection.

Restore Defaults
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Click this button to restore the default values for Data Collection and Periodic Optimization.

Notes:

n When the User Profile is closed, you cannot use Dragon to dictate or to perform actions by

voice.

n Scheduled Accuracy Tuning and Data Collection cannot run if Dragon is open, including if

Dragon is running in QuickStart mode, if Dragon is left open with no User Profile loaded, or if

Dragon is left open by another user in a separate Windows session on the same computer.

n Since Dragon uses a local system account to schedule periodic tasks, User Profiles placed on

network shares will not be available for scheduled Accuracy Tuning and Data Collection unless

special arrangements are made with the network administrator

For more information, see the following topics in the Dragon Help:

n "About the Acoustic and Language Model Optimizer" for information about Accuracy Tuning.

n "About Data Collection" for more information about Data Collection.

n The "Options dialog box Data tab" for more information on scheduling Scheduled Accuracy

Tuning and Data Collection for the current Dragon User Profile.
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Spell Mode (definition) 346

User Profile (definition) 347
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.DRA files (definition)
Dragon Recorded Audio (DRA) files. By default, Dragon automatically saves audio and text tran-

scripts of your dictation in the DRA files.
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Accuracy Center (definition)
Offers a central location for tools and information you can use to ensure recognition. The link in

the description of each feature opens a topic describing that feature more completely. Say “display

Accuracy Center” or click Accuracy Center on the DragonBar Tools menu.
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Accuracy Tuning (definition)
A process Dragon can use to adapt to your usage. Once you have been dictating for a period of

time, Dragon uses Accuracy Tuning to automatically refine your User Profile, analyzing your dic-

tation, corrections, and any other acoustic training you have done. Accuracy Tuning uses two of

Dragon's accuracy tools, the Acoustic Optimizer and the Language Model Optimizer.
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Acoustic Optimizer (definition)
Looks for any corrections you have made or additional training you may have performed. Opti-

mization enhances recognition accuracy and helps predict words most likely spoken in a given con-

text by a speaker (the language model).
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Advanced Scripting (definition)
Supports using programming languages such as Microsoft® VBA to create commands that can per-

form virtually any function on the computer with voice commands.
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Commands-only Vocabulary
(definition)

A restricted Vocabulary containing only words and phrases that Dragon recognizes as commands.

Choose this way of dictation if you want to use Dragon only for command and control of pro-

grams and not for dictation.
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Command Browser (definition)
A window showing voice commands that Dragon recognizes, including commands that are pro-

vided with the software as well as any commands that you or your system administrator might

have added (custom commands). The Command Browser is the most comprehensive place to see

the commands that are available in each application.
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Correction menu (definition)
Shows Dragon’s best guess for alternatives to words you dictated and selected. Choose the correct

word from the Correction menu by saying “Choose” and the number next to your choice.
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Command Mode (definition)
A restricted recognition mode that causes Dragon to interpret everything you say as a command

and nothing is interpreted as dictated text. Say "Start Command Mode" or "Command Mode On".
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Correction-only mode (definition)
Enables transcriptionists to play back a Dragon user's dictation without having their User Profile

loaded. Note that dictation is disabled if you select this option.
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Data Distribution Tool (definition)
Enables developers to interactively create new words, customized Vocabularies or commands, and

to make them available to all User Profiles on a particular Dragon NaturallySpeaking installation.
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Dictation Box (definition)
Provides full support for dictating and editing text in non-standard windows. The DictationIBox

supports voice commands like Delete, Correct, and Insert, and custom commands as well. When

you are finished, the content is transferred to the non-standard window where your cursor was

positioned when you opened the Dictation Box. The Dictation Box can operate in Hidden Mode

(Medical, only), and can be anchored or unanchored.
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Dictation Mode (definition)
A restricted recognition mode that causes Dragon to interpret everything you say as dictation and

nothing is interpreted as a command. Dictation Mode can be helpful if you want to dictate as

quickly as possible, or dictate without looking at the words Dragon transcribes. Say "Start Dic-

tation Mode" or "Dictation Mode On".
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Dictation Source (definition)
An audio input device or multiple devices associated with a User Profile. A user can select a head-

set microphone at one computer, an array microphone at another, and a portable recorder for tran-

scription at several computers. This way, Dragon supports users who need to move, or “roam”,

from computer to computer regardless of the microphone type or differences in ambient noise.
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DragonPad (definition)
Dragon’s built-in word processor, optimized for dictation and includes basic text formatting fea-

tures as well as the ability to save and print documents.
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Hidden Mode (definition)
A recognition mode that causes Dragon to send all recognized text to the Dictation Box, which is

active but does not display. All recognized text is added to the Dictation Box, regardless of the

cursor location. Hidden Mode is often used by healthcare providers who are dictating medical

reports to be sent to a medical transcriptionist/editor. Say "Start Hidden Mode" or "Start Hidden

Mode".
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Language Model optimization
(definition)

Updates the language model of the current Vocabulary. Language Model Optimization uses text

Dragon extracts from the .DRA files that are created when you correct words. Based on the

speech data collected, Language Model Optimization applies modifications to the language model

to reflect your word usage.
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Language Model Optimizer
(definition)

Performs Language Model Optimization from the Accuracy Center. Any Dragon user with admin-

istrator privileges can schedule Dragon to perform optimization periodically.
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Normal Mode (definition)
Dragon's default mode of dictation. In Normal Mode, Dragon distinguishes dictation from words,

numbers, and commands by analyzing what you say between pauses. Say "Start Normal Mode" or

"Normal Mode On".
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Numbers mode (definition)
A restricted recognition mode that causes Dragon to recognize only numbers, commands, and

punctuation. If you are dictating only numbers (including currencies), working in this mode

increases recognition accuracy. Say "Start Numbers Mode" or "Numbers Mode On".
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QuickStart (definition)
Allows Dragon to load in the background when you start your computer or log in to your oper-

ating system, depending on your version of Windows. When Dragon is launched in QuickStart

mode, Dragon is available for use more quickly than when you start in normal mode. The micro-

phone icon appears in the system tray.
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Recognition Modes (definition)
By default, Dragon functions in Normal Mode, distinguishing dictation from words, numbers, and

commands, and analyzing what it hears between pauses. Dragon also offers restricted recognition

modes for dictating only commands (Command Mode), numbers (Numbers Mode), characters

(Spell Mode), or words (Dictation Mode). You can also use Hidden Mode to have Dragon hide

the DictationBox as you dictate into it.
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Roaming User (definition)
Enables you to dictate with Dragon from different network locations and on different computers

without having to create and train individual User Profiles at each location. User Profiles are

stored in a network location available to all computers on the network, so that the information

Dragon learns from a user dictating on one computer is also available to the same user when they

log in on other computers.
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Spell Mode (definition)
A restricted recognition mode that causes Dragon to recognize only letters, numbers, commands,

and punctuation. Spell mode is useful for dictating unpronounceable alphanumeric strings, such as

part numbers and license plate numbers, and other terms you anticipate Dragon may not rec-

ognize, such as Web addresses, words in a foreign language, or unusual product names. Say "Start

Spell Mode" or "Spell Mode On". You can still use commands while in Spell Mode.
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User Profile (definition)
A set of files created the first time you use Dragon, which is subsequently used to reflect your

characteristics and adapt to your usage. Each person who uses Dragon must have a User Profile,

which the software stores in a set of files containing, among other things, acoustic and lexical data.

These data contain information about how you sound, and the words you use, and how often you

use them. When you add a word to your Dragon Vocabulary, make corrections, read a training

text, or change a setting in the Options dialog, Dragon can save these refinements in your User

Profile. If your edition of Dragon supports custom commands, these are also saved in the User

Profile.
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